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Welcome to Final Writer
Congratulations! You have chosen an advanced and innovative word
processing system for the Amiga®. Final Writer™ is designed for people
who want high quality personal and business documents. It combines
word processing and graphic handling features with high quality, state-of-
the-art printing technology.
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Before you go further
Before you begin using Final Writer, please take a few moments to:

° Back up the Final Writer disks. After you have backed up your
disks, store the originals in a safe place in case you need to revert to
them at a later time.

<> Fill out and mail the enclosed warranty registration card.
SoftWood provides technical support for Final Writer if your warranty
card is on file. Tear off your portion of the registration card and keep
it with your manual. Fill out the other portion of the card and mail it
to SoftWood. When you call for technical support, please have your
registration number ready in case you are asked for it.
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How to use this manual
This manual is divided into a number of sections that follow this introduc­
tion. These learning and reference chapters are:

• Installing and Getting Started - Information necessary to begin
working with Final Writer is contained in this chapter. It includes
installation procedures, an overview of basic terminology, instructions
for starting and quitting Final Writer, and brief descriptions of Final
Writer's user interface.

• Tutorial - We have produced a set of tutorial exercises designed to
familiarize you with using Final Writer as quickly as possible. In­
cluded are exercises on creating, revising, and formatting a document.

• Setting Preferences - This chapter describes Final Writer's prefer­
ence settings which let you customize certain operations to suit your
personal needs.

• Page Setup - Final Writer is very flexible in allowing you to define
page characteristics for your documents. This chapter discusses
setting up pages.

• Creating and Saving a Document - Follow these easy, step-by-step
instructions to create and save a document in Final Writer. Included
are editing functions that you are likely to use as you are actually
writing your document for the first time.

• Revising a Document - This chapter tells you what you need to
know about revising and editing a document.

• Formatting a Document - This chapter provides an explanation of
various ways in which you can change the appearance or format of
your document. Included are document, paragraph, and graphic
settings; fonts; rulers; and other important features.

• Graphics and Text Blocks - Instructions for working with graphics
and text blocks are found in this chapter.

• Making a Document Perfect - This chapter contains instructions for
using Final Writer's speller, thesaurus, and document statistic features.

• Sections - Contained in this chapter are guidelines for creating
sections such as Table of Contents and Index.

• Printing a Document- Once you have created your document, refer
to these instructions for printing it.

• Form Letters - Instructions for creating and saving merge data,
creating a form letter, and merging data with a form letter.
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• ARexx Support - A description of Final Writer's ARexx commands.

• Reference - A descriptive guide to Final Writer's menus and com­
mands, including references to specific areas of the manual where
additional information can be found.

• Appendices - A list of cursor key functions; a description of key­
board shortcuts; a compilation of helpful hints to make the most of
Final Writer's word processing abilities; and a glossary of word
processing, printing, typesetting, and computing terminology.

Thank You
SoftWood is committed to making excellent software for the Amiga®. In
fact, the Amiga® is the only computer for which SoftWood publishes
software. We have done everything we can to ensure that Final Writer is
an enjoyable product in which you can have confidence.

If you should find anything about Final Writer that you believe needs
improvement, mail us your suggestions. We read each letter and continu­
ally compile a list of changes requested by users of our programs.

Good luck with Final Writer, and thank you for purchasing it. We hope
you like Final Writer well enough to tell your friends about it.

Woody, Terry, Mary, Pat, and Jim

SoftWood, Inc.
1993
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| Installing and Getting Started
This chapter is designed to get you started using Final Writer. It
guides you through installing Final Writer on an Amiga® with a
hard drive. It explains the basics of operating Final Writer and
describes its user interface. The goal of this chapter is to get you
acquainted with Final Writer so you may begin using it right away.
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Before you begin
Before you begin using Final Writer, you should know a few basic
concepts and verify that your computer and system software are
compatible with Final Writer.

Things you should know
To use Final Writer effectively, you need to understand a few basic
concepts. Before you begin, you should know how to:

• Start your Amiga®.
• Use the mouse to point, click, double-click, and drag.
• Start a program from the Workbench™.
• Initialize and duplicate disks.
• Use menus to choose commands.
• Scroll, move, and resize windows.
• Use a requester.

Some of these concepts are discussed in this chapter, others are
found in the manuals that came with your Amiga®.

Required hardware and software
Before installing or using Final Writer, make sure your computer
and system software are compatible with Final Writer.

Hardware required
Final Writer has a thesaurus database, spelling dictionary, hyphen­
ation database, and many outline fonts. In addition, the program
size is over 500K. Because of all of this, you will need a hard disk
to use Final Writer. If the system software is correct (sec below),
Final Writer will work on any Amiga® with at least 1.5 megabytes
of available internal memory. If your computer has less than 1.5
megabytes of memory available after Workbench™ is loaded, you
will not be able to run Final Writer.

System software required
Final Writer requires version 2.0 or higher of the Amiga® Work­
bench™. If you have any Workbench™ version before 2.0. Final
Writer may not work properly or perhaps not at all.
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Final Writer concepts
The following are some basic terms used throughout this manual.
Experienced Amiga® users may wish to skip over this section.

Point

Press

Click

Double-click

Select

Drag

Highlight

To move the mouse so that the mouse pointer is
either pointing at or pointing on top of some
object.

To hold the left mouse button down.

To press and quickly release either the left or right
mouse button.

NOTE. In this manual “Click the mouse" will mean
to click the left mouse button. The right mouse
button is only used for accessing menus.

To quickly click the left mouse button twice.
Depending on what you are doing, double-clicks
are used to open documents, access drawers, or
select words. A double-click is always performed
using the left mouse button.

To specify something (e.g. to select lines of text or
to select a document to be opened).

To press the left mouse button and move it in some
direction while still holding the mouse button
down. Dragging is used to select areas of text.
Dragging with the right mouse button down is used
to choose a menu command.

Text that has been selected appears to be high-
lighted on the screen. This is highlighted text.

Preparing to use Final Writer
Now that you are sure your computer and system software are
compatible with Final Writer, make backup copies of the Final
Writer master disks. Afterwards, follow the steps in “Installing Final
Writer” to prepare your computer for using Final Writer.

Making backup copies
Use the Workbench™ commands to copy all Final Writer disks. If
you are unsure how to do this, refer to your Amiga® manual.
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Installing Final Writer
Final Writer is not copy-protected and can be installed on a hard
disk. The "HDJnstall" program located on the disk named "Disk 1"
must always be used to install Final Writer. You need at least 3
megabytes of space on your hard drive to install Final Writer.

To install Final Writer on a hard disk:

1. Start your Amiga®, if it is not already running.

2. After the computer completes its start up, eject any disk in
the floppy drive, and insert the disk named “Disk 1”.

3. Double-click on the “Disk 1 ” disk icon.

'Illis will open the main window for the "Disk I" disk.

4. Double-click the mouse on the “HDJnstall” program icon.

This will start the installer program.

5. Click the mouse on the “Proceed with Install” button.

The installer will display a screen with some additional options.

6. Click the mouse on the "Proceed" button.

The installer program will display a screen that lets you specify
where Final Writer is to be installed. On this screen, beneath
the title "Selected Drawer", will be a destination the installer
program has chosen for the installation. You can modify this
destination if you choose to.

7. If you want to change the "Selected Drawer" location, do
so now.

NOTE. Do not specify "FinalWriter" as part of the "Selected
Drawer". The installer program automatically creates a drawer
named "FinalWriter" within the "Selected Drawer" location.

8. Click the mouse on the "Proceed" button.

9. When the program asks you to insert a disk, remove the
disk that is currently in the drive, and insert the one that is
requested.

10. The “HDJnstall" program will notify you when the installa­
tion is complete. When this occurs, click the mouse on
the “Proceed” button.

11. Close the “Disk 1" window.
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Starting Final Writer
Final Writer requires that you have a hard drive in your computer.
It does not come with a system disk and relies upon the system that
is installed on your hard drive. If you do not have a hard drive,
you will not be able to use Final Writer.

To start Final Writer:

1. Turn on your Amiga® and follow the normal startup
procedures you go through to get your computer running.

2. Once you are running on your hard drive, locate the “Final
Writer” drawer that was created during the Final Writer
installation process.

3. Double-click the mouse on the “FinalWriter” drawer.

Shortly, you will see several icons, including the Final Writer
program icon.

4. Double-click on the “Final Writer” program icon.

In a few seconds, Final Writer will be running, and you will see
the "Startup Screen”. This screen gives you the opportunity to
choose the type of screen Final Writer will use.

Final Writer ]'ta
------- Screen Type---------

_) Use Workbench
C Open New Screen

-----------------New Screen Options-------------------
---------------------------Mode-----------------------------

MULTISCAN:Productivity Lace S3
NTSC:Hlgh Res

NTSC:Ldw Res - 2*
NTSC:LowRes Laced y|

---------Number of Colors----------
tsm__jmmsl «

OK | Cancel |

5. Click the mouse on the “OK” button.
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Working in Final Writer
Once you have started Final Writer, you will see an untitled Final
Writer document window. The following are descriptions of the
various elements of a Final Writer document window.

Menus
Most of Final Writer's features are accessed by choosing a menu
item. As you know, on the Amiga® you can access the menus by
moving the mouse along the top of the screen while pressing the
right mouse button. Below are brief descriptions of Final Writer’s
menus.

"Project” menu
This menu includes commands to create, open, save, print, and
delete a document. It also contains commands that let you specify
page setup parameters, set preferences, and quit Final Writer.

“Edit” menu
Commands in this menu will allow you to cut, copy, paste, clear,
and select text. Also included are commands to insert and update
date and time, and to copy and paste the nilcr.

“View” menu
The View Menu is used to choose a page view, and show or hide
various screen display elements.

“Layout” menu
This menu enables you to define page, section, and paragraph
characteristics. It also is used to define and apply paragraph styles,
insert and remove page breaks, insert and and remove sections.

“Text” menu
Contained in this menu are commands to set the characteristics of
the text contained in your document, including the font, size,
leading, style, position, width, and case of text. You may’ also use
this menu to select a color for your text, and specify’ the oblique
percentage (or degree of slant) for italic text. The Type Specs
feature enables you to define type specifications for any’ amount of
selected text in your document or for text which has yet to be
entered.
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“Graphics” menu
This menu includes commands to insert IFF graphics; select settings
for those graphics; specify settings for lines, boxes and ovals drawn
with Final Writer’s tool icons; and to determine if graphics are to
appear in front of or behind other elements on your page.

“Tools” menu
Included in this menu are commands to find or replace text, as well
as commands to initiate a spell check, consult the thesaurus, and
obtain document statistics. This menu also contains commands
used to create special sections such as table of contents and index.

“User” menu
This menu is available for you to add your own items to.

Title bar
A window’s title bar will show the name of the document in the
window. If the document has not been saved, the name will be
“Untitled”.

User button strip
Final Writer's user button strip is the area at the top of a document
window which can contain one or more buttons you set up for
accessing often used operations.

Program command strip
Final Writer's program command strip is the area just above a
document's ruler which contains button-activated commands you
can use to control various aspects of the program's operation.

Justification selectors
Final Writer allows you to justify your paragraphs in four different
ways-left, right, centered, or full-using the justification selectors.
Each paragraph may be justified independently.

Spacing selectors
The spacing selectors enable you to space your paragraphs as
single, 1-1/2, double, or variable spaced. Each paragraph may be
spaced independently using these selectors.
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Tab stop selectors
Final Writer's tab stop selectors allow you to mark tab stops on the
ruler. Four different tab alignments-left, right, center, and decimal­
may be specified using the tab stop selectors. Each paragraph in
your document may have its own unique tab configuration.

Hyphenation "On/Off"
The hyphenation selectors allow you to turn Final Writer’s automata
hyphenation feature off and on as you wish.

Tool box
By selecting the appropriate tool, you may enter text; select graph­
ics; draw horizontal, vertical or 45° diagonal lines; draw lines in any
direction; draw a rcctangle/square; draw an oval/circle; and crop
graphics.

Master/Body page selectors
Tlte master pages selectors enable you to designate a page as a
master guide for your entire document. Any text or graphics
entered on a master page will appear on every page of the docu­
ment. You may select left and/or right master pages.

Ruler mode selectors
These selectors enable you to determine whether your document
displays no rulers, the top ruler only, or both side and top rulers.

User command strip selectors
These buttons let you hide or show the user command strip.

Left and right margins
Left and right margins may be marked on the ruler using the margin
selectors. Each paragraph may' have its own margins.

First line indent
The first line indent margin allows you to specify- the indentation
distance for the first line in a paragraph.

Hyphen “hot zone"
This margin allows you to specify the point in a line of text where a
word becomes eligible for hyphenation.
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1Page number
This tells you which page of your document is currently in the
window, and can be used to go to a previous, next, first, or last
page of the document.

First Line indent

Left margin

Spacing selectors a^e
Title bar User button strip / „ , , number\ / Ruler mode selectors, \

Justification selectors

Scroll bars
Scroll bars are used to adjust the viewing area of a window. Drag­
ging the scroll bar allows you to move to a desired position within
the document. Clicking in the scroll box moves the text either
horizontally or vertically in large increments within the document
window. Clicking on the scroll arrows results in a small movement
either horizontally or vertically within the document window.
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Window gadgets
In addition to the above Final Writer gadgets, several Amiga®
gadgets also appear in the window.

Close box
When the mouse is clicked on the close box, the Final Writer
window will be closed.

Front to back gadget
This gadget places the current window behind other windows that
might be simultaneously open.

Size gadget
You may alter the size of a document window by dragging the
mouse while clicking on the size gadget.

Quitting Final Writer
To quit Final Writer:

Project
New ON
Open... K30

Save BESS
Save As...
Save Text Clip...
Print... Eb"
Print Merge...

Delete...

Preferences ►
About k

Choose “Quit” from the “Project” menu.

If you only have one window open, that window will be dosed
and you will return to the Workbench™ screen. If other Final
Writer windows are open, only the current window will be
closed. Before closing a window, the program looks to see if
you have made any changes to the document since the docu­
ment was last saved. If there are unsaved changes. Final Writer
will ask you if you want to save the revised document.
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Technical support
We have tried our best to explain Final Writer in this manual. If
you have problems that you can’t solve by using this manual, you
can call Softwood’s technical support. The phone number you
should call, and the hours you can call are listed below:

American English version
Technical Support for the American English version of Final Writer
is available from Softwood, Inc. in Arizona by calling (602) 431-
9151. The hours you may call for technical support are from 10:00
AM to 12:00 PM MST and 2:00 PM to 4:00 PM MST Monday through
Friday. MST is Mountain Standard Time. Arizona's time does not
change during the year. During winter 10:00 AM in Arizona is the
same as 12:00 AM EST. In the summer months 10:00 AM in Arizona
is the same as 1:00 PM EST. Technical support is not available on
Saturdays, Sundays, or holidays.

There is no charge for technical support. However, you must pay
your own telephone toll charges. We price our programs as low as
possible to make a fair profit and stay in business. You are wel­
come to send comments and suggestions to us by mail or fax.
However, because of the volume of mail we receive, we CAN NOT
respond to mail or faxes.

British English version
Technical support for the British English version of Final Writer is
available from Gordon Harwood Computers in Derbyshire, England
by calling 0773-520252. The hours you may call for technical
support are 10:00 AM to 12:00 PM, Monday through Friday.

Limits on support
In order to receive technical support your registration card must be
sent in. In order to serve legitimate owners of Final Writer, we will
not give support to anyone who is not a registered user. Every time
we take a call from someone who has an illegal copy of our
program, it keeps us from taking a call from a registered owner. It
only takes a few moments of your time to complete and send in
your registration card.
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| Tutorial
This chapter contains a set of exercises designed to introduce you
to some of Final Writer’s important basic features. When you finish
this section, you will know how to:

• Create a document
• Enter text
• Insert text
• Move text
• Delete text
• Save a document
• Close a document
• Open a document
• Align text
• Set a margin
• Change font size
• Create a header
• Save a changed document

Keep in mind that the purpose of this section is to lead you through
a set of simple tasks using some of Final Writer’s features. Step by
step instructions for other Final Writer commands may be found in
other chapters of this manual.

2
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Creating a document
The following exercise will show you how to create a new docu­
ment. In this practice session, you will type a letter. As you do so,
you will not need to hit the RETURN key when you get to the end
of a line. Final Writer will automatically take you to the next line
when a word will not fit on the line you are typing. To end a
paragraph or insert a blank line, you will need to press the RETURN
key.

In the letter that you will be typing on the following page, the "SI"
symbol shows where you should press the RETURN key.

If you make a mistake while typing, use the BACKSPACE key to
erase the characters.

To create the tutorial document:

1. Start Final Writer if it is not already started.

An untitled document window will appear on your screen.
Notice that the text tool icon on the horizontal ruler has been
selected and that the insertion point is located in the upper lelt
corner of the window. When you begin typing, text will be
inserted at the insertion point.

“Text tool" icon
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2. Type the following letter:

NOTE. Remember the “SI” in the letter below indicates where
you should press the RETURN key.

Professor Sean O’Boyle]]
Department of Irish Studies]]
11
Mary Williams]]
222 Main Street]]
Hometown, Indiana 60209]]
U.S.A.]]
H
H
Dear Mrs. Williams]]
U
I received your letter asking for information on Irish literature.
You are absolutely correct that reading a nation’s literature is
the best way to prepare for travels there. Listed below are
selected works by some of Ireland’s greatest authors. Happy
Reading!]]
H
The Playboy of the Western World, by J.M. Synge]]
H
The Collected Works of Yeats]]
11
A Guide to Dublin Pubs, by Eamon 0'FerrallH
11
Ulysses, by James Joycell
H
H
Sincerely,U
11
Prof. Sean O’BoyleH

2
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Revising a document
Now that you have created your tutorial document, you can pro­
ceed with several editing exercises.

Inserting text
You will often wish to add characters to existing text in a document.
With Final Writer, this process is quick and easy. Characters are
always inserted at the insertion point.

To insert text into the tutorial document:

1. Move the mouse so that the text tool is positioned just
before the word “Happy” in the main paragraph.

2. Click the left mouse button.

You have just set the insertion point, and any characters that
you type will he inserted before the word ''Happy".

o| • ~ .....................—--------------------- --------------- ------------- !EJIEi

■cginni^ianpaEiainFirfiiHiaisi^FnRU=ijFi^=ii
1 "'fr' 1'1 b ' 1 1 1'1 • u • 1 ' it • ~1

Piofessoi Sean O'Boyle
Department of Irish Studies

Maty Willlcsns
222 Mam Sli cel
Hometown, Indiana 60209
USA

Deai Mis Williams

I leceived you lefiei asking fo; lnbimationonhishliletdi.ee Youaedosoldely cot-
lecllhd leading a nation's lifeiofuie is the bed way to prepaie br hovels I here Listed
below a e selected wo. ks by some of It eland's giedesl adhois. )Happy Reoaing' 

5 The Playboy of the Western Wo. Id, by J. M Synge

The Collected Wo. Is of Yeds

A Gude Io Dublin Pubs, by Ecmon O'Fei tall
i

Ulysses, by Janes Joyce

3. Type the words “You may find these books at your local
library.” followed by two spaces.

Notice that the text automatically readjusts itself within the
margins of your document. The two spaces were entered to
separate your new sentence from the one following it.

lnbimationonhishliletdi.ee


Deleting text
If you create a document and decide at a later time that some of the
text needs to be removed, you may do so easily by using Final
Writer’s “Edit" menu.

To delete a block of text in the tutorial document:

1.

2.

3.

4.

I®
Copy
Paste
Clear GSEBu

Select All
Find.. ISZDF
Replace...
Go To Page...
Go Ta- Section
Go To Selection

L—C? *]G

Insert Item ►
Update Item ►
Copy Ruler 1^5? MO
Paste Ruler i^gi

Position the mouse at the beginning of the blank line that
appears above the line reading “A Guide to Dublin Pubs,
by Eamon O’Ferrall”.

Press the left mouse button and continue to hold it down.

While holding the mouse button down, drag the mouse
down and to the right until the blank line and entire line of
text are highlighted.

Release the mouse button.

This process of dragging the mouse over text is known as
“selecting". Selected text always appears highlighted on your
screen.

Choose “Cut” from the “Edit” menu.

The selected text will be removed, and Final Writer will auto­
matically reformat the document.
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copy e^sc
Poire rav
Clear E3D
Select AH EE5A

Find KJF
Replace E3R
Go To Paae
C-oT-: Seftii-i
Go To Selection

E3G

insert Item
Update Item
Copy Ruler RJO
Paste Ruler K31

EH
Cut
Copy

C3X
K3C

1 [Paste V |
Clear EJD
Select All
Find
Replace eesr
Go To Paae
Go r.; $e: ti:-n
Go To Selection

EEIG

Insert item »
Update Item >
Copy Ruler
Paste Ruler

G30
K31

Moving text
Text in a document is moved using “Cut’’ and "Paste" commands.

To move text in the tutorial document:

1. Drag the mouse over the words “Happy Reading!”

Dragging involves pressing and holding the left mouse button,
then moving the mouse while continuing to hold the button
down. When finished dragging, release the mouse button, and
die selected text will appear highlighted on your screen.

2. Choose “Cut” from the “Edit” menu.
The highlighted text is removed from your document and stored
in a special place called the "Clipboard".

3. Position the mouse after the last character of the line
reading “Ulysses, by James Joyce”, and click the left
mouse button to set the insertion point.

4. Press the RETURN key twice.

5. Choose “Paste” from the “Edit” menu.

Final Writer will insert the sentence at the insertion point.
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Saving and closing a document
Now that you have practiced some of Final Writer's basic editing
techniques, it is time to learn to save and close your document.
While you were creating and revising the tutorial document, you
may have noticed that the name "Untitled” appeared in the title bar
of your window. This is the name that Final Writer assigns to a
new document until it is named and saved.

To save the tutorial document for the first time:

Projecti||
New t-<rXlN
Open...

||Save
Save As...
Save Text Clip...
Print... tr-£-TJP
Print Merge...
Delete...

Preferences ►
About ►
Quit

1.

2.

Choose “Save” from the “Project” menu.

A file requester will appear so you can give your document a
name and choose where you wish to save it.

Click in the data entry area following the word “Untitled”,
backspace over “Untitled”, then type in Lesson 1.

1 f 1 - - — - - le
Docs Drawer J
FCFiles Drawer
FCFonts Drawer f-j
FCLIbs Drawer £;
fcLibsDev Drawer >;.
FCSpelt Drawer
FCThes Drawer 0
gt<3 Drawer W
hdr Drawer A
Macros Drawer v|

Drawer |SourcGDIsk:swDev/fc3 |
File [Lesson 1 |

l Save | Volumes | Parent | Export... | Cancel |

3. Click on “Save”.

Your tutorial document has now been saved for the first time.
Notice that the document remains on your screen.

2

Close box To close the document:

1. Click the mouse in the window’s close box located in the
upper left corner of the document window.

The program will remove the document from the window and
ask if it is OK to quit the program.

2. Click the mouse on the “No” button.

If you had chosen “Yes”, the program would have ended and
returned you to the Workbench™ window.
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Opening a document
In the previous exercise you closed the document you had created.
Normally, if you were going to make additional changes to the
document, you would not have closed it. But since this is a tutorial,
you need to know about closing a document. Now you will make
changes to your document. Before you can do this, it is necessary
to “Open" the document.

Save
Save As...
Save Text Clip..
Print­
print Merge.-
Delete„___
Preferences
About
Quit

Project

To open the tutorial document:

1. Choose “Open...” from the “Project” menu.

A file requester will appear on your screen.

2. Locate the document you just saved and double-click the
left mouse button on its name.

Final Writer will load the document from disk and display it in
the window.

Formatting a document
The following set of exercises shows you how to perform some of
Final Writer’s many exciting formatting commands.

Aligning text
Using Final Writer you can align your text in several ways:

Left Justified Left justified text is displayed so that each line
starts at the same position on a line.

Right Justified Right justified text is displayed so that each line
ends at the same position on a line.

Centered Centered text is displayed so that each line is
centered between its margins.

Full Justified Full justified text is displayed so that each line
starts and ends at the same positions on a line.

You can change the justification of one or more paragraphs using
either the ruler or a requester. Next, you will learn to change the
justification of two paragraphs using the “Justification Selector on
the ruler.
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To center text using the ruler:

1. Position the mouse before the very first word in the
document, “Professor”.

2. Drag the mouse down and to the right until the first two
lines of the document are highlighted and release the
mouse button.

"Center justification " icon

Deoi Mis. William:

The Playboy of lhe Western World, by J.M. Synge

The Collected Works of Yeats

Ulysses, by Janes Joyce

Happy Reading*

I received your letter asking for Information on Irish lileiature. You are absolutely col­
lect tlTcit reading a nation's lileiature is the best way to prepare for tiavels there. Lisle
below are selected works by some of Ireland’s greatesl authors. You may find these
Ijooks at your local library.

Maty Williams
222 Main Street
Hometown, Indiana 60209
U.S.A

Two lines are now selected.

2

3. Click on the “Center justification” icon in the ruler.

The two selected lines will be centered on the page. Notice the
lines are still selected. If you were going to make other
changes to these lines, you could do so without reselecting
them. Since you will be doing something else now, you will
want to deselect the lines.

4. Click the mouse somewhere else on the document.

The lines will be deselected.

To change justification of two or more paragraphs at the same time,
it is necessary to drag the mouse through text contained in the
paragraphs. If you only want to change justification of one para­
graph, you simply click the mouse in the paragraph to be changed.

Tutorial 2 - 9

Tutorial



Setting margins
The Final Writer ruler may be used for many different purposes
related to the appearance of your document on the page. Margins
may be easily set or changed by moving the left margin, right
margin, and first line indent horizontally along the ruler. For any
paragraph (text ended by a return), the first line indent sets the left
position of the first line of the paragraph; the left margin sets the
left position of the remaining lines in the paragraph; and the right
margin sets the right position of all lines in the paragraph.

To change the left margin using the ruler: 1 2 3 * * * * * * * *

1. Click the mouse anywhere in the document’s main para­
graph.

The main paragraph is the one that starts "I received...".

2. Position the mouse on the left margin marker.

[ol~s—r------ -------- ——~;irnua

I b" T^V"11 h' " I " ' " k' ' "r" ■ I;............k.............. .. I——r~-

Left Margin / pjrst jjnc [ne]elli

marker (lower) marker (upper)

On your document window the left margin and first line indent
are set at 1 inch. Since they are set at the same value, their
markers are drawn at the same location. The markers are
distinguished in that the first line indent marker is drawn above
the left margin marker.

3. Press and hold the left mouse button and drag the left
margin marker horizontally to the right until it is directly
over the “2" on the ruler.

Final Writer will automatically reformat the left margin of all
lines of the paragraph except the first line. As explained above,
the starting position of the first line in a paragraph is deter­
mined by the first line indent marker. In order to set the left
margin of the first line, you must use the first line indent.
Experiment by moving the first line indent marker to some
other position to the right of where it is now.
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iESL
Font
Text Styles

Other...
Leading
Style
Position
Width
Case
Color
Oblique Pe
Typo Spec:

8
10

-v<12
14
18

1 1
36
72

Changing font size
Final Writer contains a number of special features that allow you to
change the appearance of text in your document. You may change
the typeface, alter the spacing, and use a number of special effects
to give your type just the right appearance. In this exercise, you
will alter the appearance of the text in the body of your document
by changing the font size.

To change font size:

The text will now appear in 24 point size.

1. Drag the mouse over the line “Professor Sean O'Boyle”.

The text is now selected and ready to have its size changed.

2. Choose “24” from the “Size” sub-menu of the “Text”
menu.

2

3. Click the mouse anywhere in the document to deselect the
text.
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Working with master pages
A master page is a place in a Final Writer document where you
define text and graphics that are to appear on each of your
document's body pages. There are many uses for master pages,
including document titles, chapter names, special graphics, dates,
page backgrounds, and page borders. Any text or graphics placed
on a master page appear automatically on each of the document’s
body pages (excluding optional title page). It is entirely up to you
whether you enter anything on a document’s master page.

The information on master pages that follows in this tutorial illus­
trates one specific master page application—how to set up a typical
document header and footer.

Using master pages for headers and footers
“Header" is a term used to identify text and graphics that appear at
the top of a document’s pages. "Footer" is a term used to identify
text and graphics that appear at the bottom of a document’s pages.
In Final Writer you create these special areas using the master pages
feature.

Text and graphics that you would normally place in a header arc
placed at the top of a master page. Text and graphics that you
would normally place in a footer are placed at the bottom oi a
master page. If you are going to use the master page for headers
and/or footers, you should first specify the height of the area on a
master page that will be used for header and footer information. If
you do this, Final Writer will not allow you to enter text on a body
page in the areas where header or footer information appears.

Layout
Page Setup

[Section Setup
Paragraph .
Define Style
Apply Style
Bullet ~
Indent Right
Indent Left
Hanging Indent
New Section

To specify the height of header and footer areas:

1. Choose “Section Setup” from the “Layout” menu.

The "Section Setup" requester will appear on your screen.
2. Locate the section of the requester entitled “Margins”,

then click in the data entry area beneath the word
“Header”.

3. Replace the contents with the value “1 ”.
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This instructs Final Writer to offset the top of the body of your
document pages 1 inch from the top.

4. Now click in the data entry area beneath the word
“Footer”.

5. Replace the contents with the value “1

This instructs Final Writer to offset the bottom of the body of
your document pages 1 inch from the bottom.

lei'! 1 Jill

— Prefix—r

Bottom
11 Q ... .
— Inside — — Format —;
O~

r— Outside — Footer —

Header

Cancel

■------------------------- Section Settings
|— Edit Area —----- Page #s-------

— Section Name —
(Main

— Margins —
r- Header-;

[—Space —
IESE3— First#—r

m«a|

— Columns-----
B| One |

------ In List Show--------
Existing sections
j Preferences

Section List

Top 2

6. Click on the “Use” button at the bottom of the requester.

This instructs Final Writer to use your header and footer setup
for the current document only. Had you wished to save your
setup as a default to be applied to all future documents, you
would have clicked on “Save”.

To access the master page:

1. Click the mouse on the right master page icon in the
horizontal ruler at the top of your window.

"Right Master Page" icon
-------------- . .. - -—------ — - [anai

| ■ ■7~7I7,.,. ~ 77, ■ ■ ■,,...... . .  i,-*-?
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The blank master page will appear. The page does not show
the text you have already entered during this tutorial, because
the text was entered on the body page.

Notice that the insertion point appears automatically in the top
left corner of the master page.

To enter header text on the master page:

1. Type the following text:

Trinity College'll
Dublin, Ireland

(Remember, the SI symbol means to press the RETURN key.)

When you eventually return to the body pages of your docu­
ment, the header text will appear just as you have entered it on
the master page. If your document contained more than one
page, the header text would appear on all pages in the docu­
ment.
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To enter a line graphic in the footer on the master page:

1. Click on the “New Line” tool.

2. Scroll the document to the end of the page, and position
the mouse pointer approximately 1 inch from the bottom
of the page.

3. Drag the mouse horizontally across the page.

As you drag the mouse, a line is drawn.

2

4. When you reach the far right margin of your footer, stop
dragging the mouse and release the mouse button.

The line is now inserted in the footer of the master page and
will appear identically on every' page of your document.

To return to the body page:

1. Click on the body page icon at the top of your window.

The master page will disappear, and the body page of your
document will appear on your screen. Notice that the header
text and footer graphic appear on the body page just as you
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entered them on the master page. While in the body page(s) of
your document, any text or graphics entered on a master page
may not be edited. You must return to the master page to do
so.

Quitting and saving changes
You have almost reached the end of the tutorial. By now you
should have a good idea of how to create a document in Pinal
Writer. Of course there is much more to Final Writer than the
features covered in the tutorial. Refer to the remaining chapters for
instructions on operations such as type styling, spelling, using the
thesaurus, printing, and working with graphics.

The last exercise in the tutorial is about quitting the program. If
you have followed the steps in the tutorial, you should have a
document with changes that have not been saved.

To quit the program and save changes at the same time:

Project
New KEJN
Open... SEIO
Save eai's”
Save As... EJW
Save Tert Clip...
Print" R=li'p
Print Merge -
Delete ..
Preferences
About

1. Choose “Quit” from the “Project” menu.

The program will ask if you want to save changes to your
document.

2. Click the mouse on the “Yes” button.
The program will save your document to disk, and then return
you to the Workbench™ screen.
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| Setting Preferences
Final Writer’s preferences settings let you inform the program of
your preferred way of doing certain operations. Final Writer comes
to you with these preferences set to Softwood’s default values. You
can modify any of these settings as you see fit. This chapter
describes the preference settings so you can modify them to suit
your needs. Preferences described in this chapter are:

• User Menu preferences
• User Button Strip preferences
• Display preferences
• ASCII Input/Output preferences
• Startup preferences
• Speller/I Iyphenation preferences
• Document item preferences
• Document colors preferences
• Document save preferences
• Screen color preferences
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“User” menu preferences
You can specify menu items of your choice in Final Writer's “User"
menu. Menu items specified in this menu may be assigned one of
the Amiga® function keys seen at the top of your keyboard. Each
menu item can be assigned to:

• Run an ARexx script.
• Open a text clip.
• Activate a Final Writer menu command.
• Execute a string command.

The "User Menu Preferences” requester is where you specify menu
items for the User menu.

To access the “User Menu Preferences” requester:
Project

Start Up
Speller / Hyphenation
Document Items.
Document Colors
Document Save
Screen Colon .

Choose “User Menu" from the “Preferences” sub-menu
found in the “Project" menu.

Final Writer will open the “User Menu Preferences" requester.

i- Menu item Name -r

I I
r— Command Deiinition —

-------- Command---------
Select... |

Patn or Nome —,

Save | Use | Cancel |

IO

To add a new item to the “User” menu:

1. Click the mouse on the “New” button.
2.

-cJ -------- --------
i Text Clip
I Menu Command

Text Clip

Shing Command

3.

Enter a name for the menu item and press RETURN.

Indicate the type of command that is to be assigned to the
menu item you are creating by selecting from the “Type”
popup menu.
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4. Specify the source of the command by clicking on the
“Select” button and choosing an item from the list that
appears.

NOTE. If you are assigning a menu command, a list of Final
Writer menu commands will be displayed for you to select
from. If you are assigning an ARexx script, a file selector is
displayed in which you can locate and specify an ARexx script
to be assigned to the menu item. If you are assigning a text
clip, a file selector is displayed in which you can locate and
specify a text clip to be assigned. If you are assigning a string
command, a list of Final Writer string commands will be dis­
played for you to select from.

5. Indicate the menu position the new item is to appear in.

6. If you want a function key assigned to the menu item,
choose one from the list of FKeys. If you do not want a
function key assigned, choose “None” from the list of
FKeys (First item in the list).

7. Click the mouse on the “Accept” button to add the new
menu item definition to the “User” menu.

To remove an unwanted item from the “User” menu:

1. In the “Menu Items” list click the mouse on the name of
the item to be removed.

2. Click the mouse on the “Remove” button.

To modify an existing item in the “User” menu:

1. In the “Menu Items" list click the mouse on the name of
the item you want to modify.

2. Make whatever changes you want to make.

3. Click the mouse on the “Accept” button.

When you are finished making settings you can save them just for
the current document by pressing “Use", or save them for the
current document and as default values for new documents by
pressing “Save”.
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User button strip preferences
Final Writer's button strips contain buttons that you click on to
activate commonly used program operations. Each button can be
designated to activate one of the following type of operation:
• Run an ARexx script.
• Open a text clip.
• Activate a Final Writer menu command.
• Execute a string command.

You specify which buttons and commands are to appear in Final
Writer's button strips in the “User Button Strip" preferences re­
quester.

To access the “User Button Strip” Preferences requester:

IJMWI___________ 1.
New EEJN
Open EJO
Save E35
Save As. KJW
Save Tert Clip
Print' (EJP
Print Merge
Delete
IrfHHH'ifr! User Menu___________

[User Button Ship
Qu7 • Display

-------------  ASCII I/O
Start Up
Speller / Hyphenation
Document Items .
Document Colors
Document Save
Screen Colors

Choose “User Button Strip” from the “Preferences” sub­
menu within the “Project” menu.

Final Writer will display the requester.

— Button Ship —
C?| Button Strip 1

Ite
Pc

• Vi

*=• (

Button Strip 3
Button Strip 4
Button Strip 5
Button Strip 6
Button Strip 7
Button Strip 8

Final Writer gives you 8 button strips in which to place buttons.
When the requester is displayed, buttons in Button Strip 1 are
displayed.

To access a different button strip:

1. Choose the desired button strip from the popup menu
located just above the list titled “Commands”.
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To add a new button to a command strip:

1. Locate the button to be added in the list titled “Buttons”.

~Cc
s

Ljfir.f: ____ ] -
Text Clip
Menu Command
String Command

2. Press the mouse on the button and while holding it down,
drag the button from the “Buttons” list into the “Com­
mands” list.

3. Indicate the type of command to be assigned to the button
by choosing an option from the “Type” popup menu.

4. Specify the source of the command by clicking on the
“Select” button and choosing an item from the list or file
selector that appears.

NOTE. If you are assigning a menu command, a list of Final
Writer menu commands will be displayed for you to select
from. If you are assigning an ARexx script, a file selector is
displayed in which you can locate and specify' an ARexx script
to be assigned to the button. If you are assigning a text clip, a
file selector is displayed in which you can locate and specify' a
text clip to be assigned. If you are assigning a string command,
a list of Final Writer string commands will be displayed for you
to select from.

------ After Button-------- >
’/\ Add Eztiq Space |

5. If you want extra space to appear after the button when it
is shown in the button strip, click the mouse on “Add
Extra Space” so a check mark appears.

Extra space after burton
To remove a button from a button strip:

1. In the “Commands” list, press the mouse on the line that
contains the button definition to be removed and drag the
button outside of the “Commands” list.

To modify an existing button in a button strip: 

1. in the “Commands” list, click the mouse on the line that
contains the button definition to be modified.

2. Make any desired changes.
When you are finished defining button strips you can save them for
the document by' pressing "Use", or save them for the document
and as default values for new documents by pressing “Save .
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Display preferences
Final Writer’s “Display’' preferences let you define various elements
that affect the way a document is displayed on your computer
screen.

To set Display preferences:

Delete.

New
Open.

EEJN
rao

Save E3S
Save As.. EJW
Save Text Clip..
Print..
Print Merge..

K3P

I. Choose “Display” from the “Preferences” sub-menu in the
“Project" menu.

The “Display Preferences" requester will appear.

2. Set the preference values according to your needs.

NOTE. Descriptions of the settings are given below.

3. Click on “Use” to save the settings for just the current
document. Click on “Save” to also save the settings so
they will be used for new documents.

Descriptions of the Display preference settings are as follows:

Screen DPI
The screen DPI setting is used to specify the horizontal and vertical
resolution for your screen display. Resolution is measured in dots
per inch (DPI). The default values are 80 for horizontal and 72 for
vertical. The larger the number used, the more screen area will be
required to show an inch of document information.

Setting the screen DPI will have no effect on printouts. Regardless
of the screen's resolution, printing will always be performed at the
printer's resolution. The purpose of the screen DPI preference is to
allow you to match your display to your computer monitor and its
settings. If the screen DPI default settings seem inadequate for your
monitor, vou may wish to experiment with different settings.
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Page guides
The page guides preferences are used to turn on or off grey lines
that appear as guides in a Final Writer document. These lines
provide a visual representation of your print area, edit area, header/
footer areas, and columns.

Rulers
The rulers setting is used to define which screen rulers, if any, will
be displayed. The “Top Only” option will display only the horizon­
tal ruler at the top of your window. The “Left and Top" option will
display both the horizontal top ruler and the vertical ruler at the left
of the window. “No Rulers" will produce a window in which
neither the horizontal nor vertical ruler are shown.

Measure in
The measure in setting is used to specify the measurement system
for the document.

IFF ‘On Screen’ colors
The IFF ‘On Screen’ colors preferences specify the way a
graphic's original colors arc converted to screen colors for display
on your screen. This setting has nothing to do with printed output.

WB Document Color
The WB Document Color preference item lets you set the
document’s background (paper) color when using a Workbench™
screen. The screen shots on the back of the Final Writer box were
taken with Final Writer running on a 16 color Workbench screen
with the "WB Document Color" option set to “Use Highlight Pen .

Window size
The window size preference lets you save your current document
window size as a default setting. All subsequent document win­
dows will automatically open to this size.
NOTE. If you check the “Window Size” preference, the setting will
affect all subsequent new document windows regardless of whether
you click on “Save" or “Use".
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ASCII file input/output preferences
Final Writer preferences determine how an ASCII file is read and/or
written.

ASCII Input preferences are used for:
• Opening and reading an ASCII file.
• Pasting data from the clipboard created in another program.
• Accepting data through ARexx.

ASCII Output preferences are used for:
• Writing an ASCII data file.
• Copying data to the clipboard that will be used in another

program.
• Sending data to ARexx.

To change ASCII I/O settings:

313033
New
Open..

K3N
K30

Save K3S
Save As... KE5W
Save Tert Clip.
Print.. EE3P
Print Merge .
Delete .

About
User Menu .
User Button Strip.

Quit Display..— F.VWI I
Start Up.
Speller / Hyphenation.
Document Items .
Document Colors .
Document Save
Screen Colors..

Select “ASCII I/O” from the “Preferences” sub-menu in the
“Project” menu.

The “ASCII File Input/Output Preferences” requester will
appear.

~:f.TT|E .1, i|...irT~3T...l. jTF,?.. = -■ | S3
-----------------------Input (Open) Options--------------------------
y| Make a paragraph at each New Line' character.
_ | Make a paragraph at each blank line.__________

---------------- Output (Save) Options------------------
✓| Insert New Line' character alter each line.
_| Insert blank line alter each paragraph.

Save | Use | Cancel |

2. Click on the button preceding the ASCII input and output
preferences you wish to implement.

3. Click on the “Save” button to indicate that you have
changed the default settings, or on “Use” to change the
settings for the current document only.
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Startup preferences
The “Startup” preferences are used by Final Writer when it starts up
to determine what kind of screen to use. If you have not saved any
startup preferences, Final Writer will display the “Startup" requester
each time you start the program.

You will probably find it convenient to specify the screen type you
prefer in the “Startup” preferences so that each time you start Final
Writer the program will automatically open on that type of screen.
The alternative, and the way the program comes from SoftWood, is
that the startup requester is displayed each time you run Final
Writer. With this default setting, you indicate the desired screen
type each time the program runs.

To specify startup preferences:

Delete

New
Open esso
Save EE3S
Save As .
Save Text Clip
Print
Print Merge

Select “Startup” from the “Preferences” sub-menu in the
“Project” menu.

The “Startup Preferences" window will appear.

IS

New Screen Options

------ Screen Type--------
__) Use Workbench
J Open New Screen
C Ask at Startup.

Save | Cancel |

2. Click on the button preceding the desired “Screen Type .

3. Choose the desired screen “Mode”.

4. Click the mouse on the “Save” button.
NOTE. No “Use” facility exists for the "Startup Preferences
requester because Final Writer does not let you assign startup
preferences to individual documents.
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Speller/Hyphenation preferences
These preferences let you define options the program will use
during spell checking and paragraph hyphenation. For spell
checking you can indicate whether spelling alternatives are given
automatically, adjust the size of memory Final Writer's speller uses
for certain operations, and specify error reporting tolerances. For
hyphenation you can indicate whether hyphenation is to be on or
off, and how much memory the program can use for hyphenation.

Delete

Nev/
Open

raw

Save EJ5
Save As. ee=3w
Save Tert Clip
Print.
Print Merge

EE3P

[Preferenc|
About
Quit”*"

User Menu
User Button Strip
Display
ASCII I/O .
Start Up.
Speller/Hyphenation
uocumenr items
Document Colors
Document Save
Screen Colors .

To set Speller/Hyphenation preferences:

1. Choose “Speller/Hyphenation” from the “Preferences”
sub-menu in the “Project” menu.

The "Speller and Hyphenation Preferences” requester will
appear.

I el

2. Set the preference values according to your needs.

NOTE. Descriptions of the settings are given below.
3. Click on “Use” to save the settings for just the current

document. Click on “Save” to also save the settings so
they will be used for new documents.

The following are descriptions of this requester's settings.

RAM Dictionary, Cache Size, and Skip Cache
The RAM Dictionary represents the amount of internal memory
devoted to the speller - larger sizes result in faster spell checking.
A cache is an internal-memory list used to store recently used
words, eliminating the need for further access to the speller when
those words occur again in your document. The size of a cache
impacts the speed with which the speller checks a document. A
higher setting means a speedier spell check, but less internal
memory available for other uses. The first cache stores words that 
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you have used to replace misspelled words in your document. The
second cache, called the skip cache, stores words that you have
instructed the speller to skip.

Automatic Suggestions
When this option is on, suggested words will be automatically given
for each word not found in the dictionaries during spell checking.

Error Reporting
This option lets you turn off the reporting of some conditions
detected by the spell checker.

Hyphenation
Enable this option to allow hyphenation for your document. Dis­
able the option to prevent hyphenation. Individual paragraphs also
have a hyphenation setting which must be ON in order for hyphen­
ation to occur in the paragraph.

Memory Usage
Use this option to indicate the amount of memory the hyphenation
process can use. Higher memory yields faster hyphenation.
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Document Item preferences
Document Item preferences tell Final Writer how much space to
insert when you press the TAB key and no tab stop has been set,
how to format dates and times when inserted via the insert date and
insert time commands, and what character to use for decimal points
in amounts.

To set Document Item preferences:

Pioiecr
Nev/ CE3N
Open . KE30
Save eais"
Save As.
Save Text Clip ..
Print jp?lip~
Print Merge
Delete.

User Menu..
User Button Strip
Display
ASCII I/O
Start Up...
Speller / Hyphenation.
Document itemi
Document Colors
Document Save .
Screen Colors

About
Quit”**'

Choose “Document Items” from the “Preferences” sub­
menu in the “Project” menu.

The “Document Item Preferences" requester will appear.

2. Set the preference values according to your needs.

NOTE. Descriptions of the settings are given below.
3. Click on “Use” to save the settings for just the current

document. Click on “Save” to also save the settings so
they will be used for new documents.

The following are descriptions of Document Item preferences:

Tabs Every
In Final Writer you can set tab stops in two ways. One is to use the
ruler (explained in Chapter 7). The other way is to tab in specified
increments using the space defined in this requester. Final Writer
comes to you with default tab spacing set at .5 inch increments.
These default tab stops do not show on the ruler. If you set normal 
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tab stops using the ruler, any default tab stops up to and including
the position of a normal tab stop are removed. Default tab stops
will continue to exist past the final normal tab stop.

Tab stops set with the “Document Item Preferences" requester are
always “Left Tab” stops. If you want to use other types of tab stops,
you must set them using the ruler. Since tabs may be set on a
paragraph-by-paragraph basis using the ruler, you might wish to use
the “Document Item Preferences" requester to specify your most
frequently used tab configuration as a default setting. Then, if you
need a specific paragraph to deviate from this configuration, you
can reset its tabs on the ruler.

Decimal
You may specify one of two decimal styles—period or comma—for
your documents. If period is chosen, decimals will be displayed as
periods; if comma is chosen, they will appear as commas.

Date Format and Order
Using the “Document Item Preferences” requester, you can define
the format and order for dates that you insert in your documents
with the “Insen Date” command.

Time Format
The “Document Item Preferences” requester offers you two format
options for time of day inserted in your document with the “Insen
Time" command.
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Document Color preferences
These preferences enable you to define the shading of 16 colors
that may be used in your document for text, lines, boxes, and ovals.
These 16 colors have nothing to do with either the screen colors
used in Final Writer or colors that are imbedded in IFF pictures that
are imported. The colors you define here are only for text and any
lines, boxes, and ovals you draw inside Final Writer. Furthermore,
the colors defined here may or may not be displayed on your
screen in the way you define them. As with IFF picture colors,
these 16 colors are converted to the colors that arc available on
your screen. These colors will, however, print as you define them.

To define a document color:

Delete
|PreferenC|
About
Qu7T“

User Menu
User Button Strip
Display .
ASCII I/O.
Start Up.
Speller / Hyphenation
Document Items

||Documenr Colors
Document Save
Screen Colors

I. Choose “Document Colors” from the “Preferences” sub­
menu in the “Project” menu.

The “Document Color Preferences" requester will appear. In the
requester you will see a list containing 16 color choices, some
of which may be titled "Undefined". You may change the name
and/or shading of any of these colors.

2. Click on the line containing the color you wish to define.

When you click on the line, the program will change the color
of the mouse pointer to reflect the shade of the color selected,
and then transfer the name and definition of the color into the
definition portion of the requester.

3. If you want to change the name of the color, modify its
name as it appears under "Name” and press the RETURN
key.
When you press RETURN the new name will appear in the list.
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4. If you want to change the color's shade, move one or
more of the color sliders horizontally.

As you move the slider the color in the mouse pointer will
change to reflect the color you have chosen.

5. If you make a mistake and wish to undo the change you
have made to the color's name or shade, click on the
“Undo” button.

6. Repeat this process for as many colors as you want to
define.

7. When you are finished defining colors, click on “Use” to
implement the color definitions for only the current docu­
ment, or click on “Save” to implement the color definitions
as default settings for all new documents, as well as for
the current document.

NOTE: If you click on “Save” other documents you have
already created will retain their color definitions - only the
current and new documents will utilize the revised definitions.
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Document Save preferences
This set of preferences is used to specify how much information
you want saved with each document, and to set the program's Auto-
Save feature to ON or OFF.

To set Document Save preferences:

New p^wn
Open . E3O
Save IE3S
Save As.. EE3W
Save Text Clip..
Print. eEjP
Print Merge..
Delete..

Jser Menu .
User Button Strip
Display..
ASCII I/O .

About
Quit"'”

Start Up..
Speller I Hyphenation .
Document Items.
Document Colors..
Document Save
Screen Colors...

Choose “Document Save” from the “Preferences” sub­
menu in the “Project” menu.

The “Save Document Preferences" requester will appear.

2. Set the preference values according to your needs.

NOTE. Descriptions of the settings are given below.

3. Click on “Use” to save the settings for just the current
document. Click on “Save” to also save the settings so
they will be used for new documents.

Descriptions of Document Save preferences are as follows:

Save With Each Document
When you save a document to disk Final Writer can also save any
preference and style settings with the document. When you open a
document, Final Writer will replace any program default preference
and style settings with those stored with the document. The more
settings that are saved with a document the larger the disk space
required to store the document. If you want to conserve disk
space, you should not save any preference or style settings with a
document that are the same as your program defaults. A check
mark in front of any Preferences or Styles item indicates that item
will be saved with a document.
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Auto-Save
Whenever you work on a document it is a good idea to save the
document periodically. This protects you from losing your work
after a hardware failure or loss of electricity. When the Auto-Save
feature is ON, the program will wait a specified length of time and
then ask if you want to save the document. The length of time is
set using the “Every" popup menu.
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Screen Color preferences
These preferences enable you to define the shading of the 4 colors
Final Writer uses to display window images such as rulers. These
colors have nothing to do with the colors you use to draw text or
graphic objects. The sole purpose of these preferences is to give
you the opportunity to pick your own color scheme for viewing the
Final Writer window.

To define a screen color:

New
Open..

esN
esso

Save CEJS
Save A$. raw
Save Text Clip
Print rap
Print Merge.
Delete

I. Choose “Screen Colors” from the “Preferences” sub­
menu in the “Project" menu.

The “Screen Color Preferences” requester will appear. In the
requester you will see a list containing 4 color choices

2. Click on the line containing the color you wish to define.

When you click on the line, the program will change the color
of the mouse pointer to reflect the shade of the color selected,
and then transfer the name and definition of the color into the
definition portion of the requester.

3. If you want to change the color's shade, move one or
more of the color sliders horizontally.

As you move the slider, the color in the mouse pointer will
change to reflect the color you have chosen.

4. If you make a mistake and wish to undo the change you
have made to the color's name or shade, click on the
“Undo” button.

5. Repeat this process for as many colors as you want to
define.
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| Page Setup
This chapter describes the process of defining page attributes. In
Final Writer some page attributes are set for the entire document
and others are set for individual sections.

Attributes set for the entire document include:

• Paper dimensions.
• Orientation (wide or tall).
° Right or Left/Right pages.
• Printable area on page.
• How the document is to be numbered.

Attributes set for individual sections include:

• Section name.
• Editable area on page.
• Prefix (if any) before page numbers.
o Format of page numbers.
° Number of columns.
° Space between columns.
° Header and footer margins.
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“Page Setup” requester
Page attributes that affect the entire document are defined in Final
Writer's “Page Setup" requester. These attributes are originally set
to Softwood's default values, and may be modified to suit your
needs. When a document is saved, its page setup instructions can
be saved with it. When a document is opened, any page setup
instructions saved with the document are used.

To define page attributes that affect the entire document:

1. Choose “Page Setup” from the “Layout” menu.

The “Page Setup” requester will appear.

2. Make the desired settings.
3. Click on “Use” to save the settings for only the current

document. Click on “Save” to also save the settings as
default values for new documents.

Attributes set in this requester are:

— Page S::e —
Oil.... .. .

rDi US Legal
r-F B_5t
l_ custom

cA3
|UA5

Page Size
Page Size is used to define the physical dimensions ot the page you
are using for the document. There are six predefined page types to
choose from, as well as a custom page type. If your document's
page is different from one of the predefined types, choose ’ Custom'
page type and specify the width and height of the page.
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_______ Pages------j
C|

Left/Right _

— Print Area------

cl ■ :

DeskJet
Sheetfed
Continuous
Other

Number
c| r L

By Section

Orientation
This setting is used to tell Final Writer whether to print your docu­
ment in tall or in wide mode. A document printed in tall mode will
have its top at the narrow end of a page.
Pages
Use this setting to indicate whether you want to use Left/Right or
simply Right only pages. Usually the only time you will use Left/
Right pages is when your document will be bound with pages
facing each other like the ones in this manual. For letters and other
documents, Right only pages are generally used.

Print Area
Each type of printer has limitations on the area of a page in which it
can print. For example, a continuous feed printer with a narrow
carriage can only print 8 inches wide even though the paper you
feed into it is 8 1/2 inches wide. In this case the non-printable area
is 1/4 in. on the left, and 1/4 in. on the right; and the “Left" and
“Right" Print Area margins would each be set to .25 inches. On a
laser printer or printer with a sheet feeder, there will also be an area
on the top and bottom of a page where the printer can not print.

Below arc examples of printer print areas:

Printer Top Bottom Left Right
IIP LaserJet .625 in. .625 in. .25 in. .25 in.
IIP DeskJet .1875 in. .375 in .25 in. .25 in.
Sheet fed 1 in. 1 in. .25 in. .25 in.
Continuous 0 0 .25 in. .25 in.

Final Writer will set the print area margins to one of the above
values depending upon which Print Area option you choose. If
none of these print areas will work for you, choose “Other" and
specify- your own margins. Usually you can consult your printer’s
user manual for information on your printer’s print area. When you
print using a sheet fed printer, and you get an extra blank page, it
is usually because the print area or page type are not defined
correctly.

Number Pages and Page #s
If you are going to have more than one section in your document,
and you want page numbers to begin numbering at each type of
section, choose the “By Section" option. If you want your docu­
ment to be numbered consecutively from beginning to end, choose
the “By Document” option and specify the value that page number­
ing should begin with.
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“Section Setup” requester
When you begin a new document Final Writer creates the document
with one section. You can leave your document containing only
one section or you can insert additional ones. Each section can
have its own master pages and page attributes. Page attributes
defined for each section are found in the “Section Setup” requester.

To define page attributes that affect a section:

Loyout
Pace Setup
[Section Setup
Paragraph
Define Style *
Apply Style»
Bullet
Indent Right
Indent Lett
Hanging Indent
New Section >
Ren'iCve Section
Insert Page Break fcJL
Remove Page BhcIc

The “Section Setup" requester will appear.

1. Choose “Section Setup” from the “Layout” menu.

2. Make the desired settings.
3. Click on “Use” to save the settings for only the current

document. Click on “Save” to also save the settings as
default values for new documents.

Attributes set in this requester are:

In List Show
The “Section Setup" requester can be used to define attributes for
sections that exist in a document, and for default attributes to be
used for new sections to be inserted in your document. Use this
setting to tell the program which attributes you want to define.

Section List
This list will show all existing sections in your document when “In
List Show" is set to "Existing Sections”, and will show Final Writer
section types when the "Preferences" option is selected.

Section Name
This will be the name that is selected in the "Section List".
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Edit Area
Four edit area settings define the area in which text may appear on
a page. Final Writer uses them as limits for the left margin, right
margin, first line indent, tab stop, and hyphenation hot-zone margin.
When you specify any of these settings, Final Writer will not let you
specify a value that is outside the edit area. The recommended way
of using the edit area is as follows: If you want a one inch margin
to appear around your page, set the edit area’s top, bottom, left,
and right margins to 1.0 inch. Never set the edit area so that it is
closer to the edge of the page than the print area. If your edit area
extends outside the defined print area, some of your text may not
show on the page when it is printed.

You will need to enter separate settings for the top, bottom, inner,
and outer boundaries of the edit area. If you have selected Left/
Right pages, the outside boundary will be on the left side of the left
page and the right side of the right page.

Page Setup
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Hie preceding example shows the relationship between inside and
outside margins and left and right pages. Typically, when using
left/right pages, you should set the inside margin larger than the
"outside margin". By doing this, when the document is printed, the
printed area of a page will be offset into the page to allow room for
binding. If your document is a letter, memo, or other document
that will not be bound, you will normally set the inside and outside
margins to the same value, and not use the “left/right page" option.

a. b, c

— Columns —

01J L’-J.j
Two
Three
Four

J
L

Five
Six 3j

print area
margin

edit area
margin

1 \

header

1

1

Body

1 footer

Page #s: Prefix and First #
In the “Page Setup" requester described earlier in this chapter there
is an attribute setting titled “Number Pages". When the "Number
Pages" attribute is set to "By Section" the requester's “Prefix" and
“First #” attributes under the title “Page #s" arc active. The “Prefix"
attribute is used to define text that you want prefixed to any page
numbers in your section. For example, this page of the manual has
a prefix of “4 - ” (see below). The “First #” attribute is used to
define the starting value for page numbering in this section.

Format
This attribute defines how you want page numbers to appear.

Columns
In Final Writer you can define each section with up to 6 side-by-
side, newspaper style columns. You may also define the space that
is to appear between each column.

Text entered in a document with multiple columns will automati­
cally flow from the bottom of one column to the top of the next as
you type. If you are revising a document that has already been
saved and wish to change the number and/or width of columns,
your text will automatically reformat when you alter the column
settings.

Headers and Footers
“I leader" is a tenn that refers to an area at the top of a page that
contains text and/or graphics that repeat on pages throughout the
document. "Footer" is a term that refers to a similar area at the
bottom of pages. "Body" refers to the area between the “Header ’
and "Footer".
In Final Writer, header and footer margins define the portion of a
master page (See Chapter 7) where header and footer information
appears. These margins redefine the size of the "Body" area of a
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page so that text entered into it will not cover up areas where
header and footer information show. For example, if you set up a
master page with a page number that is to appear on each of your
document's pages, you would not want text you enter to go on top
of and cover the page number. To keep Final Writer from placing
"Body" text in the area where your page number is, you define
either a header or footer margin in such a way that normal "Body"
text will not flow on top of the page number.

The header and footer settings in the “Page Setup" requester allow
you to specify the size of any header or footer area you want in
your document. For instance, if you enter “2" in the “Header” data
entry area, the "Body" area of your pages will begin 2-units (inches,
centimeters, or picas, depending on the unit or measurement
specified in your preferences) from the top of the "Edit Area”. So,
as you change the boundary of the header and/or footer in a
document, the height of the body area also changes.

NOTE: The header and footer areas reside within the edit area.
Therefore if you set your Edit Area Top at 1 inch, and your Header
margin at 2 inches, the body of your document will be 3 inches
down from the top of the page.
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| Creating and Saving a Document
This chapter gives you an overview of the basic information and
commands you will need to begin your document project. Because
the initial creation of a document usually involves a lot of typing
and very little editing or formatting, these more advanced com­
mands will be discussed in the chapters entitled “Revising a Docu­
ment” and “Formatting a Document".

Discussed in this section are commands that will enable you to:
• Create a new document window
• Insert text
• Correct mistakes as you type
• Select text
• Delete text
■ Save a document
• Close a document
° Create text clips
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Creating a new document
In order to begin a new document project, you will want to have an
untitled Final Writer window.

To create a new document window:

1. Start the Final Writer program or select “New” from the
“Project” menu.

A blank document window with “Untitled" in the title bar will
appear. The insertion point is automatically set in the upper
left corner of the new window.

2. Begin typing your document.

As you type, if the last word of a line does not fit in its entirety
on a line, the word will either be wrapped around to the next
line or hyphenated. Because of this feature, there is no need to
press the RETURN key at the end of each line as you type,
unless you want to force a line to end, or start a new
paragraph.
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Inserting text
“Inserting” is the term used to describe the process of adding
characters to existing text in a document. For example, as you are
typing a document, you may wish to add a sentence in the middle
of a paragraph you have already written. Or, you may need to
insert spaces or blank lines in your document.

In our discussion here, text will refer to any typed character con­
tained in a Final Writer document. Numbers, letters, punctuation
marks, blank lines, and spaces will all be considered text.

Setting the insertion point
Text can only be inserted at the insertion point. The insertion point
may be moved within text by pressing the keyboard arrows or by
using the mouse. In a new document window, the insertion point
is preset in the upper left corner of the window.

To set the insertion point using the mouse:

1. Move the mouse to the area in the document where you
wish to enter text.

2. Click the mouse button.

If you click the mouse at any point beyond the last character in
a document, Final Writer will automatically place the insertion
point just after the last character in the document (if any).

Inserting characters
When you enter characters on the keyboard, Final Writer inserts
them into your document at the location of the insertion point.

To insert characters:

1. Set the insertion point where you wish to add new text.

2. Type the characters you wish to insert.
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Inserting blank lines
Blank lines may be inserted by using the RETURN key.

To insert blank lines:

1. Set the insertion point where you wish to add blank lines.

2. Press the RETURN key once for each line you wish to add.

If you are at the end of a line when you first press the RETURN
key, Final Writer will go to the next line. It is from that point
that blank lines may be entered.

Correcting mistakes as you type
The ability to correct mistakes as you type is one of the most
important features of any word processor. Final Writer makes it
easy for you to remove typographical errors as you go along.

To correct a typing mistake:

1. Use the BACKSPACE key to delete the characters you
wish to remove.

Each time you press the BACKSPACE key, the character or
space immediately to the left of the insertion point will be
deleted.

2. Type the correct characters once you have removed the
mistake.

Selecting text
Selecting text is often performed during the creation of a document
to specify an area of text where you would like to make a change.
For example, you might decide to change text to bold, that a certain
phrase should be replaced by another, or that an entire paragraph
should be deleted. When you have selected text in Final Writer, it
is highlighted on the screen. You may select individual characters,
words, lines, sentences, paragraphs, or even the entire document.
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Selecting a block of text
You may select a block of text by dragging the mouse over it.

To select a block of text:

1. Position the mouse at the beginning of the text to be
selected.

2. Press the mouse button and drag the mouse until all
desired text is selected.

As you drag the mouse, Final Writer will highlight the selected
text. If you drag the mouse above or below the window
border, the document will automatically be scrolled for you.

To select a single word quickly:

1. Double click the mouse on the word to be selected.

When you double-click on a word. Final Writer selects all
characters that could be part of that word, plus the space
following the word.
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Deleting text
Deleting is the act of removing text from a document. Characters
may be deleted one at a time or in selected blocks of text. As text
is deleted, your document will reformat automatically to fill in
where the deleted text used to be.

Deleting a character
You can use the BACKSPACE key to remove characters in a right to
left direction from the insertion point.

To delete a character with the BACKSPACE key:

1. Set the insertion point to the right of the text to be deleted.

2. Press the BACKSPACE key.

Copy
Paste
Clear

EH.

Select All K3A
Find . CEE9F
Replace R3R
Go To Page

Go To Selection

®E3G

Insert Item
Update Item
Copy Ruler
Paste Ruler Ell

Deleting selected text
When you need to delete several characters at once, it is sometimes
more efficient to first select the text to be deleted, and then delete it
using one of the following methods.

To delete selected text:

1. Select the text to be deleted.
2. Press the BACKSPACE key one time, or choose “Clear” or

“Cut" from the “Edit” menu.

If you choose the "Cut" command, the deleted text may later be
"Pasted" in another place in the document. If you choose
"Clear", the text is permanently removed and cannot be pasted.
Use “Clear" only when you know you do not want the text.

Deleting a blank line (RETURN character)
A blank line is one that contains only a RETURN character.

To delete a blank line with the BACKSPACE key:

1. Place the insertion point at the left margin of the line
below the blank line you wish to delete. If there is not a
line below the blank line to be deleted, place the insertion
point on the blank line itself.

2. Press the BACKSPACE key.
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Saving a newly created document
Once yon have finished writing your new document, you should
save it to either the hard drive or to a floppy disk. Once saved, the
document can be reopened for editing or formatting. Even if you
are going to edit your document immediately after completing the
first draft version, you should still save the document to safeguard it
in case of power outage or other unforeseeable events.

To save a document for the first time:

1. Select “Save” from the “Project” menu.

A file requester will appear in which you can give your docu­
ment a name and choose where you wish to save it.

ScMc.« | Volumes | Poront | Bpotf.. | Cancel |

—------ ---------------------- .................. ..... .............. |B
Doct Orowei
FCFitot Drawer
FC Font; Drawer
FC LiEu Drawer
fclibsDev Drawer
FCjpoll Drawer
FCInoi Drawer
oCO Drawer
ndr Drawer
Macro* Drawer V
Draper |3ourccDIiicrwDovA=&

Fae |LerK*n I

2. Click in the data entry area following the word “File”,
delete the word “Untitled”, and type the desired document
name.

3. You may assign your file to a drawer by either using the
“Parent” and “Volumes” buttons, or by clicking in the data
entry area following the word “Drawer” and typing in the
appropriate drawer name, then pressing the RETURN key.

4. Click on “OK”.

Closing a document
Window close
gadget

o'.............ti" ’ •'1 ■ l

You can close a document using the window close gadget.

To close a document:

1. Click the mouse in the window close gadget.

If you have made any changes to the document, and have
forgotten to save them, a requester will appear to remind you to
do so.
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Text Clips
Many times when you create a document, you will enter text that
has previously been entered in other documents. A good example
is your name and address as it appears at the top of a letter. Other
examples include:

• FAX headings
• Memo headings
• Names and addresses of clients
• Common text used over and over
You can automate the task of entering these and other commonly
used bits of text by using Final Writer's text clip feature. For
example, you can save your name and address, complete with type
and paragraph settings, in a text clip. Then, when you create a
document and need to insert your name and address in it. you
instruct Final Writer to place the text clip in your document, saving
yourself the bother of typing it all over again. This process is
especially useful when you assign a text clip to either a L'ser Button
or I’ser Menu Item. Let's say you have assigned your name and
address to a button labeled "M". To have Final Writer insert the
contents of the text clip in your document, complete with format­
ting, all you need do is click the mouse on the “M" button.

To create a text clip:

1. Enter and format the text that is to be in the text clip.

2. Select the text that is to comprise the text clip.
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3. Choose "Save Text Clip” from the “Project” menu.

Final Writer will display a file requester.
4. Use the file requester to give the text clip a name and a

place to save it.
l-'inal Writer will save the text along with all format settings <.
disk file having the name you entered.

Refer to Chapter 3 -Setting Preferences for details on assigning a
clip to a button or menu item.

Creating and Saving a Document g

C
reating and Saving

a D
ocum

snl





Revising a Document



| Contents
Opening a document

Opening a document 6-2

Moving through text
Scrolling text 6-3
Using the “Go To" commands 6 - 4
Using the "Page Number" icon 6-4

Replacing text
Replacing text with new text 6-5
Replacing text using the “Paste”

command 6 - 6

Copying text
Copying text 6-6

Moving text
Moving text 6-7

Finding and replacing text
Finding text 6-8
Finding and replacing text 6-10

Inserting the date or time
Inserting the date or time 6-12

Updating date and time
Updating date or time 6-13

Sorting paragraphs
Sorting two or more paragraphs 6-13

Adding a column of numbers
Adding a column of numbers 6-14



| Revising a Document
In the previous chapter, you learned to insert text, correct typo­
graphical errors, select text, and delete text. In this chapter you will
learn the following additional editing functions to help you revise
existing documents:
• Opening an existing document
• Moving through text
• Replacing text
• Copying text
• Moving text
• Finding and replacing text
• Inserting date and time
• Updating date and time
• Sorting paragraphs
• Adding a column of numbers
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Opening a document
A document must be open and visible on the screen before it can
be edited.

To open an existing document:

New CEBN

Save B53S
Save As... K£SW
Save Text Clip...

Project

Print... 853 P
Print Merge...

Delete...
Preferences ►
About ►
Quit

1. Choose “Open..." from the “Project” menu.

A file requester will appear on your screen.

IO
FWFlies Drawer
FWFonts Drawer
FWLIbs Drawer
FWMacros Drawer
FWSpell Drawer
FWThes Drawer
FlnalWriter 526172
Install.loa.file 1158 J
More

= i- i.-
7912 A J

_____________________________ V|
Drawer |StorageDisk.FlnalWriter |

File|ReadMe |
I1— OK | Volumes | Patent | Cancel |

2. If necessary, use the scroll arrows to find the document
you wish to open. If you need to go to a different Parent
or Volume to locate your file, click on the appropriate
button to do so.

3. When you have located your document, click on its name
to select it.

Notice that the name of the document appears in the data entry
area following the word "File". If you prefer to type the name
of your file directly in this area instead of scrolling the list and
clicking on the name, you may do so. Simply click the mouse
in the data entry area and type the file name exactly as it
appears on the list.

4. Click on the “Open” button to open the document.

Your document will now appear in the Final Writer window.
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Moving through text
In order to see parts of the document which are not currently
visible on the screen, it is necessary to move the document through
the window.

Scrolling text
The scroll bars allow you to move your document up, down or
sideways within the document window.

To scroll text in small increments:

1. Click the mouse on the scroll arrow that points in the
direction you wish to move in the document.

P’or example, to move toward the bottom of the document, click
on the down arrow. If you click and hold on the down arrow.
you will eventually scroll the document to its end. There will
be a slight delay when you first press on an arrow.

To scroll text in larger increments using the scroll box:

1. Click the mouse in the region of the scroll box that corre­
sponds with your desired direction of scrolling.

In the illustration shown on this page, the scroll box only exists
beneath the scroll drag bar. This situation occurs when the top
of a document appears at the top of the window. When the
document is scrolled toward the bottom, there will be two scroll
box areas: one above, and another below the scroll drag bar.
Clicking in the scroll box area above the scroll drag bar moves
the viewing area toward the top of the document, clicking in
the scroll box area below the drag bar moves the viewing area
toward the bottom of the document.

To scroll text in larger increments using the scroll drag bar:

1. Drag the horizontal or vertical scroll drag bar until you
reach your desired destination.

The horizontal scroll bar moves left and right through text. The
vertical scroll bar moves up and down through text.
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To go to a specific page in a document:

1.

2.

3.

To go to selected text in a document:

Using the “Page Number” icon

document's w indow can be used to access pages as follows:

To go to the next page:

1. Click the mouse on the icon.

Using the “Go To” commands
Final Writer's “Go To" commands, found in the "Format” menu,
allow you to move directly to any page or to previously selected
text within your document. This method of moving through text is
especially helpful when your document is very large and scrolling
would take too much time.

Choose “Go To Page” from the “Edit” menu.

The “Go To Page" requester will appear on your screen.

Type the desired page number.

Notice that the number you type appears in the "Page Number"
data entry' area. If you make a mistake, use the delete key to
remove the incorrect information, and then retype the correct
page number.

Click on “OK”.
The page you desired will appear on the screen.

||tg]
— Page Number ~r

OK | Cancel |

1. Choose “Go To Selection” from the “Edit” menu.

Your document will return to any currently selected text.

Page Number The »p.1ge \umber" icon in the command strip at the top of a
Icon - -
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To go to the previous page:

1. Hold the SHIFT key down, and while it is down, click the
mouse on the "Page Number" icon.

To go to the last page of a document:

1. Hold the ALT key down, and while it is down, click the
mouse on the "Page Number" icon.

To go to the first page of a document:

1. Hold the ALT and SHIFT keys down, and while they are
down, click the mouse on the "Page Number" icon.

Replacing text
Replacing text is a common editing technique in which new text is
entered in place of existing text. One way in which text may be
replaced is to backspace over the unwanted text, and type in the
new text. The following are two more efficient ways.

Replacing selected text with new text
You can replace selected text by entering one or more characters
from the keyboard. The first character entered replaces the entire
range of selected type.

To replace selected text with a character from the keyboard:

1. Select the text to be replaced.

replace selected text by entering one or more]
\^aracters from the keyboard.

2. Enter the desired character or characters from the key­
board and continue typing.

You could

In this example, the letter "c" in "could" replaced the entire
selected range of text.
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Replacing text using the “Paste” command
Selected text can also be replaced with the contents on the Clip­
board.

cur
Copy

SE3X
rac

Paste
Clear K3D
Select All ESA
Find...
Replace CEJR
Go To Paqe..
G o (■: S»Kllr-n
Go To Selection

C3G

Insert Item »
Update Item »
Copy Ruler
Paste Ruler

830
KE31

To replace text with the contents of the Clipboard:

1. Select the text to be replaced.

2. Choose “Paste” from the “Edit” menu.

The selected text will be replaced with whatever is on the
Clipboard.

Copying text
Final Writer’s “Copy” and "Paste" commands enable yon to make a
copy of text in one location in your document and "paste" the
copied text in another location. You can also paste copied text in
another Final Writer document.

To copy text within the same document:

1. Select the text to be copied.

Please note that only one block
on Clipboard.

2. Choose “Copy” from the “Edit” menu.

The selected text will be copied onto the clipboard.

3. Set the insertion point at the location in the document
where you wish to paste the copied text.

Please note that only one block of text can be placed

on the Clipboard. I
4. Choose “Paste” from the “Edit” menu.

The text on the clipboard will be pasted into the document at
the insertion point.
Please note that only one block of text can be placed
on the Clipboard. Please note that only one block of
text can be placed on the Clipboard.

6 - 6 Revising a Document



S33
teW____________
Copy sue
Paste E5V
Clear &3D
Select All ^5 A
Find EEBF
Replace. EE3R
Go To Page

Go To Selection

1ZZ5G

Insert item ►
Update Item ►
Copy Ruler S5I0
Paste Ruler

Edit Wi
Cur ezsx
Copy EEBC

L^Q-F/I
Clear
Select All KE5A
Find t—F
Replace ES3R
Go To Page

Go To Selection

EE5G

Insert Item »
Update Item ►
Copy Ruler
Paste Ruler

Moving text
Blocks of text may be moved within a document using the “Cut"
and “Paste” commands found in the “Edit" menu. Text may also be
moved between separate documents.

To move text:

1. Select the text to be moved.

This is a serif font at 14 points.

sans serif font at 18 points.
2. Choose “Cut” from the “Edit” menu.

The selected text will be temporarily moved to the clipboard.

3. Set the insertion point at the location in the document
where you wish to paste the cut text.

This is a sans serif font at 18
points. I

4. Choose “Paste” from the “Edit” menu.

The text on the clipboard will be pasted into the document at
the insertion point.

This is a sans serif font at 18
points. This is a serif font at 14 points.
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Finding and replacing text
When revising a document, you may wish to locate and/or replace
certain words, phrases, or numbers. Final Writer’s “Find" and
“Replace" commands enable you to do so without having to read
the entire document on the screen.

Finding text
The “Find" feature can be used independently of the “Replace”
feature when you simply want to locate text in a document.

Edit
cut essix
Copy EESC
Paste EE3V
Clear
Select All EES A

Replace.. ^HR
Go To Page”.......
Go To Section
Go To Selection
Insert Item >
Update Item >
Copy Ruler (SEJO
Paste Ruler EF<1

Find

To find specific text in a document:

1. Set the insertion point in the document location where you
wish the search to begin.

For example, if you wish to search an entire document, you
would set the insertion point to the left of the document's first
word.

2. Choose “Find...” from the “Edit” menu.

The “Find" requester will appear on your screen.

3. Enter the desired character, word, number or phrase in the
data entry area under the words “Search For”.

4. Set the search parameters by clicking in the appropriate
option boxes to add or remove check marks.

Placing a check mark in the box preceding “Ignore Case” will
cause Final Writer to find the specified text regardless of case or
capitalization. The absence of a check mark means that Final
Writer will search for the word exactly as you entered it in the
data entry area. Any variation in case will cause the word to be
passed by in the search.
A check mark in the box preceding “Wrap Around” will instruct
Final Writer to search the entire document regardless of the
position of the insertion point. Similarly, the absence of a
check mark before "Wrap Around" means that the search will
end at the bottom of the document.
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5. Click on the “Find” button to begin the search.

Final Writer will begin to search for the specified text. When
the text is located, it is selected. If you wish to edit the text,
simply click on the document and edit the text as you wish.

6

To find the next occurrence of specified text:

1. Click the mouse on the “Find” button again.

Revising a Document 6 - 9

R
evising a

D
ocum

ent



Finding and replacing text
If you want to locate text and replace it with alternate text, you may
do so with Final Writer's “Replace" command. For example, you
may wish to search for all occurrences of "1986” and replace them
with “1987". You may direct Final Writer to replace all instances of
certain text, or you may personally review each occurrence to
determine whether or not it should he replaced.

To search for a//occurrences of specific text and
automatically replace them with alternate text:

1. Set the insertion point in the document location where you
wish the word search to begin.

If you wish to search an entire document, set the insertion point
to the left of the document's first word.

Edit
Cut
Copy
Paste
Clear

Go To Page.

Go To Selection

{Replace

Select All
Find...

Insert Item »
Update Item >
Copy Ruler (EJO
Paste Ruler g^Ttn

5.

Choose “Replace...” from the “Edit” menu.

The “Replace" requester will appear on your screen.

Enter the character, word, number or phrase you wish to
find in the data entry area under the words “Search For”.

Enter the replacement text in the data entry area under the
words “Change To”.
Set the search parameters by clicking in the appropriate
option boxes to add or remove check marks.

Placing a check mark in the box preceding ' Ignore Case" will
cause Final Writer to find the specified text regardless of case or
capitalization. The absence of a check mark means that Final
Writer will search for the word exactly as you entered it in the
data entry area. Any variation in case will cause the word to be
passed by in the search.

A check mark in the box preceding "Wrap Around" will instruct
Final Writer to search the entire document regardless of the
position of the insenion point. Similarly, the absence of a

6-10 Revising a Document



check mark before “Wrap Around" means that the search will
end at the bottom of the document.

6. Click on the “AH” button to begin the search and auto­
matic replacement process.

Final Writer will begin to search for the specified text. When
the text is located, it will automatically be replaced with the
alternate text.

To search for an individual occurrence of specific text and
replace it with alternate text:

1. Set the insertion point in the document location where you
wish the word search to begin.

For example, if you wish to search an entire document, you
would set the insertion point to the left of the document’s first
word.

Cur
Copy GSDC
Paste
Clear IZIO
Select All SEDA
Fma
|r'=jc)|o(c =

Go To Page...
Go T<: Section

I33G

Go To Selection
Insert Item ►
Update Item ►
Copy Ruler I3B0
Paste Ruler S31

Choose “Replace..." from the “Edit” menu.

The “Replace” requester will appear on your screen.

Enter the character, word, number or phrase you wish to
find in the data entry area under the words “Search For”.

Enter the replacement text in the data entry area under the
words “Change To”.
o| ; ■ r I'D

-------- Search For--------- -------Options--------
11935 j ✓| Ignore Case

I Wrap Around

11936

Find | IS! All 1

5. Set the search parameters by clicking in the appropriate
option boxes to add or remove check marks.

Placing a check mark in the box preceding “Ignore Case" will
cause Final Writer to find the specified text regardless of case or
capitalization. The absence of a check mark means that Final
Writer will search for the word exactly as you entered it in the
data entry area. Any variation in case will cause the word to be
passed by in the search.

Revising a Document 6-11



2:
00

^0
03

A check mark in the box preceding “Wrap Around" will instruct
Final Writer to search the entire document regardless of the
position of the insertion point. Similarly, the absence of a
check mark before “Wrap Around" means that the search will
end at the bottom of the document.

6. Click on the “Find” button to begin the search process.

Final Writer will begin to search for the specified text. When
the text is located, it will be selected. You must then decide if
you would like to replace the text.

7. To replace the selected text, click on “Replace”. To
continue the search without replacing the currently
selected text, click on “Find”.

You may instruct Final Writer to repeat your most recent
replacement decision for the next occurrence by clicking on
"Again”.

8. When you have completed the “Find” and “Replace”
session, click on the close box in the upper left corner of
the “Replace” requester.

The requester will be closed.

Inserting the date or time
You may occasionally want to have the current date or time inserted
in your document. Final Writer utilizes your computer's internal
system clock to do so quickly and easily when you use the "Insert
Date” or "Insert Time" command.

To insert the date or time in your document:

1. Set the insertion point where you would like the date or
time to appear.

2. Choose “Date” or “Time” from the “Insert Item” sub-menu
of the “Edit” menu.

The current date or time will appear in your document format­
ted according to the settings in the Document Preferences.
Final Writer inserts the date or time to the right of your insertion
point.
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Updating date and time
If you have inserted a date or time in your document using the
“Insert Item" command in the “Edit" menu, you may want to update
those items later to make them current. Dates and times are
updated with the current date or time from the system clock.

To update dates or times in your document:

1. Drag the mouse through the paragraph(s) containing the
dates or times you want to update.

NOTE. To select all dates or times in the document, choose
“Select All” from the edit menu - this will select all paragraphs
in the document.
NOTE. If the dates or times are in a master page, you will have
to first access the master page before selecting the paragraphs.

2. Choose “Date” or “Time” from the “Update Item” sub­
menu of the “Edit” menu.

Sorting paragraphs
This feature lets you alphabetize paragraphs according to their
textual content. You may choose to sort either from low to high, or
from high to low. The “Sort” command is only active when wo or
more paragraphs arc selected for sorting.

To sort two or more paragraphs:

1. Select the paragraphs to be sorted.

..

2. Choose “Low to High” or “High to Low” from the "Sort
Paragraphs” sub-menu of the “Tools” menu.

The paragraphs will be sorted from first to last character.
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Aciding a column of numbers
Final Writer can be instructed to add a column of numbers and
insert the total at a designated place in a document.

To add a column of numbers:

1. Select the text tool if it is not already selected.

2. Position the mouse to the top and left of the first number
to be added.

Position / ‘15.23 Drag
mouse here/ 100.41 mouse here

The total is:

Edit
cut esjx
copy___________eac
[Paste
C!ear _ C53D
Select All
Find...
Replace... EJR
Go To Page..
Go To section---------
Go To Selection
Insert item >
Update Item >
Copy Rule? f»FT»n~
Paste Ruler CE31

3. Press the ALT key while simultaneously pressing and
holding the mouse.

4. Draw a “marquee” around the column of numbers by
dragging the mouse diagonally from the upper left corner
of the column of numbers to the lower right corner of the
column of numbers.
A “marquee" is a special dotted line that "captures" all the
information within its borders. When you release the mouse
button, Final Writer adds the numbers in the marquee and
places the total on the Clipboard.

L200.41J
The total is:

5. Set the insertion point at the location where you would
like the total to be displayed.

‘■5-23 Insertion
pointThe total is: I

6. Choose “Paste” from the “Edit” menu.

■15.23
100.41
The total is: 145-64
The total of the column of numbers will be pasted at the
insertion point taking on the attributes of the text settings in
effect at the insertion point. Once the total is pasted, you can
edit it as desired.
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| Formatting a Document
This chapter describes using Final Writer to modify the way your
text appears. Included in this section are instructions to:
• Adjust the page view percentage - You may view your page

at several different magnifications and reductions to assist you
in your document formatting process.

• Specify paragraph parameters - Paragraph parameters may
be specified for indents, spacing, and alignment. These param­
eters may be set as defaults or for a single document.

• Use the ruler - Final Writer’s ruler is a powerful tool in format­
ting your document. You can even copy and paste the ruler
settings to save time defining the style of your paragraphs.

• Use fonts effectively - Final Writer enables you to select from
a number of different fonts and specify their size, leading, style,
position, width, case, color, and oblique (or slant) percentage.

• Use, define, and edit styles - Final Writer’s styles feature lets
you quickly and efficiently apply predefined paragraph, tabs,
and type settings to your text.

• Use master pages - Text and graphics entered on master
pages will automatically be placed on each page of your
document with the exception of a title page. You can use
master pages in many ways, including specifying header and
footer information.

• Determine page breaks - Final Writer automatically creates
new pages as you enter text. If you want, you can override
these page breaks by inserting your own forced page breaks.
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Page view
From time to time when you are formatting your document, you
may wish to alter the size of your page on the screen. A smaller
page view lets you see a greater portion of the page on the screen,
while a larger page view enables you to see part of your page with
a greatly enlarged perspective. In Final Writer you can view your
page at its normal 100% size, as well as at 25%, 50%, 75%, 125%.
150%, 200%, and 400% sizes.
Final Writer also lets you perform full editing at any magnification.

View
[Page Vi<

Lett M<
Right L

■vZ'Body
Top Ru

■x/Tcp/Le
No Rul

xZ Normal
25%~
50%
75%
125%
150%
200%
400%

ShOW I. -Jn-.p-
Hide Button Strip

To change your view magnification:

1. Choose the desired page view percentage from the “Page
View” sub-menu of the “View” menu.
Your page will appear at the desired size on your screen.
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Paragraph setup
Final Writer is a paragraph-based word processor. That means that
you can give each paragraph its own unique set of characteristics.
This assignment of characteristics may be accomplished in two
different ways. One way is by using the Final Writer ruler. The
other way is by using the “Paragraph” requester.

Using the ruler
The Final Writer ruler contains all the tools you will need to set up
your paragraphs. The various elements on the ruler may be
changed for a single paragraph by clicking in that paragraph, then
making the desired changes. Settings for multiple paragraphs may
be altered by first selecting the desired paragraphs and then making
changes to the ruler.

Using the “Paragraph” requester
For certain paragraph settings, it may be desirable in some situa­
tions to use the “Paragraph” requester. The settings for left margin,
right margin, first line indent, and hyphenation hot-zone can be set
with a numeric value using the requester. Using the ruler, you
move a marker horizontally along the ruler until you reach tire
desired location. If you need to specify a precise value for these
settings, you may wish to use the “Paragraph” requester.

You will also need to use the “Paragraph" requester if you want
your settings to be used as default values for new documents.

To open the “Paragraph” requester: 

1. Choose “Paragraph...” from the “Layout” menu.

The “Paragraph” requester will appear.
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Making paragraph settings
The following instructions describe Paragraph settings. All settings
can be made via die ruler. Everything but tab stops can also be
accomplished using the “Paragraph" requester.
Left and right margins
The left and right margins define your text’s distance from the sides
of the page.

MnnniBegngjjLgnniagigniiiiiaJE]
I j;'''-'~ ~ t ’ ■ Ij " 1 ' ' ' I;' 1 ' 1 • ' ' t, -r^T-"1—

Left Margin Marker Right Margin Marker

To change the left or right margin using the ruler: * 1 2 3 4

1. To change the margin(s) of a single paragraph, click the
mouse in the paragraph to be changed. To change the
margin(s) of multiple paragraphs at once, select the
desired paragraphs by dragging the mouse through them.

2. Position the mouse on the appropriate margin marker.
3. Press and hold the mouse button and drag the appropriate

margin marker horizontally along the ruler.
4. Release the mouse button when the margin marker is

where you want it to be on the ruler.

Final Writer will automatically reformat the paragraph or
paragraphs to reflect the new margin.

To change the left or right margin using the requester: 

Layout

1. To change the margin(s) of a single paragraph, click the
mouse in the paragraph to be changed. To change the
margin(s) of multiple paragraphs at once, select the
desired paragraphs by dragging the mouse through them.

2. Choose “Paragraph...” from the “Layout” menu.
3. Enter the appropriate values in the “Left and Right In­

dents” area in the “Paragraph” requester.

4. Click on the “OK” button.
Final Writer will automatically reformat the paragraph or
paragraphs to reflect the new margin.
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First line indent margin
The first line indent margin tells Final Writer how far to indent the
first line of a paragraph.

; tr|—ranir-i-’snilrtir.Tr-

I Io........ -/f,■■ ■ ■ ■ ■ ■ ........................ ■ ■ ..................... ■■■■.■ !>■ ■ ■ i■ ■ ■ r+4
First Line Indent

To change the first line indent margin using the ruler:

1. To change the first line indent margin of a single para­
graph, click the mouse in the paragraph to be changed.
To change the first line indent margin of multiple para­
graphs at once, select the desired paragraphs by dragging
the mouse through them.

2. Position the mouse on the first line indent margin marker.

3. Press and hold the mouse button and drag the marker
horizontally along the ruler.

4. Release the mouse button when the first line indent
margin marker is where you want it to be on the ruler.

Final Writer will automatically reformat the paragraph or
paragraphs to reflect the new first line indent margin.

To change the first line indent margin using the requester:

1. To change the first line indent margin of a single para­
graph, click the mouse in the paragraph to be changed.
To change the first line indent margin of multiple para­
graphs at once, select the desired paragraphs by dragging
the mouse through them.

Layout. |
Page Setup
Section Setup.
|Paragrapr
Define Style ............ »
Apply Style »
Bullet
Indent Right
Indent Left
Hanging Indent
Nev/ Section »

, Rerncve Section
Insert Page Break
Retrcve Page Break

2. Choose “Paragraph...” from the “Layout” menu.

3. Enter the desired value in the “First” Indents area in the
Paragraph requester.

4. Click on the “OK” button.

Final Writer will automatically reformat the paragraph or
paragraphs to reflect the new first line indent margin.
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Tab stops
Tab stops let you align text to form lists, outlines, tables, and other
elements precisely. When you press the TAB key while typing, the
insertion point will automatically advance to the location of the next
tab stop. The Final Writer ruler has four different tab stop options:

Left tab -
Right tab -

Center tab -

Decimal tab -

Text is aligned left justified at the tab stop.

Text is aligned right justified at the tab stop.

Text is centered at the tab stop.

Decimal points are aligned at the tab stop. This lab
type is used mostly for numbers that must be
properly lined up in a column. Characters lo the
left of the decimal point are inserted to the left of
the lab stop. Characters to the right of a decimal
point are inserted to the right of the tab stop.
Numbers without decimals and other text are
aligned to the left of the tab stop.

Left, Right, Center, and Decimal
Tab Stop Selectors

To set tab stops using the ruler:

1. To set tab stops for a single paragraph, click the mouse in
the paragraph to be changed. To set tab stops for mul­
tiple paragraphs at once, select the desired paragraphs by
dragging the mouse through them.

2. Click on the appropriate tab icon.
3. Click on the ruler at the point where you wish to insert the

tab stop.

All default tab stops to the left of the new tab stop will be
removed.

4. Repeat this procedure as often as you like until all tab
stops are set.
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To move a tab stop using the ruler:

1. To move a tab stop for a single paragraph, click the
mouse in the paragraph to be changed. To move a tab
stop for multiple paragraphs at once, select the desired
paragraphs by dragging the mouse through them.

2. Click and hold the mouse on the tab stop you would like
to move.

3. Drag the tab stop horizontally along the ruler until it is
located where you want it.

4. Release the mouse button.

To delete a tab stop using the ruler:

1. To delete a tab stop for a single paragraph, click the
mouse in the paragraph to be changed. To delete a tab
stop for multiple paragraphs at once, select the desired
paragraphs by dragging the mouse through them.

2. Click and hold the mouse on the tab stop you would like
to delete.

3. Drag the tab stop below the ruler.

4. Release the mouse button.

Hyphen “Hot Zone” margin
This margin marker tells Final Writer that when the last word of a
line stans before the marker, it is eligible for hyphenation. When
you set the “Hot Zone" marker too close to the right margin, your
lines will appear less ragged along the margin, but you may have
excessive hyphenation. If you set the “Hol Zone” marker too far
from the right margin, you will have less hyphenation, but your
lines will appear more ragged.

Hyphen "Hot Zone" marker

TVT
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Hyphen "Hot Zone" marker
fo|—---------— - —---------- - - - -------■ -...................1E3IC
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To move the “Hot Zone” marker using the ruler:

1. To move the “Hot Zone” marker for a single paragraph,
click the mouse in the paragraph to be changed. To move
the “Hot Zone” marker for multiple paragraphs at once,
select the desired paragraphs by dragging the mouse
through them.

2. Click and hold the mouse on the Hyphen “Hot Zone”
marker.

3. Drag the marker horizontally along the ruler until it is
located where you want it.

4. Release the mouse button.

To move the “Hot Zone” marker using the requester:

1. To move the “Hot Zone” marker for a single paragraph,
click the mouse in the paragraph to be changed. To move
the “Hot Zone” marker for multiple paragraphs at once,
select the desired paragraphs by dragging the mouse
through them.
Choose “Paragraph...” from the “Layout” menu.

Click the mouse in the “Hot Zone” data entry area, and
enter the desired value.

Click on the “OK” button.
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Paragraph alignment
In Final Writer you can align paragraph text in the following ways:
Left Justified Text is aligned so that lines start at the left

margin (except the first line which starts at the
first line indent).

Right Justified Text is aligned so that lines end at the right
margin.

Centered Text is aligned so that lines are centered
between the left and right margins (except the
first line which is centered between the first
line indent and the right margin).

Full Justified Text is aligned so that lines start at the left
margin (except the first line which starts at the
first line indent), and end at the right margin.
In order to do this the program may expand
spaces between words.

iKajagmi

Center
Full

1. To set justification for a single paragraph, click the mouse
in the paragraph to be changed. To set justification for
multiple paragraphs at once, select the desired para­
graphs by dragging the mouse through them.

2. Click on the desired justification icon.

To set justification using the requester:

1. To set justification for a single paragraph, click the mouse
in the paragraph to be changed. To set justification for
multiple paragraphs at once, select the desired para­
graphs by dragging the mouse through them.

2. Choose “Paragraph...” from the “Layout” menu.

3. Choose the desired “Text Alignment” option.

4. Click on the “OK” button.
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Spacing
When text is entered in a document, the space between lines
depends mostly on the size of the font being used. Large fonts will
have larger areas between lines to allow room for letters that
descend below the main line of type, such as “y”, “j", “p”, and "q”.

Final Writer enables you to choose from four spacing options—
single, 1-1/2, double, and variable. The chart below shows you
important information for each type of spacing.

Spacing
Style

Height of
Line

Maximum
Line Height

Single 120% of line’s largest font 240 pts.

1-1/2 180% of line's largest font 18 pts.

Double 240% of line’s largest font 24 pts.
Variable spacing is based on tallest leading value for the line

: o| \ _____________________ _______ I tala
oJ^la|Q|.H| jpmjffllgl EH.^lajpi jglraj Bl. | jjjpj j- '___ r
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' Spacing selectors (Single, One
and One Half, Double, and Variable

To set line spacing using the ruler:

1. To set line spacing for a single paragraph, click the mouse
in the paragraph to be changed. To set line spacing for
multiple paragraphs at once, select the desired para­
graphs by dragging the mouse through them.

2. Click on the desired line spacing icon.

To set line spacing using the requester: 1 2 3 4

1. To set line spacing for a single paragraph, click the mouse
in the paragraph to be changed. To set line spacing for
multiple paragraphs at once, select the desired para­
graphs by dragging the mouse through them.

2. Choose “Paragraph...” from the “Layout” menu.

3. Click on the desired line spacing option.

4. Click on the “OK” button.
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Hyphenation off/on
The hyphenation off and on selectors are used to enable or disable
the automatic hyphenation function of selected paragraphs.

■pgpoi£ggnB3gflEPPPfijg<igwiggigiiBEiaa=LdguiiMwnn
i ' " f,' " i ■ ■ i ■ ' ■ I,’ 1 ...........U—" i " Is............... ip ........... b1 2 3 4~^~||

\ Hyphenation selectors
'(Offand On)

To set hyphenation status using the ruler:

1. To set hyphenation status for a single paragraph, click the
mouse in the paragraph to be changed. To set hyphen­
ation status for multiple paragraphs at once, select the
desired paragraphs by dragging the mouse through them.

2. Click on the desired hyphenation selector.

To set hyphenation status using the requester:

1. To set hyphenation status for a single paragraph, click the
mouse in the paragraph to be changed. To set hyphen­
ation status for multiple paragraphs at once, select the
desired paragraphs by dragging the mouse through them.

2. Choose “Paragraph...” from the “Layout” menu.

3. Click on the desired “Enable” status button.

4. Click on the “OK” button.

NOTE. In order for hyphenation to occur for a paragraph, the
hyphenation feature itself must be turned on for the document. See
the description of hyphenation preferences in Chapter 3 for more
information.
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Text and fonts
High quality output is probably one of the main reasons you chose
Final Writer as your word processor. Final Writer lets you define
your text’s font, size, style, position, width, case, color, and oblique
percentage. All the commands you will need to work effectively
with text can be found in the "Text" menu. The settings may be
made all at once using the “Type Specs" command (explained later
in this chapter), or one at a time using other commands in the
“Text" menu.

Opening fonts
SoftSans is the Final Writer default font. Before you may use
another font in your document, you must first open it.

To open a Final Writer font:

Leadinq >
Style " ,
Position »
Width »
Case >
Color CE3&
Oblique Percent >
Type Specs

1. Choose “Open...” from the “Font” sub-menu of the “Text”
menu.

The “Font" requester will appear.
2. Scroll through the list of fonts until you reach the font

your want to open.

3. Double-click on the desired font.

Selecting a font
You may select a font prior to entering text, or you may change the
font of existing text. All font commands are executed through the
“Font" sub-menu of the "Text" menu.

To select a font:

1. Open the desired font if you have not already done so.
2. If you are changing the font of existing text, select the text

to be changed. If you are setting a font for text that has
not yet been entered, set the insertion point where the text
is to appear.

3. Choose the desired font from the “Font” sub-menu of the
“Text” menu.
If text was selected, it will be redrawn in the new font.
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Font size
You may specify text ranging in size from 4 points to 300 points.
Some samples of text size are shown below.

8 points

10 points

12 points
14 points

18 points
24 points

To set font size:

Font
Text Styles

Other...-

10
>X12

14
18
24
36
72

3Leading
Style
Position
Width
Case
Color...
Oblique Pe
Type Specs

1. If you are changing the size of existing text, select the text
to be changed. If you are setting the size for text that has
not yet been entered, set the insertion point where the text
is to appear.

2. Choose the desired size from the “Size” sub-menu of the
“Text” menu. To specify a size that does not appear in the
“Size” sub-menu, simply select “Other”. When the “Size”
requester appears, type the desired size in the data entry
area and click on “OK”.

If text was selected, it will be redrawn in the new size.
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Leading
Leading refers to the amount of space between lines of type. If you
are using single, 1-1/2, or double spacing for your text, you need
not be concerned with leading, since it is preset according to the
chosen spacing and largest font size on a line.

If you are using the variable spacing option, however, you will
need to specify a leading value for your text. When specifying the
leading, be sure to allow enough space for your characters to
appear in their entirety. A leading value that is too small will chop
off the tops and/or bottoms of certain characters.

To set leading:

"Variable Spacing" ict

Font
Text Styles
Size

11 Leading Other... 1
Style 8
Position 9
Width 10
Case 11
Color... 12
Oblique Pe 13
Type Specs -»/14

15
10

C.~

1. If you are changing the leading of existing text, select the
text to be changed. If you are setting the leading for text
that has not yet been entered, set the insertion point
where the text is to appear.

2. Click on the variable spacing icon if it is not selected.

3. Choose the desired leading measurement from the “Lead­
ing” sub-menu of the “Text” menu. To specify a leading
value that does not appear in the “Leading” sub-menu,
simply select “Other". When the “Leading” requester
appears, type the desired value in the data entry area and
click on “OK”.
If text was selected, it will be redrawn with the new leading.

Text style
Text may be entered in one of the following styles:
Normal Underline Strike Through Double Underline

To set text style:

1. If you are changing the style of existing text, select the
text to be changed. If you are setting the style for text that
has not yet been entered, set the insertion point where the
text is to appear.

2. Choose the desired style from the “Style” sub-menu of the
“Text” menu.
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Text position
Text may be positioned in one of the following three ways:
Text may be in the normal position.
Text may be in the position.
Text may be in the sub5cripl position.

Font ►
Test Styles ►
Size ►
Leading ►
Style ►
Position ►

Other.. |
Case
Color .
Oblique Pc-

50%
70%
85%
95%

■x/-Normal
105%
115%
130%
150%

Type Specs

To set text position:

1. If you are changing the position of existing text, select the
text to be changed. If you are setting the position for text
that has not yet been entered, set the insertion point
where the text is to appear.

2. Choose the desired text position from the “Position” sub­
menu of the “Text” menu.

Text width
Text may be set using different width values. These values alter the
way characters appear by increasing or decreasing the width of
those characters. Some examples of different widths are shown
below.

50% width

75% width

85% width
Normal width

115% width

130% width

150% width

Hello
Hello
Hello
Hello
Hello
Hello
Hello

To set text width:

1. If you are changing the width of existing text, select the
text to be changed. If you are setting the width for text
that has not yet been entered, set the insertion point
where the text is to appear.

2. Choose the desired width from the “Width” sub-menu of
the “Text” menu. To specify a width that does not appear
in the “Width” sub-menu, simply select “Other”. When the
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“Width” requester appears, type the desired value in the
data entry area and click on “OK”.

If text was selected, it will be redrawn in the new width.

Text case
You may choose from three different case settings for your text.
These settings are:

Normal Small Caps ALL CAPS

To set text case:

1. If you are changing the case of existing text, select the
text to be changed. If you are setting the case for text that
has not yet been entered, set the insertion point where the
text is to appear.

2. Choose the desired case from the “Case” sub-menu of the
"Text” menu.

If text was selected, it will be redrawn in the new case.

Text color
You may specify any of Final Writer's predefined colors for your
text.

NOTE: When entering colored text, the Final Writer default screen
(.which only shows four colors) may not allow you to see your text
in the exact color selected. However, if you position the mouse in
the text and press the mouse button, the mouse pointer itself will
change color to reflect the true color of the text.

Text
Font
Text Styles
Size
Leading
Style
Position
Width
Case

Type Specs...

To set text color:

1. If you are changing the color of existing text, select the
text to be changed. If you are setting the color for text
that has not yet been entered, set the insertion point
where the text is to appear.

2. Choose “Color...” from the “Text” menu.

The "Select Color" requester will appear.
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NOTE. The colors in this requester are defined in the “Color
Preference” requester (See Chapter 3).

3. Double-click on the name of the desired color.

Oblique percentage
Text may be slanted to the left or right to varying degrees using the
“Oblique Percent" command.

To set oblique percent:

0^71
Font
Text Styles
Size
Leading
Style
Position
Width
Case
Color...
lopiiqueifiei Other...
Type Specs -»/'Normal

2
3
4
6
8
10
12

1. if you are changing the oblique percent of existing text,
select the text to be changed. If you are setting the
oblique percent for text that has not yet been entered, set
the insertion point where the text is to appear.

2. Choose the desired oblique percent from the “Oblique
Percent” sub-menu of the “Text” menu. To specify a
value that does not appear in the “Oblique Percent” sub­
menu, simply select “Other”. When the “Oblique Percent”
requester appears, type the desired value (from -20 to 20)
in the data entry area and click on “OK”.

A negative oblique percent will result in text that slants to the
left, while a positive percent results in text that slants to the
right. If text was selected, it will be redrawn in the new
oblique percent.
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Type specs
In some instances, you may wish to change many or all of the text
characteristics for existing text or text you are about to enter. When
this is the case, it may be impractical and time-consuming to make
all of the revisions using the individual text commands found in the
“Text” menu. For this reason, Final Writer includes the “Type
Specs" requester, which provides a convenient and speedy way to
make numerous adjustments to text.

To open the “Type Specs” requester:

Text
Font
Text Styles
Size
Leading
Style
Position
Width
Case
Color...
Oblique Percent
Type Specs

1. Choose “Type Specs...” from the “Text” menu.

The “Type Specs" requester will appear.

To select a typeface using the “Type Specs” requester:

1. Click on the “Select” button in the “Typeface” area of the
requester.

A font requester will appear.

2. Scroll through the list of open fonts until you reach the
typeface you wish to use.

3. Double-click on the desired typeface.

The "Type Specs" requester will reappear, and the name of the
typeface you just selected will appear in the "Name" data entry
area. If vou wish, you can also click in the data entry area and
tvpe the name of the desired font rather than using the
scrollable list of typefaces.
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To select a color using the “Type Specs” requester:

1. Click on the name of the desired color in the “Color” list.

To set size, width, leading, and oblique percent using the
“Type Specs” requester:

1. Click in the appropriate data entry area for size, width,
leading, or oblique percent.

2. Type the desired numeric value for each type characteris­
tic you wish to set.

To set style, text position, and case using the “Type Specs”
requester:

1. Select the desired settings for style, position, and case.

Implementing type specs
You may implement type specs for text that has been selected, for
text that has not yet been entered, or as default settings.

To implement the type specs settings:

1. If you want to make the settings the default for new
documents, check the “Set Default” box at the lower left
corner of the requester.

2. Click on “OK”.

If text was selected, it will be redrawn in the new font. If text
was not selected, the new type specs will be applied to text
entered at the insertion point.
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Text styles
In Final Writer you can define, name, and save text styles. For each
text style you can define preset type specification attributes, and
indicate which type specification attributes are to be applied to text.
A typical use for text styles is to create one text style for each font
you normally open. Later when you create new documents, you
will not have to open each of these fonts - they will already be in
the “Text Styles” sub-menu.

To apply a text style :

1. If you are applying a text style to existing text, select the
desired text. If you are applying a text style to text that
has not yet been entered, set the insertion point where the
text is to appear.

2. Choose the desired text style from the menu.

Text styles are defined, modified, and deleted from the “Define Text
Styles" requester.

To access the “Define Text Styles" requester:

1. Choose “Define...” from the “Text Styles” sub-menu.

The requester will appear.

The “Define Text Styles” requester contains a list of existing text
styles along with areas used to define a text style.

Text Style Names Text styles that have been defined.

FKey Shortcut Used to assign an Amiga® function key
combination to a text style.

Menu Position The position a text style is to appear in the
“Text Styles" sub-menu.

Name The name assigned to a text style.

Define button Provides access to the "Type Specs" requester
(discussed in previous section) where you
define type attributes for a text style.

Apply Check boxes that indicate which type spec
attributes are to be applied with the text style.
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Name of text style

Existing text styles

Position in text style Type attributes that the

Function key assigned
to a text style--------

Type spec definition button

sub-menu assigned to a text style text style is to apply

To add a new text style:

1. Click the mouse on the “New” button.

2. Define the text style's attributes.

3. Click on the “Accept” button to add the text style to the
list of text styles.

4. Repeat the above steps for each new text style that you
want to define.

To modify an existing text style.

1. In the list of text style names click the mouse on the name
of the text style to be modified.

2. Make desired modifications to the text style.

3. Click on the “Accept” button.

4. Repeat the above steps for each text style that you want to
modify.

To delete an existing text style:

1. In the list of text style names click the mouse on the name
of the text style to be deleted.

2. Click on the “Remove” button.

3. Repeat the above steps for each text style that you want to
delete.
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Paragraph styles
In Final Writer you can define, name, and save paragraph styles.
Each paragraph style can have paragraph attributes, tab stops, and
text attributes assigned to it. Paragraph styles differ from text styles
(discussed above) in two ways:

1. Text styles are applied specifically to text, while paragraph
styles are applied to the entire paragraph.

2. If you change the definition of a paragraph style, any para­
graphs in the document that have been defined with that style
will be reformatted automatically to conform with the style's
new definition. Text styles, on the other hand, only affect text
when they arc first applied.

Paragraph styles provide a powerful way of formatting a document.
With a single style you can set the font and its size, type style, text
alignment (left, right, centered, or full), margins, and tab stops.
Paragraph styles free you from the need to apply many formatting
attributes individually to every' paragraph. For example, if you want
all section titles to be size 18, in SoftSans_Boki, centered, and
underlined, you can apply all of these attributes at once, rather than
having to set each of these formats to every' section title you create.
Styles also make changing formats of existing paragraphs easy -
you simply change the definition of the style and the changes are
automatically' applied throughout the document.

Using styles ensures that the style of each type of paragraph re­
mains consistent throughout your document. To prepare this
manual we created styles for body text paragraphs, bulleted text,
captions, headlines, and sub-headings.

Final Writer also uses styles to format the paragraphs it creates for
special sections such as Outline, Index, Table of Contents, Table of
Illustrations, Endnotes, and Bibliography. The number of styles that
can be defined for these types of sections is fixed - you can not
add or remove any of them, only modify them. You can, however,
add and remove "Main" styles. "Main" styles are used for Main, Title
Page, and Preface sections.

To apply a paragraph style :

1. Set the insertion point in a paragraph, or drag the mouse
through multiple paragraphs that you want to apply a
paragraph style to.
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2. Choose the desired style from the “Apply Style” sub-menu
of the “Layout” menu.

Paragraph styles are defined, modified, and deleted using the
“Paragraph Style Definition” requester.

To access the “Paragraph Styles Definition” requester:

1. From the “Define Styles” sub-menu select either “Main...”
or the special section type whose styles you want to work
with.

The style definition requester will appear. The title bar of the
requester will show the type of paragraph style you are defin­
ing.

The “Paragraph Styles Definition” requester contains a list of para­
graph styles along with areas used to define a paragraph style.

Name of paragraph style

>n«

Existing paragraph styles

Tob Settings--------- r
Frey Shortcut--------

i Shift F9
I Shift Fl 0

lancel |OK

Style attribute setting
and apply buttons

Function key assigned to
a paragraph style

— Type Settings-------- r
Define.. | Apply |

TofC------ Tf— Outline —r

-------- Menu Definition----------
---------Style Names----------
Section Nome '
Topic Marne

<Suo Topic 1
Sub Topic 2
Body

Ren\oV^

Retet \

— Menu----- 1

i ||S
- ■■■■ style Definition ■ — - —-
|-——7—Name
|indented Body

Paragraph Settings —;
Define.. | ✓! Apply |

Position in menu Table of Contents Outline assign
assigned to style assign popup menu popup menu

Paragraph Style Names

FKey Shortcut

Defined paragraph styles.

Used to assign an Amiga function key
combination to a paragraph style.

Menu Position The position in which a paragraph style
is to appear in the menu.

Name Name assigned to paragraph style.
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Name of paragraph style

Position in menu Table of Contents Outline assign

Style attribute setting
and apply buttons

Function key assigned to
a paragraph style

Existing paragraph styles

assigned to style assign popup menu popup menu

Paragraph Settings The "Define..." button accesses the
“Paragraph" requester. Check "Apply" if
you want "Paragraph" requester at­
tributes assigned with the style.

Tab Settings The "Define..." button accesses the
"Tabs" requester. Check "Apply" box if
you want tab stops set in the "Tab”
requester to be assigned with the style.

Type Settings The "Define..." button is used to access
the "Type Specs" requester. Check the
"Apply" box if you want "Type Specs"
settings to be assigned with the style.

Table of Contents Popup If paragraphs set with the style being
defined are to generate an entry' when
the Table of Contents section is created.
select from this menu the level of Table
of Contents entry' to be generated. It no
Table of Contents entry is to be gener­
ated, choose "None".

Outline Popup If paragraphs set with the style being
defined are to generate an entry when
the Outline section is created, select
from this menu the level of Outline
entry to be generated. If no Outline
entry is to be generated, choose "None".
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To define a new style:

1. Click on the button labeled “New”.

Remember, you can only add new styles when working with
“Main" styles.

3. Define the style's attributes.

Descriptions of these attributes appear later in this section.

4. Click on the “Accept” button to save the new style.

5. Repeat the above steps for each style you want to define.

To modify an existing style:

1. In the “Style Names” list click the mouse on the name of
the style you want to modify.

2. Make desired modifications to the style's attributes.
3. Click on the “Accept” button.

4. Repeat the above steps for each style to be modified.

To delete an existing style:

1. In the “Style Names” list click the mouse on the name of
the style you want to delete.

2. Click on the “Accept” button.

3. Repeat the above steps for each style to be deleted.

Using the “Define Tabs” requester
When you click on the “Define...” button in the "Tab Settings" area
of the requester, the “Tabs” requester will appear. Within this
requester is a list of existing tab stops and a series of action buttons
that you use to define new, edit existing, and remove existing tab
stops from a style. Only 8 tab stops may be defined for a style.

To access the “Define Tabs” requester:

1. Click on the Tab Settings “Define...” button.
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Existing tab stops
(ifany) ----------

Ruler position for tab stop (tab stop's
distance from left margin).

Type of tab stop

To define a new tab stop:

1. Access the “Define Tabs” requester and click on “New".

Default settings for the new tab stop will be provided in the
definition area.

2. Modify the default settings to what you wish them to be.

3. Click on the “OK” button when you are finished defining
the style's tab stops.

To modify an existing tab stop:

1. Access the “Define Tabs” requester and click the mouse
on the line in the list of tab stops showing the tab stop
you want to modify.

2. Modify the default settings to what you wish them to be.

3. Click on the “OK" button when you are finished defining
the style's tab stops.

To remove an existing tab stop:

1. Access the “Define Tabs” requester and click the mouse
on the line in the list of tab stops showing the tab stop
you want to remove.

2. Click on the “OK” button when you are finished removing
the style's tab stops.
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Master page
with text and
graphic items

Master pages
A master page is a place in a Final Writer document where you
define text and graphics that are to appear on each of your
document's pages. There are many uses for master pages, including
document titles, chapter names, special graphics, dates, page
backgrounds, headers, footers, and page borders.

Notice that master
page items can appear
anywhere on the page.

Every time a new document is created, blank master pages are also
created. If you leave master pages blank, they will have no effect
on the body of your document. I iowever, once you have entered
text and/or graphics on a master page, those items will appear on
each page of your document except the optional title page.

If you have set the “Left/Right” page option (See Chapter 4), the left
master page will be used for items that are to be repeated on left­
sided pages, and the right master page will be used for items on
right-sided pages. If you have not set the “Left/Right” page option,
only items entered on the right master page will affect your pages.

Master pages are accessed through the page icons in the horizontal
ruler at the top of a document window. There are three page
icons—left master, right master, and body. Clicking on the left or 
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right master page icon will bring the appropriate master page up on
your screen. Clicking on the body page icon will return you to the
body of your document.

ia|<a

4r
■urinn^GncBitjnnKiuPi^r.EciiiFrzi^i —U

vT1 ’ ■ ' ' ■ it- ' ..... ir I—t-

Left, Right, and Body "Master Page" icons '

To define left and/or right master pages: 

1. Click on either the left or right master page icon.

The selected master page will appear and the window title will
show which master page is being edited.

2. Enter any text or graphics you wish to include as master
items.

Remember that any text or graphics placed on a left master
page will appear on even- left-sided page of a document.
Similarly, any text or graphics entered on a right master page
will appear on every right page of a document. If you arc not
using the “Left/Right" page option (See Page Setup - Chapter 11.
nothing you enter in the left master page will appear on your
body pages.

3. Click on the body page icon in the ruler to return to your
document's body page(s).

Headers and Footers
There are a number of ways in which you may utilize a header or
footer. The most common use for headers and footers is for page
numbering. Other common uses are for inserting the date and time
that the document was written or printed, and for running headlines
at the top of each page.

In Final Writer you create headers and footers inside a master page.
At the top of a master page you place header items, and at the
bottom of the same master page, you place any footer items.

Final Writer is a word processor where text must be entered se­
quentially from the top of the first page down through a document.
This is in contrast to desktop-publishing programs that allow you to
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stan a text block wherever you wish. For example, in a desktop­
publishing program, if you want to place text at the bottom of a
page, you start a new text block at the bottom of a page. In a
word-processor, however, you need to advance the insertion point
to the bottom of the page by pressing the RETURN key or by
entering text. Therefore, when you want to place a footer at the
bottom of a Final Writer master page, you advance the insertion
point to the bottom of the master page.

When you use a master page to define header and footer items, you
will probably not want text you enter on a body page to be placed
on top of the header and footer items. In order to accomplish this,
you will need to limit the size of the “Body” area of your page by
specifying the height you are using for header and footer areas (See
Chapter 4 - Headers and Footers).

Lavorml

Page breaks
Page breaks will occur naturally as you type your document. Final
Writer inserts a page break whenever it gets to the end of a page.
You may also manually insert page breaks at any place in your
document.

To insert a page break:

1. Set the insertion point where you want the page break to
appear in your document.

2. Choose “Insert Page Break” from the “Layout” menu.

To remove a page break: 

Pago Setup
Section Setup.
Paragraph c=*=na
Define Style »
Apply Style »
Bullet
Indent Right
Indent Left
Hanging Indent
New Section ►
Son € Section
i.:eit F cqe llreck CSBL

[Remove Page Break

1. Set the insertion point at the beginning of the line of text
immediately following the page break you wish to remove.

2. Choose “Remove Page Break” from the “Layout” menu.

If the “Remove Page Break” menu item is disabled, it is because
you did not set the insertion point in the paragraph immediately
following a forced page break.
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| Graphics and Text Blocks 
Nothing adds interest to a word processing document like a care­
fully created, well placed graphic. Using Final Writer you can create:
° Diagonal, horizontal, and vertical lines
• Arrow-tipped lines
• Boxes and perfect squares
» Rounded-corner boxes and perfect squares
o Ovals and perfect circles
*> Movable text blocks

In addition, you can also import into Final Writer the following
images created in other programs:
• IFF ILBM images
° EPS (Encapsulated Postscript®) images

Each graphic in Final Writer is treated as an independent object and
can be deleted, sized, rotated, grouped, or moved according to your
needs. Text can be made to automatically flow around or on top of
any graphic objects according to your instructions.
In this chapter are instructions to help you:
° Create graphics
• Import IFF ILBM and EPS images
• Change graphic settings
« Select graphics
° Delete graphics
° Size graphics
• Move graphics
° Specify exact size and position of graphics
• Crop IFF ILBMs
• Rotate graphics and text blocks.
° Cancel a graphic operation
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Settings requesters
There are five settings requesters each corresponding to one of the
graphic types supported in Final Writer. These requesters arc:

• Imported Graphic Settings
• Line Settings
• Box Settings
• Oval Settings
• Text Block Settings

These requesters may be used in several ways:

• Set permanent default values for a type of graphic object.
Set Default When a new document is created, these default values define

the attributes for graphic objects placed in the document.

• Set temporary default values for a type of graphic object. When
a new graphic object is created, these temporary default values
are used as the attributes for the objects, however the perma­
nent default values remain the same.

• Reset the attributes of existing objects. Attributes of any
existing graphic or text block object can be modified at any
time.

Creating lines, boxes, and ovals
Graphic elements like lines (horizontal, vertical. and diagonal).
rectangles/squares, and ovals, circles may be created in your
document using the tool icons found in the command strip at the
top of a window.
When you create a graphic, Final Writer creates it using the default
settings for the type of graphic being created. For example, if the
default settings for a line are 2 points thick and colored in red,
when you draw a new line, it will be drawn as a 2 point, red line.
You can, of course, change a graphic's current or default settings at
any time.
You have two choices of how a new graphic is to be drawn when
you create it. One choice is to set the default settings to the way
you want the graphic drawn and then create the graphic. The other
choice is to create the graphic using the default settings, and then
after the graphic is drawn, change its settings to suit your needs. In
the instructions that follow for creating graphics, the default settings
arc defined and then the graphic is created.
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Lines
In Final Writer you can draw lines at any angle with thickness
ranging from hairline (thinnest at any given resolution) to 12 points.
Lines may be created in any of the 16 colors defined in the “Docu­
ment Color Preferences” requester. Text can be made to flow
around or on top of lines. A special option allows you to create a
line with an arrow at one of the line's endpoints.
Lines are drawn to conform with the default settings for new lines.
If you want to override these settings, you can either access the
“Line Settings" requester and define line settings before you draw a
line; or draw a line and while it is selected access the requester to
change its settings.

To draw a line: 

New Free Line Tool

New Line Tool 1. Click on the desired line tool icon.
The “New Line" tool will produce perfectly horizontal, vertical,
or 45° diagonal lines. The “New Free Line” tool will produce
diagonal lines of any angle. Once a line is drawn, you can
change its angle no matter which tool you used to create it.

2. Position the mouse pointer at the place in your document
where you wish your line to begin.

3. Hold the mouse button down and drag the mouse in the
direction you want the line to be drawn.

4. Once the line has reached the desired length, release the
mouse button.

To access the “Line Settings” requester:
Graphics]!
Import.. EEB2

Imported Graphics
81.14, 1

Relate Boxes..
Ovals.
Text Blocks...

hn:j TaP:.-
Sen:! To E‘-:c

U-iyo-jp
L ock
Unlock
Delete

Select “Lines...” from the “Settings” sub-menu.

The “Line Settings" requester will appear.
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Below are descriptions of the "Line Settings" requester.
Text Flow Options The way in which text is to flow around (or

over) a line. Text may flow on the left or
right side of a line, following either the line’s
contour or a vertical line created by the line’s
frame. If “None" is selected, the line will
become a background element, and text will
flow over it.

Text Flow Distance The amount of space between the line and
any text that flows next to it. For example, a
setting of 0.25 will leave 1/i" of empty space
between a line and text flowing around it.

Line Weight The line's thickness.

Color The line's color.

To draw an arrow-tipped line:

1. Follow the steps above for drawing a line except hold the
left ALT key before pressing the mouse button, and
continue to hold the ALT key down while dragging the
mouse.
The size of the arrow depends upon the thickness of the line.
The arrow will draw on the end where the mouse is released.

Boxes
Final Writer lets you create boxes in any width and height combina­
tion. A box can have a border and be filled with a color or left
empty. Special options for boxes are the ability to make boxes with
rounded corners and/or perfect squares.
Boxes are drawn to conform with the default settings for new
boxes. If you want to override these settings, you can either access
the "Box Settings" requester and define settings before you draw a
box: or draw the box and while it is selected access the requester
and change the settings.
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To draw a box:

New Box Tool

laSMfflgQ

1. Click on the "New Box" tool icon.

2. Position the mouse pointer at the place in your document
where you wish your box's corner to begin.

3. While holding the mouse button down, drag the mouse in
the proper direction to draw the box.

4. Once the box has reached the desired size and shape,
release the mouse button.

To access the "Box Settings" requester:

Select "Boxes..." from the "Settings" sub-menu.

The "Box Settings” requester will appear.

Below are descriptions of the "Box Settings" requester.
Text Flow Options The way in which text is to flow around (or

over) a box. Text may flow on the left or
right side of a box, following either the box’s
contour or a vertical line created by the box’s
frame. If "None" is selected, the box will
become a background element, and text will
flow over it.

Text Flow Distance The amount of space between the box and
any text that flows next to it. For example, a
setting of 0.25 will leave 1/4" of empty space
between a box and text flowing around it.

Border Weight

Border Color

The box's border thickness.

The box's border color.
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Fill Interior Determines whether the box is filled with a
color (Solid) or left empty (Transparent).

Fill Color The color of fill when the "Fill Interior" is set
to "Solid".

To draw a rounded-corner box: 

1. When drawing a box, hold the left ALT key before press­
ing the mouse button, and continue to hold the ALT key
down while dragging the mouse.

To draw a perfect square:

1. When drawing a box, hold the /eft SHIFT key before
pressing the mouse button, and continue to hold the
SHIFT key down while dragging the mouse.

To draw a perfect square with rounded-corners:

1. When drawing a box, hold the left ALT and left SHIFT keys
before pressing the mouse button, and continue to hold
the ALT and SHIFT keys down while dragging the mouse.

Ovals
Final Writer lets you create ovals in any width and height combina­
tion. An oval can have a line as a border, and can be filled with a
color, or left empty. A special option for ovals is the ability to make
ovals as perfect circles.
Ovals are drawn to conform with the default settings for new ovals.
If you want to override these settings, you can either access the
"Oval Settings" requester and define settings before you draw an
oval; or draw the oval and while it is selected access the requester
and change its settings.

8 - 6 Graphics and Text Blocks



New Oval Tool To draw an oval:

1. Click on the "New Oval" tool icon.

2. Position the mouse pointer at the place in your document
where you wish your oval to begin.

3. While holding the mouse button down, drag the mouse in
the proper direction to draw the oval.

4. Once the oval has reached the desired size and shape,
release the mouse button.

To access the "Oval Settings" requester:

Graphic!] |
Import S52

Imported Graphics...
Lines
Boxes

Cii'irjlG
So-i:ilc b:r

___ U
l&t Blocks

U-irroj-.
1 :<:»
U'i.OS-

I..-:

Select “Oval Settings” from the “Graphics” menu.

Final Writer will display the "Oval Settings" requester.

Below arc descriptions of the "Oval Settings" requester.

Text Flow Options The way in which text is to flow around (or
overt an oval. Text may flow on the left or
right side of an oval, following either the
oval’s contour or a vertical line created by
the oval’s frame. If “None’’ is selected, the
oval will become a background element, and
text will flow over it.

Text Flow Distance The amount of space between the oval and
any text that flows next to it. For example, a
setting of 0.25 will leave 1/4" of empty space
between an oval and text flowing around it.

Border Weight The oval's border thickness.

Border Color The oval's border color.
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Fill Interior

Fill Color

Determines whether the oval is filled with a
color (Solid) or left empty (Transparent).
The color of fill when the "Fill Interior" is set
to "Solid".

To draw a perfect circle: 

1. When drawing an oval, hold the left SHIFT key before
pressing the mouse button, and continue to hold the
SHIFT key down while dragging the mouse.

Importing graphics
In addition to graphics drawn with Final Writer’s drawing tools, you
may also import pictures and brushes created by other programs in
either the EPS (Encapsulated PostScript®) format or the Amiga®
graphic format IFF ILBM. HAM, Extra Halfbrite, and 2 i bit IFF II.BMs
may also be imported.

Imported graphics may be inserted before or after text is entered.
Text will always reformat to How around a graphic according to that
graphic's text flow settings.

Graphics

Importing graphics
An imported graphic may be inserted into a Final Writer document
as long as it is in either the EPS or IFF ILBM graphic format. Im­
ported graphics are drawn to conform with the default settings for
new imported graphics. If you want to override these settings, you
can cither access the "Imported Graphics Settings" requester and
define settings before you import a graphic; or import the graphic
and while it is selected access the requester and change its settings.

To import a graphic:

1. Select "Import" from the "Graphics" menu.

A file requester will appear.
2. Use the file requester to locate the graphic you want to

import, and click the mouse on its name.

3. Click the OK button.
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To access the “Imported Graphic Settings” requester:
| Graphics M

B3!
1 imported Graphics ||

Rotate* To
Rotate Boxes...

Ovals...
Text Blocks...Piing To Frot

Senrl Tc> Ba<
Group
Ungioup
Lock
Unlock

Select “Imported Graphics” from the “Graphics” menu.

Final Writer will display the requester.

The following are descriptions of this requester's settings
Text Flow Options The way in which text is to flow around (or

over) a graphic. Text may flow on the left or
right side of an IFF ILBM graphic, following
either the graphic’s contour or a vertical line
created by the graphic's frame. EPS graphics
can only have text flowed to the left or right
of the graphic's frame. If “None" is selected,
the graphic will become a background
element, and text will flow over it.

Text Flow Distance

Border Weight

Border Color

Background

The amount of space between the graphic
and any text that flows next to it. For
example, a setting of 0.25 will leave 1/4" of
empty space between a graphic and the text
flowing around it.
The graphic's border thickness.

The graphic's border color.

The background of an IFF ILBM graphic can
be treated as solid or transparent. If the
background is transparent, the picture’s
“transparent" color (usually color 0) will not
be used when rendering the graphic. If you
plan to wrap text to the contour of a graphic,
you will want to make the background
transparent. If a HAM graphic was clipped
as a brush, it will use the shape of the brush.
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Save/Link Option The “Save graphic” option actually stores a
copy of the inserted graphic in your docu­
ment. The “Save link” option does not save
the graphic itself in your document, but
rather saves a link to that graphic. However,
when you open your document, the graphic
will also be opened through the link and will
appear on the page where you have placed
it. The “Save link” option is helpful when
your graphic takes up a great deal of
memory or when you anticipate changing
your graphic before your document reaches
its final draft stage. In this latter instance, the
link will open the revised graphic and insert
it when you reopen your document.

Text blocks
You can use Final Writer's text block feature to create short lengths
ol text that are independent of the text in your document. Text
blocks may be moved anywhere on a page, resized, rotated, and
modified.

To create a text block: 

Text Block Tool

1. Click the mouse on the "Text Block Tool" icon.

The "Text Block Settings" requester will appear.

2. In the area titled "Content" enter the text of the text block
you are creating.

3. Modify or define Text Flow Options, Distance, and Type
Specs to suit your needs, or use the settings as they are.

4. Click the mouse on the "OK" button.
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The text block will be drawn in the upper left corner of the
window. Now that the text block is drawn you can manipulate
it just as you do other graphic objects.

To change the text or settings used in a text block:

1. Double-click the mouse on the text block.

The “Text Block Settings" requester will appear.
2. Make any desired modifications.

3. Click the mouse on the “OK” button.

The text block will be redrawn according to the new settings.

Selecting objects
Final Writer treats all lines, boxes, ovals, images, and text blocks as
independent objects. In order to size, move, crop, delete, rotate, or
redefine a graphic you must first select it.

To select a single object:

J!Uiz|V|D|O|0| 1-7 2-
Select Tool

Click the mouse on the “Select” tool.

Click the mouse on the object you want to select.

Notice that “anchor points" (tiny boxes in the corners and
midpoints of the graphic) appear around or on the object. The
presence of anchor points indicates that the object has been
selected.
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To select one or more objects by drawing a marquee: 

Select Tool

1. Click the mouse on the “Select” tool.
2. Position the mouse pointer above and to the left of the

first object you want to select.

3. Hold down the left mouse button and drag the mouse to
the right and bottom of the last object you want to select.

As you drag the mouse the program will draw a marquee
rectangle on the screen. When you release the' mouse, all
graphics that fit entirely within the marquee will be selected.

4. Release the mouse button.

Deleting objects
Lines, boxes, ovals, images, and text blocks may be deleted at any
time.

To delete one or more objects:

1. Select the object(s) you wish to delete.
2. Press the BACKSPACE or DELETE key, or choose “De­

lete” from the Graphics menu.

The selected objects will be deleted.
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Sizing objects
A graphic object already inserted in a document can be made
smaller or larger at any time. When you make an IFF ILBM or EPS
image smaller, it may appear to lose resolution (dots) on the screen,
but on printouts you probably won’t lose any resolution.

To change the size of an object in your document:

1. Select the object to be sized.

2. Press and hold the mouse on one of the anchor points at
the corners or midpoints of the selected graphic.

3. Drag the mouse inward toward the middle of the graphic
to reduce its size. Drag the mouse outward away from the
middle of the graphic to increase its size.

4. Release the mouse when the graphic has reached the
desired size.

Constrained sizing of IFF ILBM images
Option 1 If you hold the SHIFT key down while pressing on an

IFF ILBM image's anchor point, and continue to hold it
down while dragging the mouse, Final Writer will keep
the image’s original proportions intact.

Option 2 If you want an IFF ILBM image to be sized to take
maximum advantage of your printer's resolution, hold
down the left CTRL, SHIFT, and ALT keys while
dragging the mouse on the lower right anchor point.
Since your printer’s aspect ratio is usually different than
a graphic’s original aspect ratio, this method of con­
straining will produce an image that may look out of
proporjion on your screen. It will, however, result in
the best printouts. This method of constraining is
known as Integer Scaling.

“Snap To” sizing
If you hold the CTRL key down while pressing on an anchor point,
and continue to hold it down while dragging the mouse, Final
Writer will snap the size of the graphic to the nearest tick mark on
the ruler.
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“Quick” sizing
If you want to reduce an object by 1/2, hold down the SHIFT key
and double-click the mouse on the image to be reduced. You can
continue reducing the image in this manner. Each time the object is
reduced, it will be by 1/2.

If you want to double (increase) the size of an image, hold down
the CTRL key and double-click the mouse on the image to be
enlarged. Each time the image is enlarged, its size will be doubled.

Moving objects
An object can be moved anywhere within a document.

To move an object from one location to another:

1. Select the object to be moved.
2. Click and hold the mouse button on the selected object

while dragging the mouse to the desired new location.

Constrained moving
If you hold the SHIFT key down while dragging the mouse, Final
Writer will move a selected object either vertically or horizontally
depending upon your initial mouse movement.

“Snap To” moving
If you hold the CTRL key down while dragging the mouse. Final
Writer will move a selected object so that the left/top of the object
is snapped to the nearest tick mark on the ruler.
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Rotating objects
Any object created in Final Writer may be rotated. Since IFF ILBM
and EPS images are not created in Final Writer, they can not be
rotated. You can rotate an object using a menu command, or you
can rotate in real time using the mouse.

To rotate an object using a menu command:

1. Select the object to be rotated.
2. Select the desired rotation menu command.

The "Rotate" sub-menu is used to rotate an object a specified
number of degrees from its current rotation. The "Rotate To"
sub-menu is used to rotate an object to a specific rotation
regardless of the object's current rotation.

To rotate an object using the mouse: 

1. Select the object to be rotated.

2. Position the mouse over one of the selection anchors and
hold down the mouse button.

3. Press the Left ALT key and move the mouse in the direc­
tion you want the object rotated.

When an object has been rotated it can be moved and rotated
again, but not resized. To resize a rotated object you must first set
its rotation to 0, resize the object, and then return the object to its
rotated position

To resize a rotated object:

Select the object to be resized.

Choose "Other" from the "Rotate To" sub-menu.

A requester will appear showing the current rotation amount.

Remember the rotation amount, replace the amount with
“0", and click "OK".

Resize the object.

Choose "Other" from the "Rotate To" sub-menu, enter the
original rotation amount, and click on "OK".
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Modifying an object's settings
An existing object can have its settings modified at any time. These
settings are the ones that comprise the settings requester for that
type of object.

To modify an existing object's settings:

1. Click the mouse on the “Select” tool if it is not already
selected.

2. Double-click the mouse on the object that is to be modi­
fied, or click once on the object to be modified, and
choose the appropriate item from the “Settings” sub­
menu of the “Graphics” menu.
Final Writer will display the settings requester for the object
along with the data that is currently being used for it.

3. Change any of the settings you wish to change.
4. When you are finished making changes, click on the “OK”

button.

Specifying exact size and location
An alternative way of sizing and moving graphics with the mouse is
to use the Position" requester. This requester is accessed while in
one of the settings requesters. Access to the "Position" requester is
only possible when viewing an object's settings requester.

To specify exact size and/or position settings: 

1. If the object's settings requester is not already on the
screen:

/
Select Tool

K. Click the mouse on the “Select” tool if it is not already
selected.

B. Double-click the mouse on the object that is to be
modified, or click once on the object to be modified,
and choose the appropriate settings item from the
“Graphics” menu.
Final Writer will display the selected object's settings
requester along with its definition data.
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3.
4.

5.

Click on the “Position” button.
The “Position” requester will be displayed showing the graphic's
exact size and position.

Modify the size and position data to your desired values.
When you are finished making changes, click on the “OK”
button.

The program will return to the settings requester.
Click on the “OK” Button.

Final Writer will redraw the selected object using the new
values.

Cropping images
Cropping is the process of cutting out unwanted portions of an IFF
I1.B.M or EPS image. The cut portions are limited to rectangular
areas on the left, top, right, or bottom of an image. An image
inserted in a document can be cropped at any time.

To crop an IFF ILBM or EPS image:

I 2.
Crop Tool

Choose the “Crop” tool from among the tool icons in the
ruler at the top of your window.

Click the mouse on the image you want to crop.

Anchor points will appear.

3. Press and hold the mouse on one of the anchor points in
the corners or midpoints of the selected image.

4. Drag the mouse to crop the area of the image the anchor
point is in.
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5. Release the mouse when you have cropped the desired
amount of the image.

To restore an image to its un-cropped size:

1. Select the image to be restored.
2. Press the ALT key and while holding it down double-click

the mouse on the image.

Canceling graphic actions
You can cancel a size, move, or crop operation by pressing the
right mouse button before releasing the left mouse button.

Grouping objects
Many times it is convenient to group more than one object together.
A group of objects can be selected, moved, rotated, and resized all
together, rather than each object separately.

To group objects:

1. Select the objects that are to be grouped.

2. Choose “Group” from the “Graphics” menu.

To ungroup objects:

1. Select the group to be ungrouped.
2. Choose “UnGroup” from the “Graphics” menu.
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Graphic colors vs. screen colors
vs. printed colors
Final Writer tries to print graphics in the colors in which they were
defined. However, when graphics are displayed on the screen they
probably will not be drawn in their true colors. When rendered on
the screen, a graphic's colors are changed to the colors that are
currently available. If you arc using a Final Writer custom screen,
for example, only four colors (Black, White, Grey, and Blue/Grey)
arc available. So no matter what color you define for a graphic, that
color will be modified to one of the colors used in the screen.
If you are using Workbench 2.0 or higher, you can set the number
of colors used for the Workbench to more than 4 colors. For
example, if you set your Workbench to use 8 colors, and open Final
Writer on a Workbench screen, 8 colors will be used to show
graphics on screen. The downside to this is that when you increase
the number of colors for the Workbench screen, the screen display
may slow down.
When the "Graphic Select" tool is selected, and you hold the mouse
down on a graphic (does not apply to IFF ILBM or EPS image), the
colors of the mouse pointer will change to reflect the graphic's
colors.
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| Perfecting a Document
Now that you have created, edited, and formatted your document,
it’s time to turn to Final Writer’s speller, thesaurus, and statistics
features to help make your document as perfect as possible.

In this section, you will learn how to:
• Use the speller - Includes information on checking a docu­

ment, obtaining spelling suggestions from Final Writer, and
working with your own personalized user dictionary.

• Use the thesaurus - Final Writer allows you to obtain lists of
synonyms for words in your document.

• Obtain Statistics - Once your document is complete, you may
instruct Final Writer to count its various elements, including
characters, words, lines, sentences, paragraphs, and pages.
Averages are also provided.
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Using the speller
Final Writer's built-in spelling detector will scan your document for
words it does not recognize and give you the opportunity to revise
the spelling. Final Writer’s spelling corrector will provide spelling
suggestions for words that it flags as possible misspellings.
All spelling functions are accessed through the “Speller" requester.
Once the Speller requester is open, it can be moved to any place on
the screen, or depth arranged behind a document window.

There are two ways the speller can be used: “Word Verify" mode,
and "Document Scan” mode. In “Word Verify" mode you instruct
the speller to verify a single word in your document text. In "Docu­
ment Scan" mode, you instruct the speller to scan a document start­
ing at the insertion point, and continue until the end of document,
or until you tell it to stop.

“Word Verify” mode
When checking a single word, the speller will check any word that
you have selected. If you have selected more than one word, the
speller will only check the first word in the selected range.

I Tools J
[[Speller
Thesaurus
Statistics.
Outline
Table of Contents
Table of Illustrations
Endnotes
Biblioaraphy
Index ’

■■ n l-cicci~:7i":

To check a single word in your document:

1. Double-click the mouse on the word to be verified.

2. Choose “Speller...” from the “Tools” menu.
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The "Speller” requester will appear, and the word is verified.
The speller will display a message indicating whether or not the
word is spelled correctly. 9

If the word is not spelled correctly, you can use any of the
“Speller" requester’s options for obtaining suggestions or adding
the word to your user dictionary.

3. Click the mouse in the “Speller” requester’s close box
when you are finished using it.

“Document Scan” mode
When scanning a document, the speller will start at the position in a
document where the insertion point is.

To begin a document spell check:

1. Set the insertion point where you want the spell check to
begin, and choose “Speller...” from the “Tools” menu.

The "Speller” requester will appear on your screen.

2. Click on the “Spell” button.

Spell [

The spelling check will begin at the insertion point, wrapping
around if necessary to examine the entire document for errors.
As they are found, potentially incorrect words will be high­
lighted in your document, and the highlighted word will appear
in the "Word” data entry area of the “Speller” requester. A
message indicating the potential error simultaneously appears in
the “Alternatives" section of the requester.
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Correcting spelling errors
Once a potential error has been identified, Final Writer offers yon
several ways in which to correct it. You may enter the replacement
from the keyboard, ask Final Writer to provide a list of potential
alternatives from which to choose, or you may skip a word that has
been incorrectly flagged by the spell checker. Please remember that
if you have turned on the “Auto Suggest” feature in the “Speller
Preferences" requester, spelling alternatives will be provided
automatically for every flagged word.
In any of these correction scenarios, the spell checker will automati­
cally resume its document scan after the revision has been made.

To correct an error from the keyboard:

1. Click the mouse in the data entry area next to “Change
To”, and type in the correct word.

2. After verifying that the word you have typed in appears as
you wish it to, click on the “Replace” button.
The original highlighted word in your document text will be
replaced with the characters you typed.

To ask for spelling suggestions:

Suggest | 1- After the word has been highlighted on the screen, click
on the requester's “Suggest” button.
A list of correctly spelled alternatives will appear in the "Alter­
natives” section of the requester. The first word in the list is the
one the spell checker considers the most likely replacement for
the word highlighted in your document. This most likely word
will automatically appear in the "Change To" data entry area.
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2. If the spell checker’s most likely alternative is not the
correct replacement, you may examine the remainder of
the list. If the list is lengthy, use the scroll bar to move
through the remaining alternatives.

To make a correction using the “Alternatives” list:

1. Once you have determined which of the alternatives is the
correct replacement, select that word by clicking the
mouse on it.

The word you selected will appear in the “Change To" data
entry area in the requester.

Replace | 2. Click on the requester’s “Replace” button.

The highlighted word in your document will be replaced with
the alternative word you selected.

To ignore a word the speller thinks is misspelled:

1. Determine if the word highlighted by the spell checker is
actually spelled correctly.
Final Writer’s spell checker will automatically flag any word that
does not appear in the main or user dictionaries. It is always a
good idea to verify the correct spelling of such words before
skipping the word.

Skip | 2. Click on the requester’s “Skip” button.

The spell checker will automatically skip over other instances of
the same word as long as the “Speller” requester is open.
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Adding words
Final Writer flags words as possible misspellings when it cannot find
them in either the main or user dictionary. You can add any word
to the user dictionary so it will not be flagged again.

To add a word to the user dictionary during a spelling check:

1. Verify that the highlighted word is spelled correctly and
that it should be added to the user dictionary.

2. Click on the requester’s “Add” button.

The word will be added to the user dictionary. If you are
examining your entire document for errors, the spell checker
will automatically continue its scan. All future instances of the
word will be verified against the spelling you have entered in
the user dictionary. The word will only be highlighted in the
future if it does not match the entry in the user dictionary.

Deleting words
You can remove a word from the user dictionary when you no
longer want that word to be accepted as a correctly spelled word.

User

To delete a word from the user dictionary:

1. Click on the requester's “User” button to bring up the list
of words in the user dictionary.
The list will appear in the “Alternatives" section of the re­
quester.

2. Click on the word to be deleted.

3. Click on the “Delete” button.
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Using the thesaurus
Final Writer’s thesaurus is a tool that helps you find the best word
for a given situation. The thesaurus gives a list of synonyms for
words you specify.

To use the thesaurus for a word in a document:

Tools i|
Speller.________Fgnjf

Statistics...
Outline..
Table of Contents...
Table of Illustrations...
Endnotes
Bibliography
Index
•-cri Pedographs

1.

2.

Double click on the desired word.

Choose “Thesaurus...” from the “Tools” menu.

The “Thesaurus" requester will appear on your screen. Notice
that the selected word appears in the “Word" data entry area.
and that a number of definitions and alternatives are listed.

3. Review the list, using the scroll bar if necessary.

4. If you would like to view additional lists of alternatives,
click on any word in the current list, then click on the
“Find” button.
A new list of definitions and synonyms will appear.

5. Once you have found the desired word to replace the
selected word in your document, click on that word in the
list.

6. Click on the “Replace” button.

The selected word in your document will be replaced with the
word from the list.
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Obtaining document statistics
Final Writer's document statistics feature is helpful if you are writing
a document that has certain limitations on the number of words,
number of pages, etc.

To obtain document statistics:

1. Choose "Statistics..." from the “Tools" menu.
The “Document Statistics" requester will appear on the screen.

I .f-iiilil', ________| *5
------------Counts------------

Characters 604
Words 147
Lines 26
Sentences 15
Paragraphs 8
Pages 1

--------------------Averages----------------------
Characters per Word 4 34
Words per sentence ’ a
Sentences per Paragraph 1 075

OK |
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Sections
This chapter describes Final Writer sections including how to divide
a document into sections, how to specify page layout settings for
individual sections, and how to create special sections such as Table
of Contents, Table of Illustrations, Endnotes, Bibliography, Index.
and Outline.
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Sections
A section is a part of a document that can consist of text and page
settings that are different from other parts of the document. For
example, if you are writing a novel, you might want to place each
individual chapter in its own section. Even if you arc not writing a
novel, you can use sections to go from one page layout setting to
another within the same document. For example, you might
change some of the following settings for each section in a docu­
ment:
• Number of columns
• Page number prefix
• Page number format
• Master page items
• 1 leader and footer areas
• Edit area margins
• Section title or name
Final Writer sets up one section automatically when you begin a
new document. If you do not intend to use multiple sections,
section settings and text entered will be consistent for the entire
document. If you do not wish to use multiple sections in your
document, think of the entire document as a single section.

When using multiple sections, text from one section can not flow
into another. In other words, when you enter text at the end of a
section, the section simply gets bigger — the text does not go into
the next section. Furthermore, you can only edit and view one
section at a time.

Special sections
Some of the section types that can be created in Final Writer are
called "special sections". Special sections are ones that Final Writer
generates for you. as opposed to you creating the text tor the
section yourself. Special sections in Final Writer include:

• Outline
• Table of Contents
• Table of Illustrations
• Endnotes
• Bibliography
Creating special sections is described later in this chapter .
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Normal sections
Normal sections are those in which you enter text. The three types
of normal sections are:
• Title Page
• Preface
• Main
A document can have more than one “Main" section, but it can only
have one of each of the other section types. For example, your
document might be an instruction book consisting of the following
sections:

• Title Page
• Preface
• Table of Contents
• Chapter 1 (Main)
• Chapter 2 (Main)
• Chapter 3 (Main)
• Index
'I’he manner in which Final Writer positions sections within a
document is consistent with the way you would expect certain
section types to appear in a book. For example, if you have been
working in a Main section and decide to create a Title Page section,
Final Writer will automatically place the Title Page section before
the Main section.

10

Lavootil

Creating a new section
'I’he process of starting a new section depends on whether it is a
special section or a normal section. Special sections such as Index,
Table of Contents, etc., arc generated by Final Writer using informa­
tion you have set up in your document. The creation of special
sections will be described later in this chapter. The following are
instructions for beginning a normal section.

To begin a new Title Page, Preface, or Main section:

1. Choose the desired section type from the “New Section”
sub-menu.
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Going from one section to another
In Final Writer you may only edit and view one section at a time.
The vertical scroll bar which you use to move through text will only
let you move within the current section.

To access a different section than the one you are working in:

1. Choose the section you want to access from the “Go To
Section" sub-menu.
NOTE. The “Go To Section” sub-menu will consist only of
sections that already exist in your document. You can not
begin a new section using the "Go To Section" command.

Deleting a section
You can remove all but the first “Main" section from your document
at any time. When you delete a section. Final Writer deletes all text
and graphics that are in the section. If you want to keep any text or
graphics in a section that you are deleting, you should copy the text
or graphics to a different section.

Layout

To delete a section:

1. Choose the section you want to delete from the “Remove
Section” sub-menu.

Printing sections
When you print a document you can print one section at a time or
all sections. Final Writer will print multiple sections in the order in
which they exist in your document. Refer to Chapter 11 of this
manual. Printing a Document, for details on printing.
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Section types
The remainder of this chapter describes the types of sections you
can create in Final Writer. Remember that each section can have its
own page layout settings. For example, your Table of Contents
might have 2 columns, your Main sections 1 column, and your
Index 3 columns.

Title Page
Final Writer will position the Title Page section as the first page of
your document. Use this section for titles of papers, stories, novels,
etc. Title Page sections use the same set of paragraph styles as
Main sections. You are responsible for entering any text and
graphics that need to appear in your Title Page section.

Preface
Use the Preface section to introduce your document. A Preface is
usually a statement or essay that introduces a book and explains its
scope, intention, or background. Final Writer will place the Preface
section after any Title Page section. You can use the same set of
paragraph styles for a Preface section that you use for Main and
Title Page sections. You are responsible for entering any text and
graphics that need to appear in your Preface section.

Main
Use Main sections for the body of your document. You can create
as many Main sections as you want for a document. Typically you
would use Main sections for different chapters of a book or paper.
You can also use Main sections simply as a way of changing page
layout and/or master pages within the same document. Final Writer
places all Main sections together after any Title Page or Preface
sections. Paragraph styles created for one Main section are shared
with other Main sections, as well as Title Page and Preface sections.
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Outlines
An Outline section is a summary of a document analyzed in head­
ings and subheadings. To produce an outline of your document
you arc required to:

• Define which Main section paragraph styles you want to trigger
the creation of an outline entiy. You do this by assigning an
outline level to the style. For complete information on para­
graph styles see Chapter 7.

• Create your document and assign the appropriate Main section
paragraph style to each paragraph that you want in your
outline.

Popup menu used
to assign an outline
level.

When Final Writer creates an outline, it scans a document looking
for paragraphs that are supposed to generate an outline entry.
When it finds one of these paragraphs it creates an outline entiy by
prefixing the paragraph's text with a sequential letter or number that
is determined by the level being created and where the entry falls
sequentially within the outline. It formats the outline entry- accord­
ing to the Outline section's paragraph style corresponding with the
level being created. Typically you would set up Main section
paragraph styles for topics, headings, and sub-headings in such a
way as to generate an outline in the order these items should
appear in an outline. For example, if you look at the default
paragraph styles Final Writer uses, you will see the following styles
and their outline assignments:

Style Name Outline assignment

Section Name
Topic Name
Sub Topic 1
Sub Topic 2

Level 1
Level 2
Level 3
Level -i
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An example of an outline created using the above styles is:

1. Section Name
A. Topic Name
B Topic Name

1. Sub Topic 1
2. Sub Topic 1

a. Sub Topic 2
b. Sub Topic 2

3. Sub Topic 1
C. Topic Name

You can assign one of 8 outline levels to any Main section para­
graph style. In the above example only 4 levels of outline are used.
You can also modify the outline section's paragraph styles to suit
your needs.

To set up a document so an outline can be created:

1. Either use Final Writer's default paragraph styles with
outline levels already assigned, or create your own.

2. Create your document, and whenever you enter a para­
graph such as a heading or topic name, assign it one of
the paragraph styles that has been set up to generate an
outline entry level.

Table of Contents...
Table of Illustrations...
Endnotes
Bibliography
Index
Sort Parogrcphs

BO® Eli
Speller...
Thesaurus-
Statistics...

ISED{
SB.1

louniiieMEra____ J

To create an outline:

1. Choose “Outline...” from the “Tools” menu.

The “Outline" requester will appear.

2. Make whatever settings you want in the requester and
press “OK”.
Final Writer will create and then display the Outline section.

Sections 10-7

10

Sections



Table of Contents
The Table of Contents section is a list of your document's headings
and subheadings and includes page numbers where these items
appear in the document. To produce a Table of Contents you are
required to:
• Define which Main section paragraph styles that you want to

trigger the creation of a Table of Contents entry. You do this
by assigning a Table of Contents level to the style, For com­
plete information on paragraph styles see Chapter 7.

• Create your document and assign the appropriate Main section
paragraph style to each paragraph that you want in your Table
of Contents.

Paragraph Style
Requei•stei Popup menu used

to assign a Table of
Contents level

•r

Main section's

When Final Writer creates a Table of Contents, it scans a document
looking for paragraphs that are supposed to generate a Table of
Contents entry. When it finds one of these paragraphs it creates an
entry in the Table of Contents using the paragraph's text along with
the page number the paragraph is on. It formats the entry accord­
ing to the Table of Contents section's paragraph style corresponding
with the level being created. Typically you would set up Main
section paragraph styles for topics, headings, and sub-headings in
such a way as to generate a Table of Contents in the order of
importance these items are to appear. For example, if you look at
the default paragraph styles Final Writer uses, you will see the
following styles and their Table of Contents assignments:

Style Table of Contents
Name assignment

Section Xante
Topic Xante
Sub Topic 1
Sub Topic 2

Level 1
Level 2
Level 3
Level i
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__________
Speller...
Thesaurus... I^E51
Statistics...
Outline..

i
Table of Illustrations...
Endnotes >
Bibliography >
Index >
Sort Paragraphs V

An example of a 1 able of Contents created using the above styles is:
Section Name

Topic Name 1
Topic Name 2

Sub Topic 1 3
Sub Topic 1 3

Sub Topic 2 3
Sub Topic 2 3

Sub Topic 1 4
Topic Name 5

You can assign one of 8 levels of Table of Contents to any Main
section paragraph style. In the above example only 4 levels are
used. You can also modify the Table of Contents section's para­
graph styles to suit your needs.

To set up a document so a Table of Contents can be created:

1. Either use Final Writer's default paragraph styles with
Table of Contents levels already assigned, or create your
own.

2. Create your document, and whenever you enter a para­
graph such as a heading or topic name, assign it one of
the paragraph styles that has been set up to generate a
Table of Contents entry.

10

To create a Table of Contents section:

1. Choose “Table of Contents...” from the “Tools” menu.

The "Table of Contents" requester will appear.
. = . • ~i <a

-------------Options---------------
_ | Include Title

r Begin Page Numbers
J With Level 1 entries
J With Level 2 entries
C With Level 3 entries

OK | Cancel |

2. Make whatever settings you want in the requester and
press “OK”.
Final Writer will create and then display the section.

Sections 10-9

Sections



Table of Illustrations
A Table of Illustrations section consists of a list of titles of graphics
and image objects in your document, along with the page numbers
on which these objects appear. To produce a Table of Illustrations,
you are required to assign titles to all graphics and imported images
within your document that you want referenced in the Table of
Illustrations.

When Final Writer creates a Table of Illustrations, it scans a
document's graphics and imported image objects looking for objects
containing an "Illustration Title". When it finds one of these objects
it generates a Table of Illustrations entry using the "Illustration Tide"
text along with the page number the object appears on.

To indicate that a graphic or imported image is to appear in
the Table of Illustrations:

See Chapter 8 for more information on the "Sellings" requesters.

1. Access the object's “Settings” requester by either 1)
double-clicking the mouse on an object, or 2) selecting the
object and choosing the appropriate item from the “Set­
tings” sub-menu.

2. Make whatever settings you want to in the requester and
press “OK”.

Final Writer will create and display the section.
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Endnotes
Endnotes are bibliographical information linked to a source and
placed at the end of the document. Final Writer creates the End­
notes section using endnote text you enter as you insert endnotes
into your document. The Endnotes section is always placed after
the last Main section in your document.

To insert an endnote in your document:

1.

2.

3.

|i&

Index

Tools")

Set the insertion point (click the mouse) in your document
where you want to insert an endnote.
Choose “Insert...” from the “Endnotes” sub-menu.

Final Writer will display the “Insert Endnote" requester.
Click the mouse in the text rectangle so that you see an
insertion point, and enter the text for the endnote.

----------------------------------- Text-------------------------
Report Writing for Business (Homewood. III.:
Richard D. Irwin. Inc., 1981). p. 187|

Click in this rectangle
before you type in the
endnote.

3?eller- IS3K
Thesaurus... cz’z-en
Statistics..
Outline"...........................
Table of Contents .
p3?!? .??!!?.—otions-
Bibliograp Edit-------- ,

4. Click on the “OK” button.

Tools
Speller...
Thesaurus...
Statistics...

13
Create..

Outline’’ ................
Table of Contents...
Table of Illustrations
Mog Insert... ~]
Bibliograp
Index Create...

Final Writer will save the endnote text and place an endnote
marker in your document at the insertion point is. The marker
is a number whose value depends upon where the endnote's
location is in relation to other endnotes in the document. Final
Writer will automatically calculate which number to use.

Endnotes that you have inserted into a document may be edited or
viewed at any time using the “Edit Endnotes" requester. Formatted
endnotes only appear when you create the Endnotes section.

To access the “Edit Endnotes” requester:

1. Choose “Edit...” from the “Endnotes” sub-menu.
Final Writer will display the "Edit Endnotes" requester.
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To edit an existing endnote: 

1. In the list titled "List of Endnotes” click the mouse on the
line that contains the endnote to be edited.

Final Writer will enter the complete text of the selected endnote
in the data entry area titled "Endnote Text".

2. Click the mouse in the area of the endnote text where you
want to begin editing.

3. When you are finished editing, click on the “Save” button.

4. Repeat steps 1-3 for each endnote you wish to edit.

To remove an endnote from a document:

1. In the document text, delete the marker of the endnote to
be removed.
Final Writer will remove the marker and the endnote text
associated with it.

To create the Endnotes section:
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2. Make whatever settings you want to in the requester and
press “OK”.

Final Writer will create and display the Endnotes section.

The “Marker”, "Indent", and “Format” settings in the Endnote
requester instruct Final Writer how to format endnotes. The “In­
dent" setting defines the amount of white space that is to appear
between the endnote marker and the endnote text. “Marker” and
“Format” settings are as follows:

Marker options
Superscript
7 Ibid., p. 223.
Normal.
7. Ibid., p. 223.

Format options:
Flush Left
1. John E. Warriner and Francis Griffith, English
Grammar and Composition (New York: Harcourt
Brace Jovanovich, 1977), p. 208.
2. Ruth I. Anderson et al., The Administrative
Secretary: Resource (New York: McGraw-Hill, 1970),
p. 357.
Flush and Hang
1. John E. Warriner and Francis Griffith, English

Grammar and Composition (New York: Harcourt
Brace Jovanovich, 1977), p. 208.

2. Ruth I. Anderson et al., The Administrative
Secretary: Resource (New York: McGraw-Hill,
1970), p. 357.

Indented
1. John E. Warriner and Francis Griffith, English

Grammar and Composition (New York: I larcourt
Brace Jovanovich, 1977), p. 208.

2. Ruth I. Anderson et al., The Administrative
Secretary: Resource (New York: McGraw-Hill, 1970),
p. 357.

10

Sections 10-13

Sections



Tools
Speller... eaJ(
Thesaurus.. EES)
Statistics...
Outline...
Table of Contents...
Table of Illustrations...
Endnotes , 

Index I Create...
Blbllograp |Add/Edlt.

Bibliography
Use Final Writer's Bibliography feature to create a list of all works
you have found relevant in writing a document. Final Writer places
your Bibliography after the Endnotes section and before the Index
section. You can create and/or edit Bibliography entries at any time
during the creation of a document. Final Writer will save your
entries with the document. When you instruct the program to
create the Bibliography, Final Writer will create the Bibliography
section consisting of your entries automatically arranged in alpha­
betical order. Bibliography entries are added, edited, and deleted
using the “Edit Bibliography Entries” requester.

To access the “Edit Bibliography Entries” requester:

1. Choose “Add/Edit...” from the “Bibliography” sub-menu.

Final Writer will display the "Edit Bibliography Entries" re­
quester.

IS
-----------List of Entries------ ------------------------Bibliography Entry-------------------

J

Al]
i------------------------ Acticnc------------------------- j
I Mev/ | Save | -TEI#?;?'-:-' ■ i'|

OK C | Concel I

To add a new bibliography entry:

1. Click the mouse in the data entry area titled “Bibliography
Entry”.

After you click the mouse you should see an insertion point.
2. Enter the text for the entry and press the “Save” button.

Final Writer will add the new entry to the list of bibliography
entries it keeps for your document.
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To edit an existing entry: 

1. In the list titled “List of Entries”, click the mouse on the
line containing the entry you wish to edit.

Final Writer will copy the full text of the entry into the data
entry area.

2. Set the insertion point (click the mouse) where you want
to edit, make your edits, and press the Save button.

Final Writer will replace the old text with the new text.

To delete an existing entry:

1. In the list titled “List of Entries”, click the mouse on the
line containing the entry you wish to delete.

2. Click on the “Delete” button.

10

Speller.
Thesaurus
Statistics.

cast
33)

Outline...
Table of Contents
Table of Illustrations
Endnotes b

Add/Edit...
index i
' Peace: ■-pi-

To create the Bibliography section:

1. Choose “Create...” from the “Bibliography” sub-menu.
Final Writer will display the "Bibliography" requester.

________ ie
— Options —

✓| Show Title
Indentation ■?

|o.3?5 ~|

OK | Cancel |

2. Make any settings you want to make in this requester and
click on the OK button.
Final Writer will create the Bibliography section by arranging
your entries in alphabetical order.

Sections 10-15

Sections



Index
Final Writer's Index feature makes it very easy to create an excellent
index for your document. You can index the current word, a
phrase, or all words in a selected range. If what you index is on
more than one page, Final Writer will automatically add those pages
to the index. When you ask Final Writer to create your index, the
program scans the document looking for every occurrence of the
entries you have indexed. Il formats the index in the Index section,
and places this section as the very last one in the document.

To index a word:

1. Set the insertion point (click the mouse) on or before the
word you want to index.

2. Choose “Insert Word” from the “Index” sub-menu.
Final Writer will add the word to a list of indexed words.

To index a phrase or words as one index entry:

1. Select the text that you want to index as one entry.

2. Choose “Insert Selection” from the menu.

To index all words in a selected range:

1. Select the text that you want indexed.
2. Choose “Insert Word(s)” from the menu.

Final Writer will scan the selected range of text for words.
Ever)' time it finds a word or number it will add the word to the
list of indexed entries.

You can edit or delete indexed entries at any time. Indexed entries
are edited and deleted from the “Edit Index Entries" requester.

To access the “Edit Index Entries” requester:

1. Choose “Edit...” from the “Index” sub-menu.

Final Writer will display the requester.
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To edit an index entry:

1. In the list titled “Index Entries” click the mouse on the
entry you want to edit.

2. Change the entry to whatever you want it to be and click
on the “Save” button.
Final Writer will replace the old entry with the edited one.

To delete an index entry:

1. In the list titled “Index Entries” click the mouse on the
entry you want to delete.

2. Click on the “Delete” button.
Final Writer will remove the entry from its list of indexed
entries.

To delete all indexed entries:

1. Click the mouse on the “Delete All” button.
Final Writer will remove all words from the list of indexed
entries.

TOOlS |

Speller EZ9[
Thesaurus.
Statistics
Outline
Table of Contents...
Table of Illustrations...
Endnotes »
Bibliography►

| Index
fcrTpaica lnsert Word's)
------------ insert Selection

Edit...

To create the Index section:

1. Choose “Create...” from the “Index” sub-menu.
|ie

------------ Option*--------------
✓| Include Title
✓I Include Letter Header

OK | Cancel |

The “Index” requester will appear.
2. Make any settings you want to make and click on “OK”.
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Updating special sections
Final Writer creates the content of the Outline, Table of Contents,
Table of Illustrations, Endnotes, Bibliography, and Index sections. If
you have already created one or more of these special sections, and
then modify the document so that these special sections need to be
updated, you will need to instruct Final Writer to create the section
again. When the program creates the section again, it will remove
anything that is already in it. For example, if you have created an
Index section, and then add pages in the middle of the document,
the Index is now probably invalid. To update the index to reflect
the new state of the document, simply instruct Final Writer to create
the Index section. When it creates the Index section again, it will
remove the old Index section automatically.
Warning, you can modify any text that Final Writer creates in a
special section, but if you make modifications to your document
that force you to create a new special section, you will lose all
modifications you made within the special section.

Reformatting special sections
Final Writer formats all text within the Outline, Table of Contents.
Table of Illustrations. Endnotes. Bibliography, and Index sections by
using paragraph styles assigned to the respective section. By
redefining these paragraph styles you can reformat existing sections
or change the fonnat of sections to be created.
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Notes...
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| Printing a Document
Now that your document has been created, revised, formatted, and
made perfect in every way, it is time to print. This chapter includes
all the information you will need to know to print your document
successfully.
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Printing a document
Final Writer provides two ways of printing: draft and final.
Draft In draft mode the program uses the built-in, mono-spaced

font of a printer to produce output. Draft mode is used
primarily for quick printouts of your text during proofing.
In draft mode all graphics, headers, footers, and formatting
arc ignored. You can set margins to be used for draft
printing, but these are used only in printing -- not on the
screen.

Final In final mode the program prints a document exactly the
way it appears on the screen. Final mode printed to a
PostScript® printer or file is usually very fast. Final mode
printed to a graphic printer is slower. Final mode always
results in the best output a printer is capable of.

How to print a document
Printing a document is simple, however it is necessary to ensure
that your computer is prepared to print. This includes installing and
selecting the appropriate printer driver, in addition, you may want
to modify some of Final Writer's print settings to suit your needs.

Prelect

To print a document:

The "Print Document" requester will appear.
1. Choose “Print..." from the “Project” menu.

2. Modify any settings you wish to change.
Refer to the next section for full details on settings that can be
modified in the "Print Document" requester.

3. Click on the “Print” button.
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If you are printing to a PostScript® file, a requester will appear
prompting you for the name of a file to write the PostScript®
information to.
•;••• ------ --------- -L....__ I©
------------------------------Filename---------—
|SourceDlsk:swDev/fc  3Alntitled.PS

OK | Choose 1 Cancel |

Supplied in the requester will be a default name. You can
either use the default name, change the name in the requester,
or use the "Choose" button to specify a name via a file re­
quester.

How to stop printing
While a document is being printed, the program will display the
"Printing Document...” requester. You can cancel or stop printing
while printing is occurring as long as this requester is on the screen.

New t-^iaN
Open.. G3-EBO
Save
Save As... EEBW
Save Text Clip...

STzaBiiSi
Print Merge...
Delete...
Preferences ►
About >
Quit ~e=3Q

To stop printing:

1. Click on “Stop” in the "Printing Document...” requester.
Information in the print buffer will still be printed, but no more
information will be sent to the printer by the program.

The “Print Document” requester
Final Writer provides considerable flexibility in producing printed
output. The options and settings that arc available via the “Print
Document " requester can be modified to suit your needs. When
the "Print Document" requester is displayed, all options are set to
either their default values, values that you have saved, or values
from your last print.

To access the “Print Document” requester:

1. Choose “Print...” from the “Project” menu.

If you have not specifically saved the “Print Document" requester’s
settings, the settings displayed will be the program’s default values
set by Softwood. If you have saved the “Print Document”
requester’s settings, those settings will be the program’s default
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values, and will be shown in the “Print Document” requester. Some
settings may be carried over from a previous printing as long as the
document has not been closed since the last time it was printed.

Collate —t

Odd only

Below are descriptions of the settings found in the ''Print Docu­
ment" requester, and how you can use them:
Copies -

Preferences -

Section -

Pages -

Enter the number of copies of your document
that you want printed in the "Copies" data
entry area.
Click on these buttons to access additional
print options. These options are discussed in
later sections of this chapter.
If your document has more than one section.
you can either print just one section, or the
entire document. This popup menu is used to
indicate your choice.
Clicking on the button preceding "All" will
cause Final Writer to print your document in its
entirety. If you only want a certain range of
pages to print, click on the button preceding
"Ranges" and enter the first and last pages of
your desired range in the data entry areas
under the words "From” and “To".

Collate - This option defines which pages are printed
when printing in Final print mode. Normally
you will use the "All" setting. If you are
printing two-sided pages, you can use the
"Odd only” option to print pages 1,3.5, etc.,
turn the printed pages over, and then use the
"Even only” option to print pages 2,-1,6, etc.
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Border
■ ol>r Tci J?]

___ uack to Front

Order -

— Print To:-----------
_b| ih.< t h, ,i-. ]

Graphic (Draft)
PostScript Printer

■Hl PostScript File

Print To -

Paper Feed —■

Single Sheet _

Paper Feed -

211 Set Default Set Default -

This option is used to specify the order in
which pages of your document are printed
when printing in Final print mode.
This option specifies where Final Writer is to
print. If you are printing to a printer, you will
either specify Graphic Printer or PostScript®
Printer. If you are saving PostScript® data to a
disk file so you can take it to someone who
has a PostScript® printer, you should use the
“PostScript® File” option. See “PostScript®
Printing" later in this chapter for more informa­
tion.
This option defines the way your printer
handles pages. Laser printers and printers with
sheet feeder are specified as “Single Sheet";
otherwise use "Continuous".
Check this if you want the "Print Document"
requester's settings to be saved as the
program's default values.

Graphic preferences
Settings that affect Final mode printing on graphic (non-PostScript®)
printers are found in the “Graphic Final Print Preferences" requester.

To access the “Graphic Final Print Preferences” requester:

1. Click on the “Graphic” button in the “Preferences” section
of the “Print Document” requester.

4 / 300x300

Color Correct -
Correct For
g]Red
UM Green
I^J Blue

----- Colors-------;
4096

- Dithering -
Ordered

J Halftone
------Shading-------

Black & White
j Grey Scale
3 Color

------Printer Driver------ ;
HP_DeskJet |

----------Density-----------

OK f | Cancel |
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-------Printer Driver--------
HP_DeskJet

:---------- Density------------
j MSflflHMflMB HflKISflMMKl

JSSZSsSSZSSiJ
41300x300

-------- Threshold----------

7

— Color Correct -
Correct For-
jfflRed
181 Green
Jffl Blue

■------ Colors------- r
4096

— Dithering —;
(~ Ordered
j Halftone

-------Shading--------
C Black & White

. 0 Grey Scale
|(0 Color

Cancel [OK

luintoli v'J-'lr ■?li-nr=!i’=‘r>’-=>:. ~ “l!tE5

Below are descriptions of the settings in the “Graphic Final Print
Preferences" requester:
Printer Driver - The name of the printer driver you have

installed is displayed here. You install a printer
driver from the Workbench™ Preferences, not
Final Writer.

Density -

Threshold -

Graphic printers print by creating images out of
a series of dots. Density is a term used to
describe the quantity of graphic dots in a given
space on the printed page. Different printers
have different densities. Some have a number
of available densities. Final Writer lets you
select from seven different density settings (1 is
low density, 7 is high density). However, not
all density settings may be available for your
printer. If you are unsure of the number of
densities available for your printer, or the dots
per inch of each, click on each density button
and observe how the numbers in the "DPI" box
change. A higher density will increase the
amount of time it takes to print your document
and, with some printers, may result in muddy
colors.
This setting determines which colors on the
screen are printed as white, and which are
printed as black when the "Shade" option is set
to "Black & White".
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Color Correct -

Dithering -

Shade -

If you are printing color graphics, this setting
helps you to better match screen colors to the
colors produced by the printer. Without color
correction, the printer device can print all 4096
colors displayed by the Amiga® on a color
printer. However, as color correction is
applied, the total number of printed colors is
reduced by 308 shades for each color selected
for correction. The total number of colors
available is always displayed in tire area under
the word “Colors”.
To see the effect of color correction, you may
wish to print a picture with solid red, green,
and blue shades once with color correct on,
and once with it off. Then compare the two
pictures with the screen display.
Dithering refers to the way in which colors are
produced on the printed page. It enables you
to produce printouts with various shades on a
printer that only uses four colors. Dithering
only applies to color or grey scale printing.

Ordered dithering - color intensities are
formed using an ordered dither method.
Ordered dithering produces shades on the
printer using an ordered pattern of dots.
Halftone dithering - Color intensities on the
printer are formed using a halftone dither
method. This technique is similar to the one
used in newspapers and comic books. It
works best on high density printers (greater
than 150 dots per inch).
Use this setting to specify whether documents
are to be printed in color, black & white, or
shades of grey. For faster printouts use black
& white.
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PostScript® preferences
Settings that affect printing to a PostScript® printer, and printing
PostScript® information to a disk file are made in the “PostScript®
Preferences" requester.

To access the “PostScript® Preferences” requester:

1. Click on the “PostScript®” button in the "Print Document"
requester.

r Printer Type -j
H .. i|!
— - Shade-------
el • I

l“s Color c

— Download fonts —
Bl

Every time

- F'aae Mode —
_ei

Thumbnails

Below are descriptions of the settings in the “PostScript® Prefer­
ences" requester.

Printer Type -

Shade -

Use this setting to which Amiga® port your
PostScript® printer is connected to.
This setting defines whether you want color
PostScript® information generated. If you are
not printing to a color PostScript® printer, set
shade to "Grey Scale”.

Download fonts- Indicates how you want fonts not on a
PostScript® printer to be downloaded.

Halftoning - You can either use the default halftoning
settings of your printer or specify your own.
When "Custom" is selected, you can enter Lines
Per Inch, Screen Angle, and Spot Function.

Page Mode - Use this option to indicate whether you want
to print in Normal mode or with thumbnails. If
Thumbnails is selected, you can specify the
number of thumbnails that are to appear on a
page.
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Scaling -

Crop Marks -

Page Size -

Orientation -

When printing in "Normal" Page Mode use this
option to specify special print scaling.
Use this option to specify whether or not you
want crop marks printed on your document.
This setting indicates what size paper you are
using in your printer. If you choose "Custom",
you can enter your own dimensions.
If you want your page printed in the normal
fashion, set this option to “Tall". If you want to
print sideways, set this option to “Wide”.

“Draft Preferences” requester
The settings in the “Draft Preferences” requester affect printing in
draft mode. Draft mode is not available on PostScript® printers. If
you choose to print to a PostScript® printer or disk file, the Print
Draft option is not available.

To access the “Draft Preferences” requester:

1. Click the mouse on the “Draft” button in the “Print Docu­
ment” requester.

First (Chars)----- ;

Margins
I------ Top (Lines)------- , |I------Left (Chars)------ ,
|b -II|16 |
I— Bottom (Lines) —, ,I-----Right (Chars)----- T
I1’ IIl.^.. ■ __ I

— Lines Per Page —,

- Pitch -
f* Pica
j Elite
J Fine

- Quality -
C Draft
J Letter

-------Spacing------- r
C 6 Lines Per Inch
3 6 Lines Per Inch |

OK | Cancel |

Below are definitions for the options and settings in the "Draft
Preferences" requester:

Lines - Use this option to specify the size of your page
in terms of the maximum number of lines that
can be printed on it. This setting will depend
upon the vertical size of your page, the "Spac­
ing" option (also found in the “Draft Prefer-

Printing a Document 11-9



Margins
Top -

Bottom -

Left-

Right -

First -

ences" requester), and the printable area on the
page. Below are a few examples:

Page Size Spacing Feed
Paper
Length

8 1/2 X 11 6 Continuous 66
8 1/2 X 11 8 Continuous 88
8 1/2 X 11 6 Sheet 54
Label 6 - 6

Top margin is the number of lines from the top
of the printable area of a page that you do not
want to print on. This value is measured from
the top of the printable area. For example, a
one inch top margin on a continuous feed
printer, using “6 lines Per Inch" spacing, would
require a Top Margin value of 6. < In a con­
tinuous feed printer, there will already be a top
margin equal to the non-printable area at the
top of the page.
Bottom margin is the number of lines from the
bottom of the printable area of a page that you
do not want to print on. If you are using a
sheet fed printer, there will already be an area
at the bottom of the page where printing can
not occur.
The number of characters from the left of the
printable area of a page that you do not want
to print on. For example, a one inch left
margin using Pica (10 characters per inch) pitch
would mean a Left Margin value of 10.
Right margin is measured from the left side of
the printable area of a page. It defines the
maximum width to print on. For example, on
a page with a printable area of 8 inches, using
Elite (12 characters per inch) pitch, a one inch
Right Margin would require a value of 84 ((8
inches - 1 inch) X 12 characters per inch).
First margin is the number of characters from
the left side of the printable area of a page you
want to indent when printing the first line of a
paragraph.
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Pitch -

Spacing -

Quality-

Pitch defines which mono-spaced printer font
you want to print with. Pica gives you 10
characters per inch, Elite gives you 12 charac­
ters per inch, and Fine gives you condensed
print.
Spacing defines the vertical placement of lines
on a page as a function of lines per inch.
Quality defines the type of printer font you
want to print with.

PostScript® printing
If you have a PostScript® laser printer, or if you know someone
who does, you can use Final Writer's built-in PostScript® printer
driver.
Final Writer's PostScript® output can be directed to your Amiga®'s
parallel (PAR:) or serial (SER:) device. It may also be redirected to a
file which can be taken to a typesetting service and printed.

Communicating with the serial port
Final Writer will communicate through the serial (SER:) device to a
PostScript® printer using the current serial preference settings. The
output generated is strict (7-bit) ASCII to provide widest acceptance
on the host PostScript® printer.

Preferences
Making sure your Amiga® has the proper serial connection with the
printer is very dependent on the output device. The default settings
of either 9600 or 1200 baud, 8 hits/char, No parity, 1 stop bit, and
XON/XOFF handshaking usually work with no problems.

Handshaking
Often, when a simple document is printed, it works fine, but when
a complex document is printed, the printer produces no output. In
most cases, this is due to a handshaking problem and can be
corrected by matching the handshake between the Amiga® and the
printer.
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To find out what handshaking your printer uses run the PostScript®
program show below. Use a text editor like emacs or ed. You can
also use Pinal Writer but make sure you save the file as ASCII.

/Helvetica findfont 20 scalefont setfont
40 200 moveto
statusdict begin
25 sccbatch
(The Options number is ) show
10 string cvs show
(. The baud rate is ) show
10 string cvs show
end
showpage

Save the file as “shake" and exit the editor. Prom the CI.l, copy the
shake file to the serial port with a command such as “copy shake
set:" This will send the PostScript® program to the primer where it
will be run. The printer should print a sheet of paper. II' nothing
seems to happen, cycle the power on the printer, wait a moment.
and try' again. The output should read:

The Options number is 0. The baud rate is 9600
If your options number is in the range of 0-3, the handshake is
properly set to Xon/Xoff. If your options number is in the range -i-
7, there is a problem - the printer is set to DTR handshake. This
won't work well with the Amiga®.
The options number is interpreted as follows:

0 or 4 Ignore parity
1 or 5 Odd parity
2 or 6 Even parity
3 or 7 No parity

For the Amiga®, the options should be set to 0.
Some printers have switches or front panel controls for the options
and baud rate. If your have one of these, look in your manual tor
the correct settings. Other printers require a PostScript® program
like the one given below.
Replace BAUD and OPTIONS with the numbers your wish to set.

serverdict begin 0000 exitserver
statusdict begin
25 SAUD OPTIONS setsccbatch
end
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Type the program in using your text editor and run it by copying it
to the SER: device as described above. This will change the internal
baud and options settings. The settings will stay in effect even if
you turn the power off. You should not change the settings more
often than necessary, though. The EEPROM device that stores the
settings wears out after about 10,000 uses.

After running the program, either send a CTRL-D to the printer or
wait 30 seconds for the changes to take effect.

Advanced topics
The “sw_prologue.ps” file
Located in the “FCFiles" drawer is the file, “sw_prologue.ps" This
file must be available for Final Writer to generate PostScript®
output. If Final Writer is properly installed, this file will be available
at all times. Please do not modify “sw_prologue.ps". PostScript®
programmers can do customized procedures using the “user-def.ps"
file.

The “User-Def.ps” file
Although the file “user-def.ps” is not included on your Final Writer
disks, a PostScript® programmer may want to create a few custom
PostScript® procedures for doing such things as color separations,
page registration marks, etc. Final Writer leaves these options open
for the PostScript® programmer.
When printing, Final Writer looks in the “FCFiles" directory for the
file, “user-def.ps”. If the file is found, it is inserted into the
PostScript® output, giving the user a chance to define a few custom
PostScript® procedures that will be called while the document is
printing. Those PostScript® procedure names are:

UserDoc
UserBOP
UserEOP

UserDoc is called right before the document begins printing. This
gives the PostScript® programmer the ability to set up device­
dependent information such as undercolor removal, halftone
screens, and the like.
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UserBOP is called at the beginning of each page, and UserEOP is
called right before each page is ejected from the printer. These two
procedures can be used to print registration marks or other informa­
tion that yon want to print on each page.

Pinal Writer also keeps a few PostScript® variables current while the
document is printing. These variables arc:

u_doc - The document name
u_time - The current time (as of printing)
u_date - The current date
u_page - What page number we are printing
u_copy - What copy of this page is printing
u_pageht/u_pagewd - The document’s page dimensions

The variables “u_doc," "u_time," and “ii_dale" are updated when
the document begins printing, and can be used inside the user's
procedures to print cover sheets or for typesetting information
printed in the margins of each page.
The variables “u_page" and "u_copy" are also useful for typesetting
information printed on each page. “u_copy'‘ is particularly useful
for doing color separations. You may specify that Pinal Writer print
four copies of the document, and your "L'serDoc” or "I’serBt )P”
procedure may use the variable "u_copy" to set up halftone screens
and color separations for Cyan. Magenta. Yellow and Black.
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Notes...
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| Form Letters
With Final Writer, you can create a form letter, a list of recipients,
and print an individualized copy of the form letter for each recipi­
ent. Included in this chapter are instructions on:

• Creating and saving merge data.
• Creating a form letter.
• Merging data with a form letter.
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Producing form letters
To print form letters in Final Writer, you need:
• A form letter document containing text that is the same for

every copy of the letter, and indication where custom data
unique for each copy is to be inserted.

• A data file containing actual information that is different for
each letter, such as the names and addresses of recipients.

The form letter and the data file are combined using the "Print
Merge" command to print individualized form letters.
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Creating a data file
In the discussions that follow, “row" is used to refer to a collection
of related data; and “field” is used to refer to a piece of data within
a row. For example, in a name and address data file, a row refers
to all information for a person; while field refers to a person's name.
A data file is an ASCII disk file where fields are separated by comma
or tab characters, and rows are separated by a newline (0x0a) or
return COxOd) character. For example, in a name and address data
file, each person's name and address information (row) is separated
from another person's name and address by a new line or return
character. Within each row the name, address, city, state, etc., fields
are separated from each other by either a comma or tab character.
Although cither a tab or comma can be used to separate data, only
one method can be used in any given data file. Therefore, if data is
separated with a tab for one row of data, a comma cannot be used
to separate data on another row.
Final Writer uses the first row of a data file to determine the names
of fields. Therefore in a name and address data file, the first row
could contain the words “First" “Last" “Address" “City", etc. Subse­
quent rows would contain the actual names and address.
To summarize, the rules governing the format of data files that can
be used in Final Writer's Form Letter feature are:
• Data file must be an ASCII data file.
• Rows within a data file arc separated by cither a new line or a

return character.
• Fields within a row arc separated by cither a tab or a comma

character. Only one method of separating fields can be used in
any given data file.

• The first row of a data file must contain the names of the fields
contained in the file.

• The sequence of fields within a row must follow the sequence
of field names used in the first row.

A typical name and address data file might appear as:

NOTE. Where a field does not exist within a row, only the separat­
ing character is entered.

First Middle List Street City State Zip
Woody Williams 1200 Company Str. Tempe AZ 12315
Terry B. Wright 43 Sailboat Ave. Tempe AZ 32321
Mary L. lines 55 Golf Street Phoenix AZ 39393
Pat F. Brouilette 23 Rock Climb Rd. Tempe AZ 38290
Ben T. Fuller 553 Amiga Lane Mesa AZ 3234

o
3
r~CD
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Tips for setting up a data file document
You may want to modify two preference settings to make entering,
saving, and opening a data file more convenient. These preferences
are:

"Tabs every" value
Final Writer has a default tab distance value that is set in the
"Document Preferences" requester. This value specifies the distance
the program will move the insertion point whenever you press the
Tab key where no tab stops are set. When you are creating a data
file, and intend to use a tab character to separate data, you may
want to set this value larger than Final Writer's original default
value. We recommend setting the "Tabs Every" value in the "Docu­
ment Item Preferences" requester to at least .75 inches.

-------- Tabs--------
l------Every-------,

— Decimal —
Q|. Period |

---------- Date Format
g| July 22.1992

------- Date Order---------
G| Month/Day/Year |

• Time Format t
g| 12 Hour ||

Save | Use | Cancel |

ASCH I/O Preferences
We recommend the following settings for the ASCII I/O Preferences
used to read and write your data file.

■ ■ ___________ la
-------------------------- Input (Open) Options----------------------------
✓| Make a paragraph at each 'New Line' character.

J Make a paragraph at each blank line.___________

-------------------Output (Save) Options---------------------
j/| insert 'New Line' character after each line.

| Insert blank line after each paragraph.

Save | Use | Cancel |
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Saving a data file
If you use Final Writer to edit and save your data file, you will need
to save it as an ASCII file. In order to do this properly, always use
the “Save Copy of Document” feature rather than “Save". The
reason for this is that “Save” will always save an existing file as a
formatted Final Writer document. By using the “Save Copy of
Document” feature, you can specify that ASCII format is to be used.

New pgna N
Open... t^go

Save CESS

Save Text Clip...
Print...
Print Merge...

l^BP

Delete...
Preferences
About

►►
Quit EEBQ

To save a data file in Final Writer:

1. Choose “Save As...” from the “Project” menu.
A file requester will appear.

2. Use the file requester to locate where you want the data
file to be saved.

3. Insert in “File” whatever name you want to save the file as.
If you are saving a data file that already has been saved,
click the mouse on the name of the file in the file
requester's list.

4. Click on the “Export...” button in the file requester.

A list of file formats will be shown.

5. Click on the word “ASCII”, and then click on “Save”.
The file will be saved as an ASCII file.
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Creating a form letter
A form letter is created in Final Writer like any other document.
The only difference is that wherever you want data to be merged
into the text from a data file, you will choose the “Insert Merge
Field” menu item and specify the name of the field that is to be
merged. Once a merge field definition has been inserted, you can
change it, remove it, and even change its type attributes.

To insert a merge field definition:

1. Make sure the insertion point is where you want data to be
inserted from the data file.

2. Choose “Merge Field” from the “Insert item” sub-menu
located in the “Edit" menu.
The “Select Merge Field" requester will be displayed.
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3. If the “Fields” list is empty:
A. Click on the “Select...” button.

A file requester will appear.

B. Use the requester to locate a data file that contains the
names of the merge fields in the first row of the file.

C. Once the data file is located, double-click the mouse
on its name.

Final Writer will read the data file, locate the field names,
and place the names into the “Field Names" list.

4. Double-click the mouse on the name of the field in the
“Field Names” list whose data is to be merged.

Final Writer will remove the requester, and insert the field's
name into your document surrounded by double-bracket
characters.

For example, “«First»”.
5. Continue typing your form letter and repeat the above

steps for each merge field.
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Changing a merge field's type attributes
A merge field created by Final Writer can have its own unique type­
attributes. For example, your form letter could be in Times-Roman ■
while data merged into a particular merge field could be Times-
Bold.

To change a merge field's type attributes:

1. Click the mouse on the merge field whose attributes are to
be changed.

Final Writer will select the entire merge field including its
surrounding brackets.

2. Set the type attributes using the “Text” menu items or the
“Type Specs” requester.

Changing a merge field's data name
You can change your mind as to what field is to be merged in a
merge field that is already defined.

To change a merge field's data name: 

1. Click the mouse on the merge field whose data name is to
be changed.
Final Writer will select the entire merge field including its
surrounding brackets.

2. Choose “Merge Field” from the “Update item” sub-menu
located in the “Edit” menu.
The "Select Merge Field" requester will be displayed.

3. If the “Field Names” list is empty:

A. Click on the “Select...” button.

A file requester will appear.
B. Use the file requester to locate a data file that contains

the names of the merge fields in the first row of the
file.

C. Once the data file is located, double-click the mouse
on its name.
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Final Writer will read the data file, locate the field names,
and place the names into the "Fields" list.

4. Double-click the mouse on the name of the field in the
“Field Names” list whose data is to be merged.

Final Writer will remove the requester, and insert the field's
name into your document replacing the name that was there
before.

Removing a merge field
You can remove a merge field from a form letter at any time.

To remove a merge field:

1. Click the mouse on the merge field to be removed.
Final Writer will select the entire merge field including its
surrounding brackets.

2. Press the DELETE or BACKSPACE key.

The merge field will be removed from the document.

Saving a form letter
A form letter is saved as a Final Writer document. There is nothing
special about saving a form letter - do it just as you save any other
document.

Merging data with a form letter
Once you have created a form letter and a data file you can instruct
Final Writer to merge the data file with the form letter. This process
will print an individualized copy of the letter for each recipient in
the data file.

To merge data with a form letter:

1. If the form letter document is not already open, choose
“Open” from the “Project” menu, and open the form letter
like you do for any other document that you open.

12
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New
Open .

EJN

Save ras
Save As.. ezjw
Save Text Clip .
Print essp

(Print Merge.. |
Delete.
Pieferences ►
About ►
Quit CEE3Q

2. Choose “Print Merge..." from the “Project” menu.

Final Writer will display the "Select Merge Data" file requester.
3. Use the file requester to locate the data file you want to

use for the merge.

I©
FCFiles
FCFonts
FCLibs
FmalCopy
MergeLetter
More

Drawer
Drawer
Drawer
222732

M98
7912

ReadMo 4266

Drawer (WofkFinaiCopy ..
J

File [ amebata

I OK | Volumes | Parent | Cane 1

4. Once the data file is located, double-click the mouse on its
name in the file requester's list.

’rhe “Select Merge Records" requester will appear.

1©J

OK [ Cancel |

---------------De
— ROWS —;r ah

it a---------------
— Range —
rrF,orn~T

Range| II- 1
I18 l|

Final Writer will analyze the data file and determine the number
of rows (records) contained in the file. It will put the number
"1" in the "From" range, and the last record number found in
the "To" range. This gives you the ability to select which group
of data records are to be merged. This feature is handy if you
have to restart a merge because of a printer error or some other
problem.

5. If you want to print all rows in the data file, click the
mouse on “All”. If you want to print a range of rows, click
the mouse on “Range”, enter the beginning row # in the
area labeled “From”, and enter the ending row # in the
area labeled “To”.
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Final Writer will display the "Print Document" requester.

6. Click on the "OK" button in the "Select Merge Rows'*
requester.

7. Use this requester just as you would if printing a single
document. Refer to Chapter 11 for details on using this
requester.
Final Writer will display the "Printing Document..." requester
and will begin to merge rows of data with the form letter. Each
page of the form letter will be printed for each data record
merged. You can cancel this process at any time by clicking
the mouse on the "Stop" button.

----------------------------------------

Progress ,

Stop C |
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| ARexx Support
Advanced users can use Final Writer's ARexx facility to create
"macro" programs. These macros can execute Final Writer com­
mands as well as commands understood by other programs. In
order to use ARexx it must be installed on your system.
This chapter describes commands that can be used in an ARexx
macro to execute Final Writer commands.

E
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Using ARexx in Final Writer
To use ARexx in Final Writer you must have ARexx installed on
your computer and be familiar with the ARexx language. ARexx is
considered a feature for "advanced" users.
An ARexx macro program is usually created in a text editor, but can
also be created in Final Writer and saved as an ASCII file. Each
Final Writer document window has its own ARexx port. The name
of this port always begins with "FinalW." and ends with a number
indicating the order in which the window was opened. For ex­
ample, the first window opened has an ARexx port name of
"FinalW.l"; the second window opened has a port name of
"FinalW.2".

Running ARexx scripts
You can create as many ARexx scripts as you want to execute Final
Writer commands. These scripts can be run from within Final
Writer as well as from other programs including the CI.I. Within
Final Writer you can access ARexx scripts in several ways: 
1. Clicking on a "User Button Strip" icon to which you have

assigned an ARexx script.
2. Selecting a "User Menu" item or pressing a function key to

which you have assigned an ARexx script.
3. Locating and selecting a script from a file requester.

Refer to the "Preferences" chapter of this manual for instructions on
assigning scripts to a User Button Strip icon or to a User Menu item.

ARexx errors
Final Writer returns one of the following numbers in the ARexx
variable "RC" after each ARexx command it processes.

0 No errors
5 Warning
10 Command failed
20 Command has invalid arguments
100 Unknown or invalid command
200 Can't open fwarexx.library
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Command syntax
The command arguments are given using the standard AmigaDOS
argument template in which the arguments arc separated by com­
mas and followed by a slash and a capital letter which indicates the
type of argument. The slash and the following letter, which are not
to be typed as part of the command, are explained below:

argumcnt/A (Always) This means that the argument
must always be given a value on the
command line.

option/K (Keyword) This means that tire argument is
optional. The option will only be filled if
the keyword appears on the command line
before the value to be assigned to the
option.

option/S (Switch) This also means that the argument
is optional. However, with this option, only
the keyword is specified on the command
line (without a value).

string/F (Final) This means that the argument is a
string which must be the final argument on
the command line. The remainder of the
command line will be taken as the desired
string.

13

Command list
The following is an alphabetical list of Final Writer's ARexx com­
mands. After each command is a brief description of what the
command is used for. Refer to the next section, Command defini­
tions" for complete descriptions of each command.

Command
AddlndexEntry
AddlndexWords
AltDown
AltUp
ASCIIPrefs
Backspace
BibPrefs

Description
Add a word or a phrase to the index list.
Add words to the index entry list.
Set ALT key status to DOWN.
Set ALT key status to UP.
Change the ASCII I/O preferences.
Same as typing backspace key.
Change the bibliography creation settings.
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BoxPrcfs
Bullet
Case
ChangeWindow
Clear
ClearDoc
Close
Copy
CopyRulcr
Create
CtrlDown
CtrllJp
Currentobject
Cursor
Cut
Delete
DeletelndexEntry
DeleteObject
DisplayPrefs
DocColorPrefs
DocItemPrefs
Draft Print Prefs
DrawBox
Drawl.ine
DrawOval
DrawText Block
Edit Bibliography
EditBody
EditEndNotes
EditlndexList
EditLeftMaster
EditRightMaster
EndNotePrefs
Extract
Find
FindCursor
Find.Xext
FindReplace
FirstObject
Font
FontColor
FontSize
GetASCIl Prefs

Change the box drawing settings.
Bullet the current or selected paragraphs.
Change the font case to the specified case.
Change the window position and size.
Delete the selected text or graphics objects.
Clear out the entire document.
Close the document.
Copy selected text or graphics to clipboard.
Copy the current ruler settings.
Create a new section.
Set CTRL key status to DOWN.
Set the CTRL key status to IJP.
Get the current object ID.
Move the insertion point.
Copy text or objects to the clipboard.
Same as typing the delete key.
Delete an entry from the index list.
Delete a graphic object.
Change the display preferences.
Change document color preferences.
Change document item preferences.
Change the draft print preferences.
Draw a box.
Draw a line.
Draw an oval.
Draw a text block.
Present the edit bibliography requester.
Edit the document's body pages.
Present the edit endnotes requester.
Present the edit index requester.
Edit the document's left master page.
Edit the document's right master page.
Change the endnote creation settings.
Get document text.
Find a text string.
Scroll to find the insertion point.
Find the next occurrence of a text string.
Present the Find. Replace requester.
Get the object ID of the first graphic object.
Change the font.
Change the font color.
Change the font size.
Get ASCII I O preferences.
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GetBibPrefs
GetBoxPrefs
GetDisplayPrefs
GetDocColorPrefs
GetDocItemPrefs
GetDraftPrefs
GetEndNotePrefs
GetGfxPrintPrefs
GetlmportPrefs
GetlndexList
GetlndexPrefs
GetLinePrefs
GetObjectCoords
GetObjectParams
GetObjectRotation
GctObjectTitle
GetObjectType
GetObjectTypeSpecs
GetOutlinePrcfs
GetOvalPrefs
GetPageSetup
GetPrintSetup
GetPSPrintPrefs
GetSectionList
GetSectionSetup
GetTextBlockPrefs
GetTextBlockText

Get bibliography creation preferences.
Get box drawing preferences.
Get display preferences.
Get document color preferences.
Get document item preferences.
Get draft print preferences.
Get endnote creation preferences.
Get graphics print preferences.
Get graphic import preferences.
Get a list of all the index entries.
Get index creation preferences.
Get line drawing preferences.
Get the object coordinates of an object.
Get the parameters of an object.
Get the rotation of an object.
Get the title of an object.
Get the type of an object.
Get the type specs of a text block.
Get the outline creation preferences.
Get the oval drawing preferences.
Get the page setup preferences.
Get the print setup preferences.
Get the postscript print preferences.
Get a list of the document's sections.
Get the section preferences.
Get the text block drawing preferences.
Get the text of a text block.

GetTextBlockTypePrefs
GetTOCPrefs
GetTOIPrefs
GfxPrintPrcfs
GoToPagc
GoToSection
GraphicTool
Group
HotZone
Hyphen
ImportPrefs
Indent
IndcntLeft
IndentRight
IndexPrefs
Insert

Get the text block type preferences.
Get the table of contents preferences.
Get the table of illustrations preferences.
Change the graphic print preferences.
Scroll to another page.
Switch to an existing section.
Make the graphic tool the current tool.
Group all selected graphic objects.
Change the hyphenation zone.
Turn hyphenation on or off.
Change the graphic import preferences.
Change paragraph indent.
Indent paragraph to the left.
Indent paragraph to the right.
Change the index creation preferences.
Insert a special item into the document.
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InsertEndNote
Insertimage
InsenPageBreak
Justify
Leading
LeftMargin
LinePrefs
Lock
MoveToLine
MoveToPara
MoveWindow
New
NewParagraph
NewSection
NextObject
ObjectToBack
ObjectToFront
Oblique
Open
OutlinePrefs
OvalPrefs
PageSetup
Paragraph
Paste
PasteRuler
Position
PostScriptFile
Preferences
Print
PrintSetup
PSPrintPrefs
Quit
Redraw
RcmovePageBreak
RemoveSection
RequestText
RightMargin
Sax e
SaveAs
ScreenToBack
ScreenToFn >nt
SectionSetup
SelccLAll

Insert a new endnote and marker.
Import a graphic image.
Insert a page break.
Change paragraph justification.
Change the font leading value.
Change paragraph left margin.
Change the line drawing preferences.
Lock the selected graphic objects in place.
Move insertion point to a different position.
Move insertion point to a different position.
Move the document's window.
Create a new document window.
Create a new paragraph.
Create a new section.
Get object ID of the next graphic object.
Send an object behind all others.
Bring an object to the front of all others.
Change the font oblique angle.
Open a document file.
Change the outline creation settings.
Change the oval drawing preferences.
Change the page setup options.
Present the paragraph settings requester.
Paste text or graphic into the document.
Paste copied ruler settings.
Change the font script.
Set the PostScript® output file name.
Present a preferences requester.
Print using the current print settings.
Change the current print settings.
Change the PostScript® print preferences.
Quit the program.
Reformat and redraw the document.
Remove a page break.
Remove a section from the document.
Request information from the user.
Change paragraph right margin.
Save the document to a disk file.
Present the "Save Document" requester.
Send screen behind all others screens.
Bring the screen in front of all others.
Change the section setup settings.
Select all the text.
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SelectObjcct
SetFind
SetMeasure
SetObjectCoords
SetObjectParams
SetObjectRotation
SetObjectTitle
SetObjectTypeSpecs
SetTab
SetTextBlockText
ShiftDown
ShiftUp
ShowMessage
ShowRulers
SizeWindow
Son
Spacing
Speller
Statistics
Status
Style
StyleSheet
TextBlockPrefs
TextBlockTypePrefs
TextTool
Thesaurus
TOCPrefs
TOIPrefs
Type
TypeSpecs
Ungroup
Unlock
UpdateDate
UpdateTime
View
Width
WinToBack
WinToFront

Select for deselect; graphic objects.
Set options for find.
Sets the measurement units.
Change the coordinates of an object.
Change parameters of a graphic object.
Set the rotation of a graphic object.
Set the title of an object.
Change an object’s type specifications.
Set a tab stop.
Change the text of a text block object.
Set SHIFT key status to DOWN.
Set SHIFT key status to UP.
Display a message requester to the user.
Show or hide the rulers.
Change the width and height of a window.
Sort the paragraphs.
Change the line spacing.
Present the speller requester.
Present the statistics requester.
Get various document information.
Change the font style.
Change the paragraph's stylesheet.
Change the text block drawing preferences.
Change the text block drawing type specs.
Make the text tool the current tool.
Present the thesaurus requester.
Change table of contents creation settings.
Change the table of illustrations settings.
Insert the characters into the document.
Present the type specs requester.
Ungroup the selected objects.
Unlock the selected graphic objects.
Update auto date strings.
Update auto time strings.
Change the current view size.
Change the font width.
Send window behind all others.
Bring window to the front of all others.
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Command definitions
The ARexx commands require Workbench™ 2.0 or greater. In the
examples below, the keywords are capitalized to help distinguish
them from the values they are given. When a command returns
results in the ARexx Result variable the options are put into the
result string in the order in which they appear in the command’s
argument template NOT in the order in which they arc specified on
the command line.

AddlndexEntry “Entry/A/F”
Add a word or a phrase to the index entry list.
See also AddlndexWords.

Entry - The word or phrase to add to the index list.
Examples:
AddlndexEntry "Softwood"
AddlndexEntry "Outline Fonts"

AddlndexWords “ONEENTRY/S”
Add words to the index entry list. If a range is not selected.
then add the word at the insertion point to the index list. If a
range is selected, then add each word in the range to the index
list. If a range is selected and “ONEENTRY" is specified, then
add the text in the range as one entry to the index list.
Examples:
AddlndexWords
AddlndexWords ONEENTRY

AltDown
Used with "Cursor" command. Set ALT key status to DOWN.
Sec also AltUp, CtrlDown. CtrlUp, ShiftDown. ShiftUp.

AltUp
Used with "Cursor" command. Set ALT key status to UP. See
also AltDown. CtrlDown. CtrlL’p, ShiftDown. ShiftUp.

ASCIIPrefs “ParaNewLine/K,ParaBlankLine/K,InsertNewLine/
K,lnsertBlankLine/K,PROMPT/S”
Change the ASCII Input Output preferences
ParaNewLine Set the Input option for making a para­

graph at each newline character.
Yes Turn the option on.
No Turn the option off.
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ParaBlankLine

InsertNewLine

InsertBlankLine

PROMPT

Set the Input option for making a para­
graph at each blank line.
Yes Turn the option on.
No Turn the option off.

Set the Output option for inserting a
newline character after each line.
Yes Turn the option on.
No Turn the option off.
Set the Output option for inserting a blank
line after each paragraph.
Yes Turn the option on.
No Turn the option off.
If specified, presents the ASCII I/O re­
quester, ignoring all other arguments.

Examples:
ASCIIPrefs PARANEWLINE Yes PARABLANKLINE No

Turns on the first input option and turns off the second
input option.

ASCIIPrefs PROMPT
Presents the ASCII I/O requester.

Backspace
Erase the character to the left of the insertion point. If a range
of text is selected, then delete the text in the range. This is the
same as typing the backspace key.
See also Delete.

BibPrefs “Title/K,lndent/K”
Change the bibliography creation settings.
Title Set the bibliography title option. Choose

one of the following:
Yes Include the bibliography title when

creating the bibliography.
No Do not include the bibliography title.

Indent Indent specification in ruler or micropoints.
(.125 - 5 inches)

Examples:
BibPrefs TITLE Yes INDENT .5

Include the title and make the indent .5 inches.
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BoxPrefs “TextFlow/K,FlowDist/K,LineWt/K,LineColor/K,Fill/
K,FillColor/K,PROMPT/S”
Change the box drawing settings.
TextFlow Change the text flow option. Choose one

of the following:
LeftVert Set to left vertical.
LeftCont Set to left contour.
RightVert Set to right vertical.
RightCont Set to right contour.
None Set to no text flow.

FlowDist Change the flow distance between box and
text, specified in ruler or micropoints
(0.025 - 2.0 inches).

LineWt Change the line weight. Choose one of the
following:
None, Hairline, .5,1, 2,4,6,8,10,12

LineColor Change the line color to a color specified
by a color name.

Fill Change the fill option. Choose one of the
following:
Solid Set the fill to solid.
Transparent Set the fill to transparent.

FillColor Change the fill color to a color specified by
a color name.

PROMPT Present box settings requester ignoring all
other arguments.

Examples:
BoxPrefs
BoxPrefs
BoxPrefs
BoxPrefs

LINEWT 2 LINECOLOR Black FILL Solid
FILLCOLOR Red
TEXTFLOW RightVert
PROMPT

Bullet
Bullet the current or selected paragraphs.

Case “Case/A”
Change the font case to the specified case.
Case Change the font case. Choose one of the

following:
Normal Set case to Normal.
SmallCaps Set case to Small Caps.
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AllCaps Set case to All Caps.
Examples:
Case Normal
Case AllCaps

ChangeWindow “Left/A,Top/A,Width/A,Height/A”
Change a document’s window position and size.
See also MoveWindow, SizeWindow.
Left Left coordinate of window in absolute

screen pixels.

Top Top coordinate of window in absolute
screen pixels.

Width Width of window in absolute screen pixels.
Height Height of window in absolute screen

pixels.

Examples:
Changewindow 10 20 400 300

Clear
Delete the selected text or graphic objects from the document
depending on the current tool. If the current tool is set to the
text tool, then the command will clear any selected text,
otherwise, it will clear any selected graphic objects.
See also Cut, Copy, Paste, GraphicTool, TcxtTool.

ClearDoc “FORCE/S”
Clear out the entire document prompting to save any changes.

FORCE If specified, clear the document regardless
of any changes made to the document.

Examples:
ClearDoc
ClearDoc FORCE

Close “FORCE/S”
Close the document prompting to save changes.

FORCE Close the document no questions asked.

Examples:
Close
Close FORCE
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Copy
Copy the selected text or graphic objects to the clipboard
depending on the current tool. If the current tool is set to the
text tool, then the command will copy any selected text,
otherwise, it will copy any selected graphic objects.
See also Cut, Paste, Clear, GraphicTool, TextTool.

CopyRuler
Copy the ruler settings of the paragraph that the insertion point
is in.
See also PasteRuIer.

Create “Section/A,PROMPT/S”
Create one of the special sections using its current settings.
Section The section type to create. Choose one of

the following:
Bibliography Create bibliography.
Contents Create table of contents.
EndNotes Create endnotes.
Illustrations Create table of illustrations.
Index
Outline
PROMPT

Examples:
Create Index
Create Contents PROMPT

Create index.
Create outline.
Specify to present the
settings requester before
creating the section.

CtrlDown
Used with "Cursor" command. Set CTRL key status to DOWN.
See also AltDown, AltUp. CtrlUp. ShiftDown, ShiftUp.

CtrlUp
Used with "Cursor" command. Set the CTRL key status to UP.
See also AltDown, AltUp, CtrlDown. ShiftDown, ShiftUp.

Currentobject
Return in Result the object ID of the current (selected) graphic
object. If there is not a current object, then Result is set to 0.

Cursor “Direction/A”
Move the insertion point in the specified direction. Additional
action is determined by the ALT, SHIFT, and CTRL key status.
See AltDown. AltUp, CtrlDown. CtrlUp. ShiftDown. ShiftUp,
MoveToLine. MoveToPara.
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Direction The direction to move. Choose one of the
following:
Left Same as pressing left arrow.
Right Same as pressing right arrow.
Up Same as pressing up arrow.
Down Same as pressing down arrow.

Examples:
Cursor LEFT
Cursor UP

Cut
Copy the selected text or graphic objects to the clipboard, then
clear the selection from the document depending on the current
tool. If the current tool is set to the text tool, then the command
will cut any selected text, otherwise, it will copy any selected
graphic objects.
See also Copy, Paste, Clear, GraphicTool, TextTool.

Delete
Erase the character to the left of the insertion point. If a range
of text is selected, delete the text in the range. Same as typing
the delete key.
See also Backspace.

DeletelndexEntry “Entry/A/F”
Delete an entry from the index list.

Entry The text of the entry to delete.

Examples:
DeletelndexEntry "house"

Removes the word ‘house’ from the index entry' list.
DeletelndexEntry "monthly report"

Removes ‘monthly report1 from the index entry list.
DeleteObject “Objectld”

Delete a graphic object. If "Objectld" is not specified, then
delete all the selected objects.

Objectld The object ID of the graphic object to
delete.

Examples:
DeleteObject

Deletes all selected objects.
DeleteObject 4

Deletes the object with an object ID of 4.

AFtexx Support 13-13



DisplayPrefs “Horizontal/K,Vertical/K,Guides/K,Rulers/
K,Measure/K,Shading/K,WBDocColor/K,PROMPT/S”
Change the display preferences.
Horizontal Set the Horizontal Screen DPI. Value from

40 to 600.

Vertical

Guides

Rulers

Measure

Shading

WBDocColor

PROMPT

Set the Vertical Screen DPI. Value from 40
to 600.
Set what page guides are to be shown.
This is a combination of letters. Specify:
P for Print Area guides
E for Edit Area guides
H for I leader/Pooter guides
C for Column guides

specify any other character to turn
everything off.
i.e. “PE”, "PEIIC", “E”, etc.

Set the rulers to be displayed. Choose one
of the following:
None Display no rulers.
Top Display only the top ruler.
All Display both left and top ruler.
Set the ruler measurement system. Choose
one of the following:
Inches Lise inch measurements.
Metric Use metric measurement (centi­

meters).
Pica Use pica measurement (1 inch =

6 picas).
Set the Imported Graphic On Screen
Shading method. Choose one of the
following:
NTSCGray Use NTSC gray mapping.
LightGray Use light gray mapping.
Color Use color mapping.

Set the document page color. Choose one
of the following:
PenO Use Pen 0 color.
HighLightPen Use the highlight color.

Present the display preferences requester
ignoring all other arguments.
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Examples:
DisplayPrefs GUIDES pe RULERS All

sets up the document to have print and edit guides and
both rulers.

DisplayPrefs PROMPT
presents the display preferences requester.

DocColorPrefs “ColorName/A,R/A,G/A,B/A,NewName/K”
Change the RGB color values for a color in the document color
preferences.
ColorName
R
G
B
NewName

Name of the document color to set.
The red color value 0-15.
The green color value 0-15.
The blue color value 0-15.
A new name for the color (optional).

Examples:
DocColorPrefs White 14 14 15

Change the values for the color named White.
DocColorPrefs Green 090 NEWNAME '"Dark

Green"'
Change the values for color Green and rename it Dark
Green.

DocItemPrefs “Tabs/K,Decimal/K,DateFormat/K, DateOrder/
K,TimeFormat/K,PROlVIPT/S”
Change the options in the document item preferences.

Tabs

Decimal

DateFormat

Change the default tab stops in ruler or
micropoints (0.125 - 10.0 inches).
Change the decimal character for use in
numbers. Choose one of the following:
Period Use the period character.
Comma Use the comma character.

Change the format to use in date strings.
Choose one of the following:
1 07/22/92
2 Jul 22, 1992
3 July, 22, 1992
4 Mon, Jul 22, 1992
5 Monday, July 22, 1992
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DateOrder Change the order in which the month day
and year appear in date strings. Choose
one of the following:
MDY Month Day Year.
YMD Year Month Day.
DMY Day Month Year.

TimeFormat Change the format to use for lime strings.
Choose one of the following:
12 12 hour format.
24 2'i hour format.

PROMPT Specify to present the document item
requester (all other arguments ignored).

Examples:
DocItemPrefs TABS 1.0

sets the default tab stop to be 1 inch.
DocItemPrefS DATEFORMAT 1 DATEORDER MDY

sets dates to appear as "5/15/93".
DocItemPrefs PROMPT

presents the requester.
DraftPrintPrefs “Top/K,Bottom/K,Left/K,Right/K, First/

K,LinesPerPage/K,Pitch/K,Quality/K,Spacing/K”
Change the draft print preferences.
Top

Bottom

Number of lines for the top margin.

Number of lines for the bottom margin
Left Number of character spaces for the left

margin.
Right Number of character spaces for the right

margin.
First Number of character spaces for the first

margin (aka indent).

LinesPerPage
Pitch

Total number of lines on a page.
Print pitch. Choose one of the following:
Pica. Elite, Fine

Quality Print quality. Choose one of the following:
Draft. Letter

Spacing Printer line spacing in lines per inch.
Choose one of the following:
Six. Eight
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Examples:
DraftPrintPrefs TOP 6 BOTTOM 6 LEFT 10 RIGHT

70
DraftPrintPrefs PITCH Pica QUALITY Letter

SPACING Eight
DrawBox “Page/A,Left/A,Top/A,Width/A,Height/A,BEVEL/S”

Draw a box using the current box settings. The box will be­
come the current object. Result will contain the object ID of the
new box. Use the Redraw command to show the image and
reformat any text.
Page Page number to draw the shape on (start­

ing from page 1).
Left Left horizontal position in ruler or

micropoints.

Top Top vertical position in ruler or
micropoints.

Width Width of box in ruler or micropoints.

Height Height of box in ruler or micropoints.
BEVEL Specify to draw a bevel box (rounded

corners).

Examples:
DrawBox 1 2 1 3.5 2.5
DrawBox 13211 BEVEL

13

DrawLine “Page/A,X1/A,Y1/A,X2/A,Y2/A,ARROW/S”
Draw a line using the current line settings. The line will become
the current object. Result will contain the object ID of the new
line. Use the Redraw command to show the image and reformat
any text.
Page Page number to draw the shape on (start­

ing from page 1).

x1 Beginning horizontal position in ruler or
micropoints.

y1 Beginning vertical position in ruler or
micropoints.

x2 Ending horizontal position in ruler or
micropoints.

y2 Ending vertical position in ruler or
micropoints.
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ARROW Specify to draw an arrow line. The arrow
tip is at the ending position (x2, y2).

Examples:
DrawLine 11122
DrawLine 1 3 1.5 1.75 1.5 ARROW

DrawOval “Page/A,Left/A,Top/A,Width/A,Height/A”
Draw an oval using the current oval settings. The oval will
become the current object. Result will contain the object id of
the new oval. Use the Redraw command to show the image and
reformat any text.

Examples:
DrawOval 12211.5

Page Page number to draw the shape on (start­
ing from page 1).

Left Beginning horizontal position in ruler or
micropoints.

Top Beginning hertical position in ruler or
micropoints.

Width Horizontal diameter in ruler or micropoints.
Height Vertical diameter in ruler or micropoints.

DrawTextBlock “Page/A,Left/A,Top/A,Text/A/F”
Draw a text block object using the current text block settings.
The text block will become the current object. Result will
contain the object ID of the new text block. The width and
height of the text block will be set by the program based on the
size of the font and the width of the characters. Use the Redraw
command to show the image and reformat any text.

Examples:
DrawTextBlock 121 "Hello There"

Page Page number to draw the shape on (start­
ing from page 1).

Left Left horizontal position in ruler or
micropoints.

Top Top vertical position in ruler or
micropoints.

Text The text to go into the text block (up to 31
characters).
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No

Names

Don't show section names in the list.
Format

Indented

Indent

Change the section names option. Choose
one of the following:
Yes Show section names in endnote list.
No

Change the endnote title option. Choose
one of the following:
Yes Include the endnote title when

creating the endnote section.
Do not include the title.

Change the indenting format. Choose one
of the following:
FlushLeft
FlushHang

EditBibliography
Present the edit bibliography requester.

EditBody
Switch to edit the document's body pages.
See also EditLeftMaster, EditRightMaster.

EditEndNotes
Present the edit endnotes requester.

EditlndexList
Present the edit index requester.

EditLeftMaster
Switch to edit the document’s left master page.
See also EditBody, EditRightMaster.

EditRightMaster
Switch to edit the document’s right master page.
See also EditBody, EditLeftMaster.

EndNotePrefs “Title/K,Names/K,Format/K,lndent/K,Marker/K’
Change the endnote section creation settings.

Title

Lincs even with left margin.
First line even with left
margin, subsequent lines
indented.
First line indented, subse
quent lines even with left
margin.

Amount to indent in ruler or micropoints
(.125 to 5 inches).
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Marker Change tlic marker style. Choose one of
the following:
Superscript Superscript the endnote

markers.
Normal Don't superscript markers.

Examples:
EndNotePrefs TITLE Yes NAMES No FORMAT In­

dented INDENT .5 MARKER Normal
EndNotePrefs INDENT .25

Extract
Get the text of a selected range or the next character into
Result. If there is a selected range, the text of the range is
placed into Result. Paragraphs will be separated by a newline
character (ASCII 10 or OxOA). If a range is not selected, the
character after the insertion point will be placed into Result. If
the insertion point is at the end of a paragraph, a newline
character will be returned.

Find “String/F”
If the find requester is not open, then present the find re­
quester. If the String parameter is given, then open the re­
quester with the given text string. If the find requester is already
open, then search for the given string.
See also FindNext, SetFind.
String The text String to search for.

Examples:
Find
Find "Final Writer"

FindCursor
Scroll the document to the location of the insertion point.

FindNext
Find the next occurrence of the text string specified in the Find
requester (The find requester must be open).
See also Find, SetFind.

FindReplace
Present the Find/Replace requester.

FirstObject “SELECTED/S”
Return in Result the object ID of the first graphic object. If there
are no graphic objects, then Result will be set to 0. If SELECTED
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is specified then Result will be set to the ID of the first selected
object.
See also Currentobject, NcxtObject.

Examples:
FirstObject
FirStObject SELECTED

Font “FontName/F”
Present the font requester to change to a different font or skip
the requester by specifying a font to change to.
FontName If a font name is specified, change to this

font without the font requester. The
fontname can be just the font name or it
can be a full font path name. If there is not
a path name, then the font is looked for in
the FWFonts/SWOLFonts drawer.

Examples:
Font
Font "SoftSans_BoldItalic"
Font "Work:SoftFaces/Rageltalic"

FontColor “ColorName/F”
Present the font color requester to change the font color.
ColorName If specified, change the font color to

ColorName without the requester.

Examples:
Fontcolor
Fontcolor Red
FontColor Black

Fontsize “Pointsize”
Present the font size requester to change the font size.
PointSize If specified, change the font size to

PointSize without the requester.

Examples:
Fontsize
Fontsize 24
Fontsize 10

GetASCIIPrefs “ParaNewLine/S,ParaBlankLine/
S,lnsertNewLine/S,lnsertBlankLine/S"
Return in Result the specified ASCII I/O preference settings.
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See the ASCIIPrefs command for the values returned.
Examples:
GetASCIIPrefS PARANEWLINE INSERTNEWLINE

might return "Yes No”.
GetBibPrefs “Title/S,lndent/S”

Return in Result the specified bibliography creation preferences.
Sec the BibPrefs command for the values returned.
Examples:
GetBibPrefs TITLE INDENT

might return “Yes 0.5".

GetBoxPrefs “TextFlow/S,FlowDist/S,LineWt/S,LineColor/
S,Fill/S,FillColor/S”
Return in Result the specified box drawing preferences.
See the BoxPrefs command for the values returned.
Examples:
GetBoxPrefs LINEWT LINECOLOR FILL FILLCOLOR

might return "2 Black Solid Red"
GetDisplayPrefs “Horizontal/S,Vertical/S,Guides/S,Rulers/

S,Measure/S,Shading/S,WBDocColor/S”
Return in Result the specified display preferences.
See the DisplayPrefs command for the values returned.

Examples:
GetDisplayPrefs HORIZONTAL VERTICAL

might return "SO 72".
GetDisplayPrefs GUIDES

might return "PEH".
GetDocColorPrefs “ColorName/A”

Get the red green blue (RGB) color values for the named
document color.
ColorName Name of the document color to get the

RGB values for.

Examples:
GetDocColorPrefs Black

might return "0 0 0".
GetDocColorPrefs White

might return "15 15 15".
GetDocColorPrefs Brown

might return "10 5 2".
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GetDocItemPrefs “Tabs/S,Decimal/S,DateFormat/S,DateOrder/
S,TimeFormat/S”
Return in Result the specified document item preferences.
Sec the DocItemPrefs command for the values returned.

Examples:
GetDocItemPrefs DATEFORMAT DATEORDER

TIMEFORMAT
might return “2 MDY 24”.

GetDraftPrefs “Top/S,Bottom/S,Left/S,Right/S,First/
S,LinesPerPage/S,Pitch/S,Quality/S,Spacing/S”
Return in Result the specified draft print preferences.
See the DraftPrintPrefs command for the values returned.

Examples:
GetDraftPrefs TOP BOTTOM LEFT RIGHT

might return “6 6 10 70”.
GetDraftPrefs PITCH QUALITY SPACING

might return “Pica Letter Eight".
GetEndNotePrefs “Title/S,Names/S,Format/S,Indent/S,Marker/

S”
Return in Result the specified endnote creation preferences.
See the EndNotePrefs command for the values returned.

Examples:
GetEndNotePrefs FORMAT MARKER

might return “FlushHang Superscript”.
GetEndNotePrefs INDENT

might return “0.25”.
GetGfxPrintPrefs “Density/S,Threshold/S,ColorCorrect/

S,Dithering/S,Shading/S”
Return in Result the specified graphics print preferences.
See the GfxPrintPrefs command for the values returned.
Examples:
GetGfxPrintPrefs DENSITY THRESHOLD

might return “4 12”.
GetGfxPrintPrefs COLORCORRECT SHADING

might return “GB Color".
GetlmportPrefs “TextFlow/S,FlowDist/S,LineWt/S,LineColor/

S,Fill/S,Linked/S,Display/S”
Return in Result the specified graphic import preferences.
See the ImportPrefs command for the values returned.
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Examples:
GetlmportPrefS TEXTFLOW FLOWDIST LINEWT

LINECOLOR
might return "LeftVert .25 2 Black".

GetlmportPrefs FILL LINECOLOR
might return "Transparent Blue".

GetlndexList “Separator”
Get a list of all the index entries into Result.

Separator Specifies a character to separate the index
entries. If not specified, the entries will be
separated with a newline character (Deci­
mal 10, I lex OxOA).

Examples:
GetlndexList

Retrieve the index list each entry separated by a newline.
GetlndexList ”#"

Each entry separated by the number sign character.
GetlndexList D2C(9)

Each entry' separated by a tab. (D2C is an internal ARexx
function which converts a decimal number to a character.
Tab is decimal 9.)

GetlndexPrefs “Title/S,Headers/S”
Return in Result the specified index creation preferences.
See the IndexPrefs command for the values returned.

Examples:
GetlndexPrefs TITLE HEADERS

might return "Yes No".
GetLinePrefs “TextFlow/S,FlowDist/S,LineWt/S,LineColor/S”

Return in Result the specified line drawing preferences.
See the I.inePrefs command for the values returned.

Examples:
GetLinePrefs TEXTFLOW FLOWDIST LINECOLOR

might return "LeftVert .25 Black".
GetObjectCoords “Objectld”

Return in Result the coordinates for the current or a specific
graphic object. The coordinates are returned as a string with the
format: “Page Left Top W idth I leight" for boxes. ovals. images,
and text blocks. For lines the format is: "Page XI Y1 X2 Y2”.
The coordinates will be in ruler or micropoints. The object
specified will become the current object.

13 - 24 ARexx Support



Objectld Object ID for the object to get coordinates
for. If Objectld is not specified or is 0, then
the command will return the parameters
for the current object.

Examples:
GetObjectCoords

might return “1 2 2 5 4".
GetObjectCoords 4

might return “3 1 3 1 5 2.75".
GetObjectParams “Objectld/A,TextFlow/S,FlowDist/S,LineWt/

S,LineColor/S,Fill/S,FillColor/S,Linked/S,Display/S”
Return in Result the requested parameters for the current or a
specific object. The object will become the current object. (Not
available for group objects.)
See the SetObjectParams command for the values returned.
Objectld Object ID for the object to get parameters

for. If Objectld is 0, then the command will
return the parameters for the current
object.

Examples:
GetObjectParams 0 LINEWT LINECOLOR FILL

FILLCOLOR
might return “4 Blue Solid Red".

GetObjectParams 4 TEXTFLOW LINKED
might return “LeftVert No".

GetObjectRotation “Objectld”
Return in ' Result" the rotation of the specified graphic object.
Objectld The ID of the graphic object to get the

rotation of. If Objectld is not specified or is
0, then return the rotation for the current
object. The object specified will become
the current object.

Examples:
GetObjectRotation 4

GetObjectTitle “Objectld”
Return in Result the title of the specified graphic object. The
object will become the current object.

Objectld The ID of the object to get the title of. If
Objectld is not specified or is 0, then the 
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command will return the title for the
current object.

Examples:
GetObjectTitle
GetObjectTitle 4

GetObjectType “Objectld”
Return in Result the type of the specified graphic object. The
object will become the current object.
Objectld The object ID of the graphic to get the type

of. If not specified or is 0, then the com­
mand will return the type for the current
object. The object specified by Objectld
will become the current object.

The possible return values are as follows:
1 - The object is an Imported Graphic I-ile i.e. 1I.BM or EPS.
2 - The object is a Line.
3 - The object is an Arrow tipped line.
•i - The object is a Box.
5 - The object is a Beveled Box.
6 - The object is an Oval.
7 - The object is a Text Block.
8 - The object is a Group of other objects.

Examples:
GetObjectType 0
GetObjectType 8

GetObjectTypeSpecs “ObjectId/A,Size/S,Leading/S,Width/
S,Oblique/S,Position/S,Case/S,Style/S,Color/S,Font/S”
Return in Result the specified text block type specifications for a
text block object. The object will be come the current object.
See the TextBlockTypePrefs command for the values returned.

Objectld The ID of the object to get type specs for.
If 0. then get the current object.

Examples:
GetObjectTypeSpecs 0 SIZE WIDTH COLOR

might return "12 100 Black".
GetObjectTypeSpecs 4 SIZE FONT

might return "2-i Work:PSFonts, Courier".
GetOutlinePrefs “Title/S,Format/S,lndent/S”

Return in Result the specified outline creation preferences.
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Sec the OutlinePrefs command for the values returned.
Examples:

GetOutlinePrefs TITLE FORMAT INDENT
might return "Yes Roman 0.5”.

GetOvalPrefs “TextFlow/S,FlowDist/S,LineWt/S,LineColor/
S,Fill/S,FillColor/S”
Return in Result the specified oval drawing preferences.
Sec the BoxPrcfs command for the values returned.

Examples:
OvalPrefs LINEWT LINECOLOR FILL FILLCOLOR

might return “2 Black Solid Red".
GetPageSetup “PageType/S,Width/S,Height/S,Orient/S,Pages/

S,PrinterType/S,Top/S,Bottom/S,Left/S,Right/S,Number/
S,FirstPage/S”
Return in Result the specified page setup preferences.
See the PageSetup command for the values returned.

Examples:
GetPageSetup WIDTH HEIGHT

might return "8.5 11.0”.
GetPageSetup TOP BOTTOM LEFT RIGHT

might return “0.1875 .375 .25 .25”.
GetPrintSetup “Copies/S,Section/S,Pages/S,FromPage/

S,ToPage/S,Collate/S,Order/S,PrintTo/S,Feed/S”
Return in Result the specified print preferences.
See the PrintSetup command for the values returned.
Examples:
GetPrintSetup COLLATE ORDER PRINTTO FEED

might return “All FrontToBack PSFile SingleSheet".
GetPrintSetup COPIES PAGES FROMPAGE TOPAGE

might return “4 Range 5 10”.
GetPSPrintPrefs “Port/S,Shade/S,Download/S,Halftone/S,LPI/

S,Angle/S,Spot/S,Thumbnails/S,Scale/S,CropMarks/
S,PageType/S,CustomWidth/S,CustomHeight/S,Orient/S”
Return in Result the specified postscript print preferences.
See the PSPrintPrefs command for the values returned.
Examples:
GetPostPrefs PORT

might return "Serial".
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GetPostPrefs HALFTONE LPI ANGLE SPOT
might return “Custom 60 45 RoundDot".

GetSectionList “Seperator”
Return in Result a list of the document’s section names.

Separator Specifies a character to separate the section
names. If not specified, then the entries
will be separated with a newline character
(Decimal 10, Ilex OxOA).

GetSectionSetup “Section/K,Name/S,Top/S,Bottom/S,Inside/
S,Outside/S,PagePrefix/S,FirstPage/S,PageNumFormat/
S,Columns/S,ColumnGap/S,Header/S,Footer/S"
Return in Result the specified section preferences.

Section 'I he name of the section to get info for. If
Section is not specified, then information is
returned for the current section.

Name The name of the section.
See the SectionSetup command for other values returned.
Examples:
GetSectionSetup NAME PAGENUMFORMAT

might return “Index Romanl'pper".
GetSectionSetup TOP BOTTOM INSIDE OUTSIDE

might return "1.0 1.0 0.5 0.5”.
GetTextBlockPrefs “TextFlow/S,FlowDist/S,Text/S”

Return in Result the specified text block drawing preferences.
See (lie TextBlockPrefs command for the values returned.

Examples:
GetTextBlockPrefs TEXT

might return “Hello World".
GetTextBlockText “Objectld”

Return in Result the text of the specified text block.
The object will become the current object.

Objectld The ID of the object to get the text of. If
Objectld is not specified or is 0, then get
the text of the current object.

Examples:
GetTextBlockText 2

might return "Hello World".
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GetTextBlockTypePrefs “Size/S,Leading/S,Width/S,Oblique/
S,Position/S,Case/S,Style/S,Color/S,Font/S”
Return in Result the specified text block type preferences.
See the TextBlockTypePrefs command for the values returned.
Examples:
GetTextBlockTypePrefs SIZE WIDTH COLOR

might return “12 100 Red”.
GetTextBlockTypePrefs SIZE COLOR FONT

might return “24 Black Work:FWFonts/SWOLFonts/
SoftSans”.

GetTOCPrefs “Title/S,Level/S”
Return in Result the specified table of contents creation prefer­
ences.
See the TOCPrefs command for the values returned.

Examples:
GetTOCPrefs TITLE LEVEL

might return “Yes 2”.

GetTOIPrefs “Title/S,BlankLine/S,Names/S”
Return in Result the specified table of illustrations creation
preferences.
See the TOIPrefs command for the values returned.
Examples:
GetTOIPrefs TITLE BLANKLINE NAMES

might return “Yes No Yes".
GfxPrintPrefs “Density/K,Threshold/K,ColorCorrect/

K,Dithering/K,Shading/K”
Change the graphic print preferences.
Density Print density 1-7
Threshold Print threshold 1-14
ColorCorrect Color correction mode. Combination of the

letters R, G, and B. Specify R for red, B for
Blue, and G for Green correction. Specify"
any other character to turn Red, Green, and
Blue all off. For example “RGB”, “GB", "B",
etc., to turn on color corrections or "X" to
clear all color corrections.
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Dithering Change the dithering method. Choose one
of the following:
Ordered Use ordered dithering.
Halftone Use halftone dithering.

Shading Change the shading mode. Choose one of
the following:
BlackWhite Print in black and white.
GreyScale Print in grey scale.
Color Print in color.

amples:
GfxPrlntPrefs
GfxPrxntPre f s

DENSITY 4 THRESHOLD 5
COLORCORRECT RB SHADING Color

GoToPage“Page”
Scroll the document to another page. Note: this does not
change the location of the insertion point, it just changes which
page is in view.
Page Scroll the document to this page. If page is

not specified, then present the "Go To
Page" requester.

Examples:
GoToPage
GoToPage 5

GoToSection “SectionName/A/F”
Switch to another existing section in the document.
SectionName The name of the section to switch to.

Examples:
GoToSection Index

GraphicTool
Make the graphic select tool the current tool. The graphic tool
must be the current tool to perform Cut. Copy, and Clear
commands with graphic objects. The current selected graphic
objects will not be deselected.
See also TextTool.

Group
Put all selected objects into a group. All objects in the group
will act as a single graphic object. The group will become the
current object.
See also Ungroup.
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HotZone “Zone/A”
Change the hyphenation zone for the current or selected
paragraphs.

Zone Hyphenation hot zone specified in ruler or
micropoints.

Examples:
HotZone 0.5

Hyphen “Status”
Turn hyphenation on or off for the current or selected para­
graphs.
Status The hyphenation status. If not specified,

then hyphenation is turned on. Choose on
of the following:
On Turn hyphenation on.
Off Turn hyphenation off.

Examples:
Hyphen
Hyphen OFF

ImportPrefs “TextFlow/K,FlowDist/K,LineWt/K,LineColor/
K,Fill/K,Linked/K,Display/K,PROMPT/S”
Change the graphic import preferences.
TextFlow Change the text flow option. Choose one

of the following:
LeftVert Set to left vertical.
LeftCont Set to left contour.
RightVert Set to right vertical.
RightCont Set to right contour.
None Set to no textflow.

FlowDist Change the flow distance between graphic
and text, specified in niler or micropoints
(0.025 - 2.0 inches).

LineWt Change the border weight. Choose one of
the following:
None, Hairline, .5,1,2,4, 6, 8,10,12

LineColor Change the border color to a color speci­
fied by a color name.

ARexx Support 13-31

AR
exx Support



Fill Change the fill (background) option.
Choose one of the following:
Solid
Transparent

Linked Change the Save/Link option. Choose one
of the following:
Yes Save the entire image with the

document.
No Save a link (filename) to the image

with the document.
Display Change the display option. Choose one of

the following:
Crossbox Display a crossbox.
Preview Display a preview.
Full Display the full image.

PROMPT Present the import graphic preferences
requester ignoring all other arguments.

Examples:
ImportPrefs

LINEWT 2
ImportPrefs
ImportPrefs

TEXTFLOW LeftVert FLOWDIST .25
LINECOLOR Black
FILL Transparent LINECOLOR Blue
PROMPT

Indent “Indent/A”
Change the paragraph indent for the current or selected paragraphs.

Indent Change the paragraph indent, specified in
ruler or micropoints.

Examples:
Indent 0.25
Indent 1.25

IndentLeft
Move the first and left margins of the current or selected
paragraphs to the left by the amount of the default tab setting.
See also IndentRight.

IndentRight
Move the first and left margins of the current or selected
paragraphs to the right by the amount of the default tab setting.
See also IndentLeft.

IndexPrefs “Title/K,Headers/K”
Change the index creation preferences.
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Title Change the index title option. Choose one
of the following:
Yes Include the index title when creating

the index.
No Do not include the index title.

Headers Change the index letter header option.
Choose one of the following:
Yes Include letter headers when creating

the index.
No Do not include the letter headers.

Examples:
IndexPrefs TITLE No
IndexPrefs TITLE Yes HEADERS No

Insert “Item/A”
Insert a special item into the document.

Item The item to insert. Choose one of the
following:
Date Insert an auto date string.
Time Insert an auto time string.
PageNumber Insert an auto page number

(Must he editing a master
page.)

MergeField Insert a merge field w/
requester.

Graphic Import a graphic image
using the "Import Image"
requester.

Examples:
Insert Date
Insert PageNumber

InsertEndNote
Present requester to insert a new endnote and marker at the
insertion point.

Insertimage “Filename/A, POSITION/S, Page, Left, Top, Width,
Height, LINKED/S”
Import a graphic image into the document by passing the
import requester. Result will contain the object ID of the image.
The image will become the current object. Use the Redraw
command to draw the image and reformat any text.
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See also ‘Insert Graphic’ command.

Filename Complete path name of the image file.

POSITION Optional switch parameter that indicates
that the following five position and size
parameters arc present. If not specified,
then the program will determine the size
and position of the image.

Page Page number to place the image on
(starting from page 1).

Left Location of the left edge of the image in
ruler or micropoints. If -1, the program will
determine the left edge.

Top Location of the top edge of the image in
ruler or micropoints. If-1, the program will
determine the top edge.

Width Width of the image in ruler or micropoints.
If-1, the program will determine the width.

Height Height of the image in ruler or
micropoints. If-1. the program will deter­
mine the height.

LINKED if specified, a link to the image will be
saved with the file instead of the image
data.

Examples:
Insertimage "Work:Bunny" POSITION 2 1.0 3.0 "-

will insert the image on page 2 with left edge at 1 inch, top
edge at 3 inches and width and height determined by the
program.

Insertlmage "Work:Bunny"
will insert the image with the program determining the size
and position of the image.

InsertPageBreak
Insert a page break at the insertion point.
See also RemovePageBreak.

Justify “Mode/A"
Change the paragraph justification for the current or selected
paragraphs.
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Mode The type of justification. Choose one of the
following:
Left Set to Left justify.
Right Set to Right justify.
Center Set to Center justify'.
Full Set to Full justify.

Examples:
Justify Left

Leading “Leading”
Change the font leading value.
Leading Leading value in points (from 4 to 255). If

not specified, then present the font leading
requester.

Examples:
Leading 24

LeftMargin “Margin/A”
Change the left margin of the current or selected paragraphs.

Margin Value to set the left margin to in ruler or
micropoints.

Examples:
Le ftMargin .125
LeftMargin 1.25

LinePrefs “TextFlow/K,FlowDist/K,LineWt/K,LineColor/
K,PROMPT/S”
Change the line drawing preferences.

TextFlow Change the text flow option. Choose one
of the following:
LeftVert Set text flow to left vertical.
LeftCont Set text flow to left contour.
RightVert Set text flow to right vertical.
RightCont Set to right contour.
None Set to no text flow.

FlowDist Change the flow distance between line and
text, specified in ruler or micropoints
(0.025 - 2.0 inches).

LineWt Change the line weight. Choose one of the
following:
None, Hairline, .5,1,2,4,6, 8,10,12
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LineColor Change the line color to a color specified
by a color name.

PROMPT Present the line settings requester ignoring
all other arguments.

Examples:
LinePrefs PROMPT
LinePrefs LINECOLOR Blue
LinePrefs TEXTFLOW None FLOWDIST .25 LINEWT 2

Lock
Lock the selected graphic objects in place.
See also Unlock.

MoveToLine “Line/A,Pos/A”
Move the insertion point to a line and position within the line.
If the Si llin'status is down, then the text will be selected.
See also ShiftDown, Shiftlip, Cursor, MoveToPara.
Line Line number to move to (starting with 1).

Pos Offset into the line (0 is at the beginning of
the line).

Examples:
MoveToLine 1 0

moves the insertion point to the beginning of the docu­
ment.

MoveToLine 5 10
moves the insertion point to offset 10 of the 5th line.

MoveToPara “Para/A,Pos/A”
Move the insertion point to a paragraph and position within the
paragraph. If the SHUT status is down, text will be selected.
See also ShiftDown. ShiftL’p. Cursor. MoveToLine.
Para Paragraph number to move to (starting

with 1).
Pos Offset into the paragraph (0 is at the

beginning of the paragraph).

Examples:
MoveToPara 1 0

moves the insertion point to the beginning of the first
paragraph.

MoveToPara 5 10
moves the insertion point to offset 10 of the 5th paragraph.
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MoveWindow “Left/A,Top/A”
Move the document's window to a new location on the screen.

New

Left Absolute screen pixel of the left edge of
the window.

Top Absolute screen pixel of the top edge of
the window.

Examples:
Movewindow 100 50

Create a new document window.

NewParagraph
Create a new paragraph at the insertion point. This is the same
as pressing the RETURN key from the keyboard.

NewSection “Type/A,Name/K,BEFORE/S,AFTER/S"
Create a new section. Only one section of each type may be
created except for the Text section type which may have many
sections.

If neither the BEFORE or AFTER switch is specified the newtext
section will be place at the end of the text sections.

Type The type of section to create. Choose one
of the following:
Outline
TitlePage
Preface
Contents
Illustrations
Text
Endnotes
Bibliography
Index

Name The name for the new section. If not
specified, use the default name. The length
of the name must be between 1 and 31
characters.

BEFORE Place the new text section after the current
section.

AFTER Place the new text section before the
current section.
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Examples:
NewSection Index
NewSection Text '"Chapter 2'"

NextObject “Objectld,SELECTED/S”
Return in Result the object ID of the next graphic object.
See also FirstObject, Current Object.

Objectld Get the ID of the object that follows the
object with this ID. If Objectld is not
specified or is 0, then the object ID of the
object following the current object is
returned. If there are no graphic objects
after the specified object, then Result will
be set to ().

SELECTED If specified, then the command will set
Result to the ID of the next selected object.

Examples:
NextObject 2

might return 8.
NextObject 4 SELECTED

might return 10.
ObjectToBack “Objectld”

Send a graphic object behind all others. The object will become
the current object. Use the Redraw command to redraw the
object.
See also ObjectToFront.

Objectld The ID of the graphic object to send to the
back. If an Objectld is not specified or is 0.
send the current object to the back.

Examples:
ObjectToBack 8

ObjectToFront “Objectld”
Bring a graphic object to the front of all others. The object will
become the current object. Use the Redraw command to redraw
the object.
See also ObjectToBack.

Objectld The Object id of the graphic object to bring
to the front. If an Objectld is not specified
or is 0. bring the current object to the front.

Examples:
ObjectToFront 4
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Oblique “Percent”
Change the text oblique angle.

Percent Oblique percent value -20 through 20. If
not specified, present the oblique re­
quester.

Examples:
Oblique
Oblique 5

Open “File/F”
Open a document file.

File The complete path name of the file to
open. If a file is not specified, present the
file requester to open a document file.

Examples:
Open
Open "Work:FWDocs/Monthly Report"

OutlinePrefs “Title/K,Format/K,lndent/K”
Change the outline creation settings.

Title Change the outline title option. Choose
one of the following:
Yes Include the outline title when

creating the index.
No Do not include the outline title.

Format Change the outline numbering format
option. Choose one of the following:
Roman Number the highest level with

Roman numbers.
Alpha Number the highest level with

Alphabetic characters.
Indent Set the Indent specification in ruler or

micropoints (.125 - 5 inches).
OvalPrefs “TextFlow/K,FlowDist/K,LineWt/K,LineColor/K,Fill/

K,FillColor/K,PROMPT/S”
Change the oval drawing preferences. See the BoxPrefs com­
mand for parameters values and meanings.
Examples:
OvalPrefs LINEWT 2 LINECOLOR Black FILL Solid

FILLCOLOR Red
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OvalPrefs TEXTFLOW RightVert
OvalPrefs PROMPT

PageSetup “PageType/K,Width/K,Height/K,Orient/K,Pages/
K,PrinterType/K,Top/K,Bottom/K,Left/K,Right/K,Number/
K,FirstPage/K,PROMPT/S”
Change the page setup options.
PageType

Width

Height

Orient

Pages

PrinterType

Top

13 - 40 ARexx Support

Change the page type. Choose one of the
following:
USLetter Use US Letter paper size.
USLegal Use US l.egal paper size.
A3 Use A3 paper size.
A4 Use Al paper size.
A5 Use AS paper size.
B5 Use B5 paper size.
Custom Use a custom page size.
Change the custom page width. This value
is ignored unless a page type of custom is
specified or the page type is already set to
Custom.
Change the custom page height. This value
is ignored unless a page type of custom is
specified or the page type is already set to
Custom.
Change the page orientation. Choose one
of the following:
Tall Set the orientation to tall.
Wide Set the orientation to wide.
Change pages to be right only or left and
right.
RightOnly Use right pages only.
LeftRight Use left/right pages.

Choose one of the Print area's printer
types:
Laser
DeskJet
Sheetfed
Continuous
Other

Change the print area's top margin, speci­
fied in ruler or micropoints.



Bottom

Left

Right

Number

FirstPage
PROMPT

Change the print area's bottom margin,
specified in ruler or micropoints.

Change the print area's left margin, speci­
fied in ruler or micropoints.

Change the print area’s right margin,
specified in ruler or micropoints.

Number the document page using one of
the following:
ByDocument Number by document.
BySection Number by section.

Change the document's first page number.

If specified, then presents the page setup
requester ignoring all other arguments.

Examples:
PageSetup PROMPT
PageSetup PAGETYPE USLetter ORIENT TALL
PageSetup TOP .1875 BOTTOM .375 LEFT .25 RIGHT

.25
Paragraph

Present the paragraph settings requester.

Paste
Paste text or graphic data on the clipboard into the document.
See also Cut, Copy, Clear.

PasteRuler
Change the ruler settings of the current or selected paragraphs
to the ruler settings from the previous CopyRuler operation.
See also CopyRuler.

Position “Script/A”
Change the font script.
Script The script to change to. Choose one of the

following:
Normal
SuperScript
SubScript

Examples:
Position Normal
Position Subscript
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PostScriptFile “File/A/F”
Change the file name for printing to a PostScript file.
File The path name for the PostScript file.
Examples:
PostScriptFile "WorkxPSPrint"
PostScriptFile "Rad:Report.PS"

Preferences “Pref/A”
Present a preferences requester.
Pref Which requester to present. Choose one of

the following:
UserMenu User Menu.
Buttonstrip User Button Strip.
Display Display.
ASCII ASCII I/O.
Startup Startup.
Speller Speller & hyphenation.
Hyphenation Speller C4 hyphenation.
Document Document Item.
Colors Document Colors.
ScreenColors Screen Colors.
DocumentSave Document Save.

Examples:
Preferences Display-
Preferences Speller

Print “PROMPT/S”
Print using the current print settings and by-passing the print
requester.
PROMPT If specified, then the print requester will be

presented before printing.

Examples:
Print
Print PROMPT

PrintSetup “Copies/K,Section/K,Pages/K,FromPage/K,ToPage/
K,Collate/K,Order/K,PrintTo/K,Feed/K”
Change the current print settings.

Copies Change the number of copies to be
printed.

Section Change which section to print. Specify the
section name or "All" to print all sections.
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Pages Change the range of pages to print. Choose
one of the following:
All Print all pages.
Range Print a range of pages from

FromPage to ToPage.

FromPage When range is chosen start printing from
this page.

ToPage When range is chosen the last page to
print.

Collate Change the collating method. Choose one
of the following:
All Print all pages.
OddOnly Print only odd numbered

pages.
EvenOnly Print only even numbered

pages.

Order Change the order to print the pages.
Choose one of the following:
FrontToBack Print pages from front to

back.
BackToFront Print pages from back to

front.

PrintTo Change the type of printer to print to.
Choose one of the following:
GfxPrinter Print to a graphic printer in

Final Mode.
DraftPrinter Print to a graphic printer in

Draft Mode.
PSPrinter Print to a PostScript printer.
PSFile Print to a PostScript file.

Feed Change the printer’s paper feed type.
Choose one of the following:
Continuous Printer is using continuous

(tractor) feed.
SingleSheet Printer is using single sheet

feed.

Examples:
PrintSetup COPIES 3 SECTION All PRINTTO

GFXPRINTER
will setup to print 3 copies of all sections to a graphics
printer.
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Printsetup ORDER BackToFront
will setup to print the pages in reverse order,

PSPrintPrefs “Port/K,Shade/K,Download/K,Halftone/K,LPI/
K,Angle/K,Spot/K,Thumbnails/K,Scale/K,CropMarks/
K,PageType/K,CustomWidth/K,CustomHeight/K,Orient/K”
Change the PostScript print preferences.

Port

Shade

Download

Halftone

LPI

Angle

Spot

Thumbnails

Scale

CropMarks

Change the port the print is connected to.
Choose one of the following:
Parallel, Serial

Change the print shading. Choose one of
the following:
GreyScale. Color
Change when to download fonts. Choose
one of the following:
OneTime Download a font only once.
EveryTime Download a font everytime

the font is used.
Change the halftoning method. Choose one
of the following:
Default l’se the default halftone method.
Custom I’se a custom halftone method.

Change the custom halftone lines per inch.
Value from 1 to 200.
Change the custom halftone screen angle.
Value from -560 to 360.
Change the custom halftone spot function.
Choose one of the following:
Line L’se a line spot function.
RoundDot L’se a round dot function.

Change the number of thumbnails to print.
0,1 Print normal (no thumbnails).
2-16 Number of thumbnails to print per

page.
Change the scaling percentage. Value from
1 to 100.
Change the crop marks. Choose one of the
following:
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Yes Print crop marks.
No Don’t print crop marks.

PageType Change the page type. Choose one of the
following:
USLetter, USLegal, A3, A4, A5, B5,
Custom

CustomWidth

CustomHeight
Orient

Width of a custom page size.
Height of a custom page size.

Change the page orientation. Choose one
of the following:
Tall Use portrait mode.
Wide Use landscape mode.

Examples:
PSPrintPrefs HALFTONE Custom LPI 75 ANGLE 30

SPOT Line
PSPrintPrefs PORT Parallel SHADE GreyScale

ORIENT Wide
Quit “FORCE/S”

Close all windows and quit the program prompting to save
changes.
FORCE Close all documents and quit the program

no questions asked.
Examples:
Quit
Quit FORCE

Redraw
Reformat and redraw the document. This command must be
used to reformat and redraw the document after a series of
graphic commands are given to create and/or change graphic
objects. Most of the graphic commands do not update or draw
the screen themselves. This is to improve the performance of
doing several graphic operations in a row.

RemovePageBreak
Remove a page break from the current paragraph.

RemoveSection “Name/A,FORCE/S”
Remove a section from the document.
Name The name of the section to remove.
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FORCE Specify to by-pass confirming requesters.

Examples:
Removesection Index
Removesection Outline FORCE
Removesection '"Chapter Two"'

Two sets of quotes are used because of the space in the
section name.

RequestText “Title/A,Prompt/A,Default/F”
Present a string gadget to request information from the user.
Return in Result the text that is entered into the requester.
See also ShowMessage.
Title This string will appear in the requester's

title bar.
Prompt This string will appear above the string

gadget.
Default This string will he the initial default string

in string gadget.

Examples:
RequestText '"Font Size" "Points" "12"'
RequestText '"Favorite Color" "What is your

favorite color?" "Green"'
RightMargin “Margin/A”

Change the right margin of the current or selected paragraphs.
Margin Value to set the right margin to in ruler or

micropoints.

Examples:
RightMargin .125
RightMargin 1.25

Save “ASCII/S,Filename/F”
Save the document to a disk file.
ASCII If specified and a filename is given, then

the document will be saved as an ASCII
file. This switch is IGNORED if no filename
is given. If specified. ASCII must be the
first argument.

Filename If filename is NOT given, then save the file
to the current name or present the file
requester if the file has not yet been saved.
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If a filename IS given, then save the
document to that filename. Filename
should be a complete path name. If a file
with Filename already exists, then this
command will save the document over the
existing file without any warning.

Examples:
Save
Save ASCII "radzMonthlyReport"
Save "WorkzFWDocs/MonthlyReport"

SaveAs
Present the file requester to save a document to a new file.

ScreenToBack
Send the screen behind all others screens.

ScreenToFront
Bring the screen in front of all other screens.

SectionSetup “Name/K,NewName/K,Top/K,Bottom/K,Inside/
K,Outside/K,PagePrefix/K,FirstPage/K,PageNumFormat/
K,Columns/K,ColumnGap/K,Header/K,Footer/K, PROMPT/
S”
Change the section setup settings.
Name The section name of the section to change.

If not specified, then the change will be for
the current section.

PageNumFormat Set the page number format. Choose one
of the following:
Normal Normal numbers (1 2 3).

NewName A new name for the section (no more than
31 characters).

Top Set the edit area top.

Bottom Set the edit area bottom.

Inside Set the edit area inside.

Outside Set the edit area outside.

PagePrefix Set the page number prefix (no more than
8 characters).

FirstPage Set the first page number.
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RomanUpper Upper case Roman
numerals (I II III).

RomanLower Lower case Roman
numerals (i ii iii).

AlphaUpper Upper case alphabetic
characters (A B C).

AlphaLower Lower case alphabetic
characters (a b c).

Columns Set the number of columns (1-6).
ColumnGap
Header

Set the column gap.
Set the header margin.

Footer Set the footer margin.
PROMPT Specify to present the section setup

requester (all other arguments ignored).
Examples
SectlonSetup

.5
TOP 1 BOTTOM .5 INSIDE .5 OUTSIDE

Changes the current section's edit areas.
sectionsetup NAME Index COLUMNS 3

Changes the section “Index" to have 3 columns.

SelectAII
Select all the text in the section being edited.

SelectObject “Objectld,MULTIPLE/S”
Select (or deselect) graphic objects.

Objectld Deselect any selected objects and select the
object specified by Objectld. The object
will become the current object. If Objectld
is not specified or is 0, then all graphic
objects will be deselected.

MULTIPLE If specified, then the graphic object will be
selected along with any other selected
objects as a multiple selection.

Examples:
Selectobject

deselect all graphic objects.
SelectObject 4

select object with ID of I.
SelectObject 8 MULTIPLE

select object with ID of S along with other selected objects.
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SetFind “Case/K, Wrap/K”
Set various option for the “Find” requester.
Case

Same Characters must be the same
case to match.

Ignore Ignore character case during the
search.

Wrap
Yes Wrap to the top of the document

after coming to the end.
No Stop at the end of the document.

Examples:
SetFind CASE Ignore WRAP No

SetMeasure “Mode/A”
Sets the units in which measurements will be given and re­
turned. The default is set to ruler measurements.

Mode Set the measurement mode. Choose one of
the following:
Micropoints Measurements will be given

and accepted in micropoints.
(720 micropoints = 1 inch)

Ruler Measurements will be given and
accepted in the measurement
system that the rulers are set to,
either inches, centimeters, or
picas.

Examples:
SetMeasure Ruler
SetMeasure Micropoints

SetObjectCoords “Objectld/A,Page/A,Left/A,Top/A,Width/
A,Height/A”
Change the coordinates (size and position) of a graphic object.

Objectld The object ID of the graphic object to
change. The object will become the current
object. If Objectld is 0, then the current
object will be changed.

Page Page to move object to (starting from page
1).

Left (X1) Left edge position in niler or micropoints.
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Examples:
SetObjectCoords 2 1 1.5 2.0 4.0 5.25

(Horizontal coordinate of the beginning
point of a line.)

Top (Y1) Top edge position in ruler or micropoints.
(Vertical coordinate of the beginning point
of a line.)

Width (X2) Width of graphic in ruler or micropoints.
(Horizontal coordinate of the end point of
a line.)

Height (Y2) Height of graphic in ruler or micropoints.
(Vertical coordinate of the end point of a
line.)

2.0 inches width of-i.O inches and height to 5.25 inches.
SetObjectParams “Objectld/A,TextFlow/K,FlowDist/K,LineWt/

K,LineColor/K,Fill/K,FillColor/K,Linked/K,Display/K”
Change the parameters of a graphic object. The object will
become the current object.

set object 2 to page I, left edge at 1.5 inches, top edge al

Objectld Object ID of the graphic object to change.
If Objectld is 0, then change the current
object.

TextFlow Change the text flow option of the object.
Choose one of the following:
LeftVert Set to left vertical.
LeftCont Set to left contour.
RightVert Set to right vertical.
RightCont Set to right contour.
None Set text flow to none.

FlowDist Change the How distance between the
object and text, specified in ruler or
micropoints (0.025 - 2.0 inches).

LineWt Change the line weight of the object.
Choose one of the following:
None, Hairline, .5,1, 2, 4, 6, 8,10,12

LineColor Change the line color of the object to a
color specified by a color name.

Fill Change the fill (background) option. This
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option is ignored for line objects. Choose
one of the following:
Solid Set fill to solid.
Transparent Set fill to transparent.

FillColor Change the fill color of the object to a
color specified by a color name. This
option is ignored for all but box and oval
objects.

Linked Change the Save/Link option. This option
is ignored for all but image files. Choose
one of the following:
Yes Save the graphic image with the

document.
No Save a link (filename) to the image

with the document.
Display Change the display option. This option is

ignored for all but image files. Choose one
of the following:
Crossbox Display a crossbox.
Preview Display a preview.
Full Display the full image.

Examples:
SetObjectParams 0 TEXTFLOW LeftVert
SetObjectParams 0 LINEWT 10 LINECOLOR Red FILL

Solid FILLCOLOR Blue
SetObjectRotation “Objectld/A,Degrees,DELTA/S”

Set the rotation of the selected graphic objects. Note that
imported graphics will not be rotated.
Objectld The ID of the object to rotate. If 0 is

specified, then rotate the current selected
objects. The specified object will become
the current object.

Degrees The angle in degrees to rotate the object
to. (0 to 360 degrees). If the DELTA switch
is specified, this is the number of degrees
to rotate the object from its current rota­
tion. (-360 to 360). If Degrees is not
specified, then present the “Rotate Graphic
To" requester or the “Rotate Graphic"
requester to rotate the object.
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DELTA If specified, then the object will be rotated
from its current rotation.

Examples:
SetObjectRotation 0 45

will rotate current objects to 45 degrees.
SetObjectRotation 4 10 DELTA

will rotate object with ID 4 an additional 10 degrees.

SetObjectTitle "Objectld/A,Title/A/F”
Set an object’s title which will appear in the table of illustra­
tions. The object will become the current object.

Objectld The object ID of graphic object to change.
If 0, use current object.

Title The text to become the new title (up to 32
characters).

Examples:
SetObjectTitle 4 "Monthly Sales Figures"

SetObjectTypeSpecs “Objectld/A,Size/K,Leading/K,  Width/
K,Oblique/K,Position/K,Case/K,Style/K,Color/K,Font/K/F"
Change an object’s type specifications. Currently only valid lor
text block objects.

Objectld The object ID of the object to change. If 0.
change the current object. See
TextBlockTypel’refs for the other com­
mand options. Currently Position. Case,
and Style options have no effect on the
object.

Examples:
SetObjectTypeSpecs 0 SIZE 24 WIDTH 120 COLOR

Blue
SetObjectTypeSpecs 4 SIZE 36 FONT "SoftSerif"
SetObjectTypeSpecs 2 FONT "WorkzTypelFonts/

Bodoni"
SetTab “Position/A,Type/A”

Set a tab stop in the current or selected paragraphs.
Position Position in ruler measurement or

micropoints of the new tab stop.
Type The type of tab stop. Choose one of the

following:
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Left Set a Left Tab.
Right Set a Right Tab.
Center Set a Center Tab.
Decimal Set a Decimal Tab.

Examples:
SetTab 3.75 Left

SetTextBlockText “Objectld/A,Text/A/F”
Set a text block’s text.

Objectld The object ID of the object to change. If 0,
then set text of the current object.

Text The new text for the text block. (Up to 31
characters.)

Examples:
SetTextBlockText 0 "Hello World"

ShiftDown
Used with “Cursor” command. Set SHIFT key status to DOWN.
See also AtlDown, AltUp, CtrlDown, CtrlUp, ShiftUp.

ShiftUp
Used with “Cursor” command. Set SHIFT key status to UP.
See also AltDown, AtlUp, CtrlDown, CtrlUp, ShiftDown.

ShowMessage “DefBut/A,Beep/A,Text1/A,Text2/A,Text3/
A.ButT ext1 /A,ButT ext2/A,ButT ext3/A”
Display a message requester to the user and return a response
in Result. Result will be the number of the button that was
selected. The requester may have up to three text lines and up
to three buttons.
See also RequestText.

Text3 Third line of text or empty string if not

DefBut The default button number starting from
left 1, 2, or 3.

Beep 0 = no beep. 1 = display beep.
Textl First line of text.
Text2 Second line of text or empty string if not

used.

used.
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Text for first button.ButTextl
ButText2 Text for second button or empty string if

not used.
ButText3 Text for third button or empty string if not

used.

Examples:
ShowMessage 1 1 ' "Text Line 1" "Text Line 2"

"Text Line 3" "Butttonl" "Button2" "But­
tons" '

ShowMessage 2 0 '"Do you want to continue" "or
halt the operation?" "" "Continue" "Halt"
ww t

ShowRulers “Mode/A"
Show or hide the document rulers.
Mode Which rulers to display. Choose one ol the

following:
None I lide all rulers.
Top Show only top ruler.
All Show top and left ruler.

Examples:
ShowRulers Top
ShowRulers None

SizeWindow “Width/A,Height/A”
Change the width and height of a document window.
See also ChangeWindow. MoveWindow.
Width Width of the window in absolute screen

pixels.
Height I leight of the window in absolute screen

pixels.

Examples:
SizeWindow 500 300

Sort “Method”
Sort the paragraphs in a selected range.
Method The sort method. If Method is not speci­

fied. then the sort will be from low to high.
Choose one of the following:
LowToHigh Sort from low to high (abc).
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HighToLow Sort from high to low (cbaj.
Examples:
Sort LowToHigh

Spacing “Spacing/A”
Change the line spacing of the current or selected paragraphs.

Spacing The spacing method. Choose one of the
following:
Single Single spacing.
OneHalf One and a half spacing.
Double Double spacing.
Variable Variable - use leading value.

Examples:
Spacing Double

Speller
Present the speller requester.

Statistics
Present the statistics requester.

Status “Option/A,Extra!”
Returns in Result information for various options.
Option What to get status on. See below for a list

of the available options.
Style “Style/A”

Change the font style.
Style Change the font style. Choose one of the

following:
Normal Normal.
Underline
□Underline
StrikeThru

Underlined.
Double underlined.
Strike through.

Examples:
Style Underline
Style Normal

StyleSheet “StyleName/A/F”
Change the style sheet for the current or selected paragraphs or
present the style define requester to define or change a style.

StyleName Change paragraph style to the named style
sheet. If StyleName is “Define", then the
style definition requester will be presented.
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Examples:
Stylesheet Define
Stylesheet "No Style"
StyleSheet "Sub Topic 1"

TextBlockPrefs “TextFlow/K,TextFlow/K,Text/K/F,PROMPT/S”
Set the text block drawing preferences.
TextFlow Change the text How around the text

block. Choose one of the following:
Left Set text flow to left.
Right Set text How to right.
None Set text flow to none.

FlowDist Change the flow distance, specified in ruler
or micropoints (0.025 - 2.0 inches).

Text The text to appear in the text block. (Up to
31 characters.)

PROMPT Present the text block settings requester,
ignoring all other arguments.

Examples:
TextBlockPrefs TEXTFLOW Left TEXT "SoftWood"

TextBlockTypePrefs “Size/K,Leading/K,Width/K,Oblique/
K,Position/K,Case/K,Style/K,Color/K,Font/K/F”
Set the text block drawing type specs preferences.

Size Change the font size ( i - 300).

Leading

Width

Change the font leading ( i - 255).

Change the font width ( i - 255).

Oblique
Position

Change the font oblique percent (-20 - 20).

Change the font script. Choose one of the
following:
Normal. Superscript, SubScript

Case Change the font case. Choose one of the
following:
Normal Set the case to Normal.
SmaliCaps Set the case to Small Caps.
AllCaps Set the case to All Caps.

Style Change the font style. Choose one of the
following:
Normal Normal.
Underline Underlined.
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□Underline Double underlined.
StrikeThru Strike through.

Color Change the font color to the specified color
name.

Font Change the font to the specified font name.

Examples:
TextBlockTypePrefs SIZE 24 WIDTH 120 COLOR

Blue
TextBlockTypePrefs SIZE 36 FONT "SoftSans"
TextBlockTypePrefs FONT "WorkzTypelFonts/

Bodoni"
TextTool

Make the text tool the current tool. The text tool must be the
current tool to perform Cut, Copy, and Clear commands with
text. All selected graphic objects will become deselected.
See also GraphicTool.

Thesaurus
Present the thesaurus requester.

TOCPrefs “Title/K.LeveVK”
Change table of contents creation settings.
Title Change the table of contents title option.

Choose one of the following:
Yes Include the table of contents title

when creating the table of contents.
No Do not include the title.

Level Set the level to begin page numbers with.
Choose 1-3.

Examples:
TOCPrefs TITLE No LEVEL 2

TOIPrefs “Title/K,BlankLine/K,Names/K”
Change the table of illustrations creation settings.

Title Change the table of illustrations title
option. Choose one of the following:
Yes Include the title when creating the

Table of Illustrations.
No Do not include the title.

BlankLine Change the blank line option. Choose one
of the following:
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Yes Separate sections with a blank line.
No Don’t separate with a blank line.

Names Change the section names option. Choose
one of the following:
Yes Show section names in the list.
No Don’t show section names in the list.

Examples:
TOXPrefs TITLE Yes BLANKLINE No NAMES Yes

Type “Text/A/F”
Enter the characters specified into the document at the insertion
point. (Same as typing the characters from the keyboard.)

Text Text to be inserted into the document.
Examples:
Type "Hello world."

TypeSpecs
Present the type specs requester.

Ungroup
(Ingroup the selected objects.
See also Croup

Unlock
Unlock the selected graphic objects so that they may be moved
or resized.
See also Lock.

UpdateDate
Update the auto date strings in a selected range of text to the
current date. If no text is selected, then update all the auto date
strings in the current paragraph.

UpdateTime
Update the auto time strings in a selected range of text to the
current time. If no text is selected, then update all the auto time
strings in the current paragraph.

View “Size”
Change the view size of the document.

Size Change the view size. If size is not speci­
fied, then set the view to normal or choose
one of the following:
25, 50, 75,100,125, 150, 200, 400
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Width “Width”
Change the font width.

Width Change the font width to the given value.
If not specified, then present the text width
requester.
4 - 255 Set the width to the percent

value.
Normal Set font width to normal or

100%.
Examples:
Width
Width 75
Width Normal

WinToBack
Send the document window behind all other windows.
See also WinToFront.

WinToFront
Bring the document window to the front of all other windows.
See also WinToBack.

Return the total height of the document’s
List of status command options:

BodyTextHeight

Filename
body text in ruler or micropoints.
Return the file name of the document

FontCase
(without a path). See also Status Pathname.
Return the font case of the text at the

FontColor

insertion point (“Normal’’ “AllCaps"
“SmallCaps").
Return the color name of the text at the

FontLeading

FontName “Id”

Examples:

insertion point.
Return the leading value of the text at the
insertion point.
If “Id" is not specified, return the filename
(without path) of the font at the insertion
point. If “Id" is specified, then return the
filename of the corresponding font. The
valid range for “Id” is from 1 to the number
of fonts in the document. See also Status
FontPath, Status NumFonts.

Status FontName
Status FontName 4
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FontOblique

FontPath “Id”

FontPosition

FontSize

Fontstyle

FontWidth

HotZone

Hyphen

Indent

Justify

LeftMargin

LineHeight

LinePos

NumFonts

Page “Insert”

Return the oblique value of the text at
theinsertion point.
If “Id” is not specified, return the complete
pathname of the font at the insertion point.
If “Id” is specified, then return the filename
of the corresponding font. The valid range
for “Id” is from 1 to the number of fonts in
the document. See also Status FontPath,
Status NumFonts.
Return the font position (script) of the text
at the insertion point. ("Normal" “Subscript'
“Superscript")
Return the point size of the text al the
insertion point.
Return the font style of the text at the
insertion point. ("Normal" “Underline"
“Dllnderline" "StrikThru")
Return the font width of the text at the
insertion point.
Return the current paragraph's hyphenation
hot zone in ruler or micropoints.
Return the current paragraph's hyphenation
status. ("On" “Off")
Return the current paragraph's indent in
ruler or micropoints.
Return the current paragraph's justification.
("Left" "Right" "Center" "Full")
Return the current paragraph's left margin
setting in ruler or micropoints.
Return the height of the current line in
ruler or micropoints.
Return the position of the insertion point as
"Line Position", where Line is the line
number and Position is the character
position on the line. (0 is at the beginning
of a line.) If a range of text is selected,
then Result is returned as "BegLine
BegPosition Endl.ine EndPosition".
Return the number of fonts opened in the
document.
Return the page number currently in view.
If "Insert" is specified, then return the page
number that the insertion point is in.
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Pages

ParaChars

ParaPos

Pathname

PortName

PostScriptFile

RightMargin

Screen

Spacing

ScrollPos

StyleSheet

View

Window

Return the number of pages in the current
section.
Return the number of characters in the
current paragraph or the first paragraph of
a selected range. (This is not the number
of characters in the range but rather the
number of characters in the paragraph.)
Return the position of the insertion point as
"Para Position", where Para is the para­
graph number and Position is the character
beginning of a paragraph.) If a range of
text is selected, then Result is returned as
“BegPara BegPosition EndPara
EndPosition".
Return the complete path and file name of
the document. See also Status Filename.
Return the ARexx port name for the
document.
Return the filename for printing to a
PostScript file.
Return the current paragraph's right margin
setting in ruler or micropoints.
Return the screen’s width and height as
"Width Height" in screen pixels.
Return the spacing of the current para­
graph. ("Single" “One and One Half
“Double” “Variable")
Returns the X Y position of the document
at the upper left corner of the window in
ruler or micropoints.
Return the stylesheet name of the current
paragraph.
Return the current view size. “25", “50”,
“75", "100", “125", “150", “200", or “400".
Return information about the size and
location of the document's window as “Left
Top Width Height MinWidth MinHeight
MaxWidth MaxHeight”.
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| Reference
This chapter contains descriptions of Final Writer's menus, rulers,
startup options, and other information. These descriptions may
include page numbers of this manual where additional information
may be found.
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Menus
Below are descriptions of Final Writer's menus. The page numbers
that accompany the descriptions refer to pages in this manual where
additional information can be found.

Project
New
Open...

KJN
e»o

Save ras
Save As... raw
Save Text Clip..
Print... «3P
Print Merge...
Delete..
Preferences ►
About ►
Quit

Project menu
Command Action

New Begin a new document (page 5-2).
Open... Open an existing document (page 6-2).
Save Save a document.
Save As... Save a copy of a document.
Save Text Clip... Save a text clip.
Print... Print a document and/or make print

settings (Chapter l(>).
Print Merge... Print form letters using current docu­

ment and a data file (Chapter 11).

Delete... Delete a file from disk.

Preferences Set program preferences (Chapter 3).

About Access information about Final Writer
(its licensers, and applicable patent
numbers), as well as information about
SoftWood. Inc. (address and phone
number for technical support) (page 1-
11).

Quit Exit Final Writer program (pages 1-10
and 2-16).
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EH
Cut ISSSKCopy tSESC
Paste GEBV
Clear IS2UJD
Select All ISE3A
Find... C=g~r3F
Replace... &3R
Go To Page...
Go To Section
Go To Selection
insert Item
Update Item ►
Copy Ruler EDO'
Paste Ruler EESt

Edit menu
Command

Cut

Copy

Paste

Clear...

Select All

Find...

Replace...

Go to Page...
Go to Section

Go to Selection
Insert Item

Update Item

Copy Ruler

Paste Ruler

Action

Remove selected text from the docu­
ment and place it on the Clipboard.
Copy selected text to the Clipboard
(page 6-6).

Transfer text from the Clipboard into
your document at the insertion point
(page 6-6).

Remove selected text from the docu­
ment.

Select all text in the part of your
document being edited (Body, Header,
or Footer) (page 5-4).

Locate specific text in your document
(page 6-8).
Replace specific text in a document
with other text (page 6-10).

Go to a specific page (page 6-4).
Go to a specific section (page 10-4).
Go to any selected text in a document.
Insert the item named in the sub-menu
at the insertion point. Insert Merge
Field displays a requester so you can
choose a data name (page 6-12).
Update all instances of inserted dates
and times in a document by choosing
"Date’’ or “Time" from the “Update”
sub-menu. Update selected “Merge
Field" by choosing a data name from a
requester (page 6-13)-
Make a copy of the ruler settings for
the paragraph in which the insertion
point is set.
Transfer copied ruler settings into the
paragraph where the insertion point is.
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View menu
Command Action

Page View Change page view magnification (page
7-2).

Left Master Access Left Master page.

Right Master Access Right Master page.

Body Access Body of document.

Top Ruler Show top ruler only.

Top/Left Rulers Show top and left rulers.

No Rulers 1 lide top and left rulers.

Show Button Strip Show button strip.

Hide Button Strip Hide button strip.
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Loyout
Page Setup...
Section Setup...
Paragraph..
Define Style >'
Apply style »
Bullet ........................................
Indent Right
Indent Left
Hanging Indent
Hew Section .......................... >

helion
Insert Page Break ...... BPSTji'

Layout menu
Command

Page Setup...

Section Setup...

Paragraph...

Define Style

Apply Style

Bullet

Indent Right

Indent Left

Hanging Indent

New Section

Remove Section

Insert Page Break

Remove Page Break

Action

Page parameters for entire document
(Chapter 4).

Page parameters for a section (Chapter
4).

Set parameters for the current para­
graph and/or program default values
(p. 7-52).
Commands to create and edit Para­
graph styles (Chapter 7).
Commands to apply paragraph styles.
Convert current or selected paragraphs
to a bullet format.
Indent current or selected paragraphs
to the right.
Indent current or selected paragraphs
to the left.
Convert current or selected paragraphs
to a hanging indent format.
Create a new section of a specific type
(page 10-3).
Delete a section from the document
(page 10-4).
Insert a page break at the insertion
point (page 7-29).
Remove a page break in the paragraph
in which the insertion point appears
(page 7-29).
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Text menu
Command Action

Open fonts or choose fonts that have
already been opened (page 7-12).Font ►

Text Styles ►
Size > Text Styles Commands to create, edit, and assign
Leading ►
Style » Text Styles (Chapter 7).
Position >
Width > Size Specify size of text (page 7-13).
Case ►
Color... K5B&
Oblique Percent ►

Leading Specify leading (line spacing) of lines
of text within paragraphs having
"Variable" line spacing (page 7-1'1).Type Specs... BEB.

Style Specify the style of text to use—
normal, underline, double underline,
or strike through (page 7-1-1).

Position Specify the position of text—normal,
superscript, or subscript (page 7-15).

Width Specify the width of text (page 7-15).

Case Specify the case of your text—normal,
small caps, or all caps (page 7-16).

Color... Specify the color of text (page 7-16).

Oblique Percent Specify the slant percentage of itali­
cized text (page 7-17).

Type Specs... Change any or all characteristics of
existing or about-to-be-entered text
(page 7-18).
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Graphics menu
Command Action

Graphics Import... Import an IFF ILBM or EPS image into
your document (page 8-8).

Settings Access default settings for various
graphic object types (page 8-2).

Rotate To Rotate a graphic object to a specific
degree (page 8-15).

Rotate Rotate a graphic object by a specific
degree increment, (page 8-15).

Import... 1^52
Settings >
Rotate To ►
Rotate ►
Bring To Front IS3J J
Send To Back I2EBK
Group
Ungroup
Lock
UnLock
Delete

Bring to Front Bring a selected graphic item to the
front of several layers of graphic items.

Send to Back Send a selected graphic item to the
back of several layers of graphic items.

Group Place multiple selected objects into a
single group (page 8-18).

Ungroup Remove objects from a group (page 8-
18).

Lock Lock the position and size of selected
graphic object(s).

UnLock... Unlock the position and size of
selected graphic object(s).

Delete Delete the selected graphic object(s)
(page 8-12).
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Tools
Speller... BEES I
Thesaurus... BES)
Statistics...
Outline...
Table of Contents...
Table of Illustrations...
Endnotes ►
Bibliography >
Index »
Sort Paragraphs >

Tools menu
Command Action

Speller...

Thesaurus...

Statistics...
Outline...
Table of Contents...

Table of Illustrations...

Endnotes

Bibliography...

Index-

Sort Paragraphs

Access Speller (Chapter 9).

Access Thesaurus (page 9-7).
Display document statistics (page 9-8).

Create Outline section (page 10-6).
Create Table of Contents section (page
10-8).
Create Table of Illustrations section
(page 10-10).
Commands to insert and edit endnotes
and to create the Endnotes section
(page 10-11).
Commands to create bibliography
entries and to create the Bibliography
section (page 10-1-i).
Commands to add to and edit index
entries and to create the Index section
(page 10-16).
Sort paragraphs from low to high or
from high to low.

User
lOthe ARe:« Script..

Text Clip..
Command..

User menu
Command Action

Other Commands to Select an ARexx script,
select a text clip, and execute a string
command.
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The Rulers
Final Writer’s rulers are used to show horizontal and vertical dis­
tances in a document. In addition, the horizontal ruler provides an
easy, visual way to set paragraph characteristics. A paragraph is
defined as zero or more characters terminated by a RETURN key.
Every paragraph can have its own ruler settings. When you termi­
nate one paragraph by pressing the RETURN key, the program
automatically copies the ruler settings of the paragraph just termi­
nated to the new paragraph. Ruler settings that can be made are:

• Left and right margins
• First line indent
• Tab stops
• Hyphenation “hot-zone"
• I’aragraph justification
• Line spacing
• Hyphenation ON/OFF

in addition to making paragraph settings, the ruler may also be used
to select master pages and various drawing tools, and to specify
which rulers are actually visible on your screen.
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Starting Final Writer from CLI
Final Writer can be operated in cither its own custom screen or on
the Workbench™ screen. The program's custom screen is a 4 color
screen that uses pre-defined colors that you cannot change. If you
want control over screen colors, you will need to operate Final
Writer on your Workbench™ screen.

You can start Final Writer from either its Workbench™ icon, a
Workbench™ icon of a Final Writer document, or from the Cl.l.
When you start Final Writer from the Cl.l you can specify an
optional command line parameter to specify the type of screen you
want to use. The options for this parameter are:

-WB Workbench™ screen
-CL Custom interlace screen
-CN Custom non-interlace screen
Below are examples of starting Final Writer from the Cl.l. These
examples assume you are within the Finalwriter drawer.

FinalWriter -CL Work:Docs/Letter
Start Finalwriter on a custom interlaced screen, and open the
document titled "Letter".
FinalWriter -WB
Start FinalWriter on the Workbench™ screen.

ToolTypes
The following are Final Writer tooltypes that you can define. The
term "pathname" below means the complete path that identifies a
directory For example, WORK:FinalWriter/FWMacros is the
pathname containing the ARexx macros that comes with Final
Writer. To assign this directory as the default MACRODRAWER, set
the tooltype as "MACRODRAWER“WORK:FinalWriter. FWMacros".

NOICON
Don't create icons for saved documents.
DOCDRAWER=pathname
Use "pathname" as the default drawer when opening or saving a
document.

GFXDRAWER=pathname
Use ’ pathname" as the default drawer when inserting an IFF 1LBM
graphic.
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MACRODRAWER=pathname
Use “pathname" as the default drawer when “Other" is selected
from the ARexx menu.
FONTDRAWER=pathname
Use “pathname" as the default drawer when opening a font.

MAKEBACKUP
Instructs Final Writer to make a backup copy of a document when it
is resaved. The backup copy is the document as it existed the last
time it was saved. The name of the backup document is the same
as the original with “.BAK” appended to the end. For example,
"Ilello.BAK" would be the backup copy of “Hello”. Use of this
tooltype ensures that you always have a backup of a document
prior to new changes you make. The only downside is that the
backup copy requires disk space.

Defining Tool Types
Final Writer tool types are defined from the Workbench “Informa­
tion" requester.
To access the “Information” requester for Final Writer:

1. Locate the “Final Writer” program icon.

2. Click the mouse once on the icon to select it.

3. Select “Information” from the “Icon” menu.

A requester will be displayed showing information about the
Final Writer program's icon. In the list titled “Tool Types” are
the Final Writer tool types listed above. If the tool type is
enclosed in parenthesis, the tool type is disabled. Tool types
not enclosed in parenthesis are active.

To define or disable a tool type:

1. In the “Tool Types” list, click the mouse on the tool type
to be defined or disabled.

The tool type will be shown in the data entry area.

2. Make the desired changes to the text and press the RE­
TURN key.

3. After all changes have been made, click on “Save”.
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FWMacros scripts
Final Writer comes with several useful ARcxx macro scripts that you
can use to enhance the power of Final Writer. These scripts are
located in the “FWMacros” drawer. You can assign these scripts to
buttons in the User Button Strip and to menu items in the "User"
menu. The names of the scripts and their purpose arc:
Script
GfxDuplicate
GfxLineWt_Decr
GfxLineWtJncr
GfxNudge_Down
GfxNudgeJJp
GfxNudge_Right
GfxNudge_Left
GfxShadowBox
GfxClip t
Magnify_Down
Magnify_Up
SectNumCols_1
SectNumCols_2
SectNumCols_3
T xtDelete_T oEndOf Line
TxtLeading_Decr

TxtLeadingJncr

TxtSelect_Off
TxtSize_Decr
TxtSizeJncr
TxtStyle_Bold
TxtStyle_Boldltalic
TxtStyleJtalic
TxtStyle_Plain
TxtWidth_Decr
TxtWidthJncr

Purpose
Make copy of selected graphic object.
Decrement selected graphic's line weight.
Increment selected graphic's line weight.
Move selected graphic's position down.
Move selected graphic's position up.
Move selected graphic's position to (he right.
Move selected graphic's position to the left.
Create shadow of selected graphic.
Create a graphic clip macro file.
Reduce page view magnification.
Increase page view magnification.
Set current section to 1 column.
Set current section to 2 columns.
Set current section to 3 columns.
Delete text from insertion point to end of line.
Decrement by 1 point the leading of paragraph
whose line spacing is set to variable by.
Increment by 1 point the leading of paragraph
whose line spacing is set to variable.
Unselect selected text.
Decrement text size by 1 point.
Increment text size by 1 point.
Open "_Bold" version of font.
Open "_BoldItalic" version of font.
Open "..Italic" version of font.
Open plain version of font.
Decrement text width.
Increment text width.
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Bold, Italic, and Boldltalic text
Final Writer's outline font engine uses separate fonts for the plain,
bold, italic, and bold-italic styles. Therefore, if you are typing in
"SoftSans" and you want to bold your text, you will need to open
the "SoftSansJBold" typeface. Once a bold, italic, or bold-italic
typeface is used in a document, it will be in the "Font" sub-menu.
However, opening the font and later selecting it from the menu can
be nuisance.

Four of the ARexx scripts in Final Writer's FWMacros drawer can be
used to conveniently open the bold, italic, and bold-italic versions
of a typeface. The names of these macros are:

TxtStyle_Bold X
TxtStyle_Italic
TxtStyle_BoldItalic
TxtStyle_Plain

For maximum convenience you can assign these macros to buttons
in a User Button Strip. For example, once these macros have been
assigned to buttons, you can set text to bold by clicking on the
button that has been assigned the "TxtStyle_Bold" macro. Refer to
the "User Button Strip" section of Chapter 3 - Preferences for details
on working with the button strip. When you choose buttons to use
for these macros, you may want to use the ones provided for this
purpose.

You can also assign the above ARexx macro scripts to menu items
in the "User" menu. Refer to the "User Menu" section of Chapter 3
for details on working with the "User" menu. One of the options
you have when defining a "User" menu item is to assign an Amiga®
function key to the item. For example, if you assign "Fl" to the
menu item that has been assigned "TxtStyle_Bold", you simply press
the "Fl" key to set your text to bold.
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Opening foreign documents
Final Writer can open documents created in WordPerfect™,
ProWrite™, and PenPal™. You open a document created in any of
these word processors just as you open documents created in Final
Writer. There is no conversion process that you are required to do.
When you instruct Final Writer to open a document, it checks to see
who created the document. If the document was created in one of
the above word processors, Final Writer automatically converts it to
a Final Writer document as it is opened. Warning, if you save the
document, it will be saved as a Final Writer document. Therefore, if
you want to retain the document in its original format, you should
make a copy of it before opening it in Final Writer.

Any information contained in documents created by other word
processors that Final Writer can not process will be ignored.
WordPerfect™ documents contain the most information that can not
be processed in Final Writer.

Program and document settlings
When you run Final Writer after it is first installed on your hard
drive, preference and style settings are set by Final Writer to values
contained within the program itself. Whenever you save preference
or style settings they are saved to a disk file named "FW.Prefs"
which is located in the "FWFiles" drawer. From then on whenever
you start Final Writer or begin a new document the preference and
style settings are obtained from the "FW.Prefs" file. If you ever
want to revert back to the original program settings that existed
before the "FW.Prefs" file was created, simply delete the "FW.Prefs"
file. The easiest way to do this is to use Final Writer's “Delete"
command located in the “Project" menu.

Based upon the "Document Save Preferences" Final Writer can save
unique preference and style settings with each document. When a
document is opened. Final Writer replaces its current preference
and style settings with any that are stored with the document. In
some situations you may wish to reset one or more of the prefer­
ence and style settings saved with a document to the Final Writer
default settings.
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To reset a document's preference or style settings to the
program defaults:

1. Open the document.

2. Access the “Document Save Preferences” requester.

See the section “Document Save Preferences" in Chapter 3 for
details on accessing this requester.

3. Remove the check mark in front of the setting you want to
reset.

4. Click on “Use”.
5. Save the document.
6. Close the document.

The next time you open the document, the settings will be
reset.

Automatic page numbering
You can insert a page number anywhere on a master page in your
document. The “Page Setup" requester and the “Section Setup"
requester (refer to Chapter zi) allow you to specify the first number
that Final Writer is to use for numbering pages in your document
when you use the automatic page numbering feature.

To use the automatic page numbering feature:

1. Click on the Master Page icon you wish your page number
to appear on (refer to page 2-13).

2. Move the insertion point to the position where you want
the page number to appear.

3. Select “Insert Item/Page Number” from the “Edit” menu.
A symbol will appear at the insertion point.

4. Click on the “Body Page” icon (refer to page 2-15) to
return to the main body of text.
The correct page number will be displayed at the selected
position.
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| Cursor Key Functions
As you get used to using Final Writer, you may wish to learn some
of its cursor key functions. The cursor keys are the up, down, right,
and left arrow keys on the right side of your keyboard. When
pressed, the cursor keys achieve the following actions:

Cursor Key
Left_Arrow
Right_Arrow
Up_Arrow
Down_Arrow

Cursor Action

Move to previous character
Move to next character
Move to previous line
Move to next line

The CTRL and ALT keys can be used to modify the action of the
above cursor keys. In the list that follows the "+" character indicates
that keys are pressed together. When cursor keys are pressed while
also holding the CTRL, and /or ALT keys down, these actions result:

Keys Cursor Action

CTRL+Left_Arrow

CTRL+Right_Arrow
CTRL+lJp_Arrow

CTRL+Down_Arrow
?YLT+Left_Arrow

ALT+Right_Arrow
ALT+Up_Arrow

ALT+Down_Arrow

CTRL+ALT+Left_Arrow
CTRL+ALT+Right_Arrow
CTRL+ALT+Up_Arrow
CTRL+ALT+Down_Arrow

Move to beginning of current or previous
word
Move to beginning of next word
Move to beginning of current or previous
line
Move to beginning of next line

Move to beginning of current or previous
sentence
Move to beginning of next sentence
Move to beginning of current of previous
paragraph
Move to beginning of next paragraph

Move to beginning of current line
Move to end of current line
Move to beginning of document
Move to end of document

If you also depress the Shift key with any of the functions described
above, the text through which you are moving will be selected (if
not already selected) or deselected (if already selected).
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| Keyboard Shortcuts
Whenever a menu item appears with a letter to the far right of the
item's border, you have the option of using the keyboard to choose
the menu item rather than using the mouse.

To use the keyboard to choose a menu item:

Graphics Menu

2 Import
J Bring to Front
K Send to Back

Tools Menu

[ Speller
] Thesaurus

1. Hold down the “A” key that is on the right side of the
space bar on the keyboard.

2. While continuing to hold down the “A” key, press the key
that is appropriate for the menu item you want to choose.

Project Menu
N New
O Open
S Save
W Save As
P Print
Q Quit

Edit Menu

X Cut
C Copy
V Paste
D Clear
A Select All
F Find
R Replace
G Go To Page
3 Insert Date
5 Insert Time
7 Insert Page #
8 Insert Merge Field
4 Update Date
6 Update Time
9 Update Merge Field
0 Copy Ruler
1 Paste Ruler

Layout Menu

Paragraph
L Insert Page Break

Text Menu

T Open Font
B Normal Style
U Underline
E Double-Underline
I StrikeThru
! Normal Position
@ Superscript
# Subscript
$ Normal Case
% Small Caps
A All Caps
, Type Specs
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Helpful Hints for Better Documents
Readability and Layout
The ultimate goal of any document is to be read. Your job, as the
creator of that document is to do everything in your power to make
it appealing and readable. Layout is merely a way of drawing the
reader through the page and should never interfere with the reader's
ability to read and understand the message of the document.

The following are some suggestions on how to make your docu­
ments look good and get read. These are just guidelines. There is
no substitute for your own instinct and experimentation when it
comes to making your document the best it can be.

Serif vs. Sans Serif
A serif typeface is one in which the strokes of the letters end with
small finishing strokes. Sans serif type faces do not. For example,
this sentence is in a serif typeface. This sentence is in a sans serif
typeface.

Mixing Typefaces
Final Writer gives you the flexibility to combine any number of
typefaces in your documents. If you follow a few general guidelines
when mixing fonts, your results will be very effective.

First, similar typefaces are normally not used together. That’s why
you should not use two serif (or two sans serif) faces on the same
page. The subtleties that make each typeface unique are lost when
two or more similar faces are competing.

Second, minimize the number of typefaces, sizes, styles, case formats,
etc. on each page. It may be tempting to use as many of Final
Writer's exciting features as possible in each document, but the result
would be a very busy, confusing jumble. By all means, experiment
with your type, but keep each document clean and readable.

Third, provide a contrast between headlines and body text in your
document. You will notice that most publications use a bold sans
serif typeface for headlines and a serif face for the text. There are
reasons for this tried and true practice. A bold sans serif face pro­
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vides an instant "pop” of recognition and legibility (an important
requirement for headlines), while a serif face gives the readability
that is so important in larger blocks of text.

Body Text
Sans serif type gives a clean, less conventional look to your text, but
is not as readable in large quantities as serif text. So while you
might wish to use a sans serif type face occasionally for your body
text, remember that it is not usually as readable as a serif face.

Headlines
In order to be effective, headlines should be left justified. This
guideline is based on the rudiments of reading. Your eye naturally
wants to move to the right and downward. A left justified headline
has the effect of pulling your reader's eye into the body text below.

Avoid all caps in a headline, too. A series of capital letters slows
down the reader's ability to decipher the words, and you want the
headline to grab them quickly and pull them into the text.

Above all, be consistent. All headlines in a document should be of
uniform size and style.

Columns and Line Length
Studies have shown that seven to eight words per line are most
readable (a serif typeface may handle nine to ten words per line
without sacrificing too much readability'). This may' be achieved in
several ways using Final Writer's columns and type features.
First, consider increasing the number of columns if you have large
blocks of text. If you elect to use very' narrow columns, use left
justified type to avoid hyphenation and spacing problems that can
occur with full justified type.

Second, consider increasing the size of your type if it is very' small.
Typically, body text is set in 10 or 12 point type. Anything smaller
than that alienates an older reader and impairs readability' for readers
of all ages.
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White Space
When designing your documents, do not hesitate to leave blank
spots, or white space, in your documents. A page that is filled
completely with text and graphics can look overwhelming to a
reader and decrease his or her likelihood of actually reading your
document. White space, however, gives the page a feeling of
openness and gives your reader room to breathe.

White space may be achieved in many ways. Try using wide
margins, or leaving empty space before or after a headline. To see
how white space is used by designers, study a few magazines,
paying special attention to the advertisements. Then take what you
like and apply it to your own documents.

Widows, Orphans, and Rivers
These are three big typographical problems with funny little names.
Avoid them whenever possible.
A widow occurs when a paragraph ends and leaves less than seven
characters on the last line (the last line is called the widow). This is
made even worse when the last line is only a portion of a hyphen­
ated word. Adding a word or widening a margin slightly will
usually correct a widow.
An orphan occurs when the last line of a paragraph is too long to fit
entirely at the bottom of a column and continues at the top of the
next column. An orphan may be corrected by removing words or
lengthening a column slightly.
A river occurs when the space between words becomes greater than
the space between the lines. This phenomenon typically occurs
only when you are working with full justified text. Be alert to any
rivers of white running vertically through your text. It may be
possible to correct this problem by switching to left justified text.
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Glossary
all caps All capital letters.

ARexx Amiga Rexx macro language.

ascender The part of a lowercase letter that moves above the x-
height (.letters with ascenders include h, t,f and I). Leading or line
spacing must allow enough room for ascenders.

ASCII File format used in most text editors.

baseline An imaginary line that runs along the bottom of letters.
A portion of some letters descend below the baseline.

body copy A page or column of body type.

body type Type sized 12 points or smaller.

boldface type Type that is blacker and heavier than its normal
appearance.

bullet A bold dot or mark that is used to draw attention or to set
off an element in a series or list.

cache An internal-memory listing used by the speller to store
recently used words, thereby eliminating the need for disk accesses
to verify their spelling.

column A section of a page that runs from top to bottom.

copy A word used to refer to written material.

crop The act of removing unwanted areas of a graphic.

descender The part of a lowercase that descends below the
baseline. Leading or line spacing must leave enough room for
descenders.

display type Any type larger than 12 points, such as that used for
headlines and titles.

flush left Type that is aligned even with the left margin.

flush right Type that is aligned even with the right margin.
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font The word used to refer to a complete family of type in a
particular style or design.

gadgets Areas on a window or requester that arc clicked on to
perform some action.

hanging indent An indent where the second and all following
lines of a paragraph arc indented a preset amount of space.

hyphen hot zone The point in a line of text where a word
becomes eligible for hyphenation.

italic type Type that slants to the right. May be used instead of
underlining to designate names of publications, etc. Also may be
used for emphasis or decoration.

leading The amount of space between lines of type, as measured
in points. Leading rhymes with bedding.

lowercase Small (non-capitalized) letters.

orphan A solitary line of type at the top of a page or column;
usually the continuation of text in the previous column.

pica One-sixth of an inch, or 12 points.

point A unit of measure applied to type. There are 72 points in an
inch.

RAM The abbreviation for random access memory. This is your
computer's internal memory bank which is used for running pro­
grams such as Final Writer.

sans serif type A typeface in which all strokes in the letters are
similar in size and do not have serifs. The beginning words ot this
entry, “sans serif type" appear in a sans serif type.

script Type that resembles calligraphy or handwriting.

scroll gadget The Final Writer gadget that enables you to scroll
through your document. The scroll gadget has three components:
the scroll bar. the scroll box. and the scroll arrows.
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serif Small finishing strokes appearing at the end of a letter stroke.
The definition portion of this entry appears in a serif typeface. The
beginning word “serif’ appears in a sans-serif face.

small caps Capital letters that appear smaller than regular capital
letters for a specified point size.

tombstone headlines Side-by-side headlines in the same size and
style - An undesirable occurrence.

typeface A particular style of type.

upper case Capital letters.

white space The space on a page that is not occupied by text or
graphics.

widow A line of type at the bottom of a page or column; usually
the beginning of text in the next page or column.

x-height The height of the lowercase x in a certain typeface.
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| Accessing Special Characters
Accented characters contained in a font can be accessed through the
use of a "Dead Key" combination. A "Dead Key1' combination is
entered by pressing the ALT key and another key at the same time.
When the Dead Key combination is pressed, nothing appears on the
screen until you release the keys pressed, and press a third key such
as an "a", "c", "i", "o", "u", "y", "n", "A", "E", "I", "O", "U", "Y”, or "N".
For example, if you want the character "a", first press the ALT and "f"
keys at the same time, release these keys, and then press the letter
"a". If you do this correctly, you will see the "a" character when you
press the letter "a".

In the following chart the "+" character indicates the ALT key and the
character following the "+" is to be entered at the same time (don't
press the "+" character). When a third character is shown, enter it
after the Alt key combination has been pressed and released.

NOTE. Not all typefaces contain these characters.
Character I low to access it Character How to access it

a Alt+f a A Alt+F A
a Alt+g a A Alt+G A
a Alt+h a A Alt+H A
a Alt+j a A Alt+J A
a Alt+k a A Alt+K A
a Alt+q A Alt+Q
c Alt+f e E Alt+F E
c Alt+g e E Alt+G E
c Alt+h e E Alt+H E
c* Alt+k e E Alt+K E
i Alt+f i i Alt+F I
i Alt+g i I Alt+G I
i Alt+h i i Alt+H I
i Alt+k i i Alt+K I
6 Alt+f o 6 Alt+F O
d Alt+g o d Alt+G O
6 Alt+h o 6 Alt+H O
6 Alt+j o d Alt+J 0
d Alt+k o d Alt+K O
u Alt+f u u Alt+F U
u Alt+g u u Alt+G u
u Alt+h u 0 Alt+H u
u Alt+k u u Alt+K u
h Alt+j n N Alt+J N
y Alt+k y Y Alt+K Y
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Other characters not on the keyboard can be accessed by pressing
the ALT key and some other keyboard character. For example, the
"©" character is obtained by pressing the ALT and “e” keys at the
same time.

Character How to access it Character How to access it
<t Alt+4 ae Alt+a
• Alt+8 /E Alt+A

« Alt+9 IS Alt+s
» Alt+0 § Alt+S
o Alt+w X Alt+1
© Alt+e 4- Alt+z

Alt+r Alt+Z
□ Alt+y Alt+X
Y Alt+Y V Alt+c

Alt+u V All+C
i Alt+i .! Alt+v
0 Alt+o •» Alt+b
0 Alt+O — Alt+n
SI Alt+p Alt+M
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| EPS Clip Art
You can import Encapsulated PostScript® Clip Art (EPS Clip Art)
into your Final Writer documents. EPS clip art is to graphic images
as outline fonts are to type - both are printed using the full resolu­
tion of a printer. The result is a very sharp and clear image unlike
the way bit-mapped images appear on printouts.

Final Writer will print EPS images on any graphic or PostScript®
printer. In addition, you can view EPS images on the screen. The
only disadvantage of EPS images is the amount of time it takes the
computer to process an image. When you print a document with
an EPS image, it will take longer to print the portion of the docu­
ment containing the EPS image. Also, if you instruct Final Writer to
display an EPS image on the screen, it will take considerably longer
for the program to open or resize the image.

Some EPS images contain text that is to be created using fonts in a
laser’s PostScript® ROM. If you are printing one of these images to
a PostScript® printer, the text should appear correctly. If you are
printing one of these images to a graphic printer, the text will not
appear.

Because of the length of time needed to load and display an EPS
image on screen, Final Writer gives you the option of showing
either a preview of the image (if one exists), or simply a box that
indicates the image's size and position. This option is set in the
“Imported Graphics Settings” requester. If you are about to import
an EPS image, you may want to first access the “Imported Graphics
Settings" requester and make sure either the “Preview" or “Cross
Box" options are selected. If you decide to show the full EPS image
on the screen, Final Writer will not display it in color on the screen.
Whenever you print, all EPS images are printed in full color (if
possible) and in full detail regardless of how they are displayed on
the screen.

The EPS images that are included with Final Writer are not in the
public domain. The owners of these images have agreed to let
SoftWood include the images with Final Writer in order to advertise
their clip-art collections. You can use these images in your docu­
ments, but the images themselves may not be freely distributed or
resold. On the following pages of clip-art the copyright owner of
the clip-art is mentioned at the bottom of each page. At the end of
the Appendix is information on each of these companies.
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Any of the EPS images that
you see on the following
pages may be sized as small
or as large as you wish with­
out any loss of clarity.
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"Anchor:" from "Nautical" volume “Cockroach" from “Insects" volume

"Apple" from “Food” volume

Images on this page are Copyright © Totem Graphics, Inc.
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Images on this page are Copyright © Totem Graphics, Inc.
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flounder from "J-'ish" volume
"Roller Coaster” from "Deluxe Business Vol­
umes s’ 1" volume
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Images on this page are Copyright © Totem Graphics, Inc.
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“Education”
"Slide" from

"W indmill" from
"Travel" volume

"Siberian Tiger" from
"W'ild Animals" volume

Images on this page are Copyright © Totem Graphics. Inc.
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Images on this page are Copyright © 1988 Studio Advertising Art
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Images on this page are Copyright © 1988 Studio Advertising Art
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Images on this page are Copyright © 1988 Studio Advertising Art
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Images on this page are Copyright © Metro Imagebase, Inc.
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Images on this page are Copyright £ Metro Imagebase, Inc.
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Images on this page are Copyright © One Mile Up, Inc.
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©1989 Droam Maker Software.
All rights reserved.

6
01989 Drcam Maker Software.

All rights reserved.

l>1939 Dream Mata Softtae.
All rights reserved

Images on this page are Copyright £' Dream Maker Software
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^1989 Dream Maker Software.
All rights reserved.
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Totem Graphics, Inc.

Metro Imagebase, Inc. 1(800)525-1552

Studio Advertising Art 1(702)641-70'11

Dream Maker Software 1(800)876-5665

Totem Graphics clip-art is available
on Amiga disks from Softwood, Inc.
All of this clip-art is in full color and
of the highest quality possible.

"Aladdin’s Lamp” from
Totem Graphic’s “Bor­
ders and Accents"

Federal Clip Art is 12 collections
available on diskette or CD-ROM.
The collections are focused to federal,
state, and international Governments
and contractors. This clip art is 100%
guaranteed. Prices per collection
range between $200 to $400. The
collections contain PostScript illustra­
tions of aircraft, ships, insignia, flags,
coats of arms, and maps. Any
Government insignia is for official use
only. Please call 1(800)258-5280 for a
free brochure.

One Mile Up, Inc.
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Appendix G:
Outline Fonts





| Outline Fonts

Final Writer supports 3 outline font formats: Type-1, Compugraphic,
and NimbusQ. In order to use Compugraphic fonts, you must have
Workbench 2.1 or higher. The NimbusQ file format used in Final
Writer is similar to, but not the same as the NimbusQ format on
other computers.

Compugraphic fonts are supported in Final Writer because at one
time the Compugraphic format was supposed to be the standard
outline font format for the Amiga, and many Amiga owners now
own Compugraphic fonts. Type-1 fonts are supported because
there are thousands available and are more industry' standard than
Compugraphic fonts. Through public-domain sources one can find
hundreds of Type-1 fonts that can be used with Final Writer.
Unfortunately most of the public domain Type-1 fonts were not
created by professional typeface designers, and are not as good as
ones available commercially. NimbusQ fonts are faster to use than
either Compugraphic or Type-1 fonts, yet they have the same and
sometimes better quality.

There are over 100 outline typefaces included with Final Writer - all
in the NimbusQ format. 100 of these typefaces are licensed from
B&P Graphics from their “Serials" collection. On the following pages
fonts from B&P Graphics are shown in three categories: Sans Serif
Fonts. Serif Fonts, and Decorative Fonts. All fonts listed in the
remaining pages of this Appendix are Copyright © B&P Graphics.
Inc.

Outline Fonts G -1
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Sans Serif fonts
Chantilly
Chantilly Italic
Chantilly Bold
Chantilly Boldltalic
Cleargothic
Cleargothic Italic
Cleargothic Bold
Cleargothic Boldltalic

Columbia
Columbia Italic
Columbia Bold
Columbia Boldltalic

Koblenz
Koblenz Italic
Koblenz Bold
Koblenz Boldltalic

Montreal
Montreal Italic
Montreal Bold
Montreal Boldltalic

Olympia
Olympia Italic
Olympia Bold
Olympia Boldltalic

Quebec
Quebec Italic
Quebec Bold
Quebec Boldltalic

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over...
The quick brown fox jumped over...
The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over...

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over...
The quick brown fox jumped ©ver...

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
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Ravenna
Ravenna Italic
Ravenna Bold
Ravenna Boldltalic
Rochester
Rochester Italic
Rochester Bold
Rochester Boldltalic

Ultimate
Ultimate Italic
Uiiimate Boid
UlBtimate BoBdOtalic

The quick brown fox jumped over the...
The quick brown fox Jumped over the...
The quick brown fox jumped over...
The quick brown fox jumped over...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over...
The quick brown fox jumped over...

The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy...
The quick brown fox jumped over...
The quick brown fox jumped over...

The quick brown fox jumped over the lazy dog.
The quick brown fox jumped over the lazy dog.
The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy...

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over...

Serif Fonts
Clearface
Clearface Italic
Clearface Bold
Clearface Boldltalic
Dragon
Dragon Italic
Dragon Bold
Dragon Boldltalic

Lingwood
Lingwood Italic
Lingwood Bold
Lingwood Boldltalic The quick brown fox jumped over...
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Riccione
Riccione Italic
Riccione Bold
Riccione Boldltalic
Quadrat
Quadrat Italic
Quadrat Bold
Quadrat Boldltalic
Stafford
Stafford Italic
Stafford Bold
Stafford BoldHtalic

Thames
Thames Italic
Thames Bold
Thames Boldltalic

Valencia
Valencia Italic
Valencia Bold
Valencia Boldltalic

Veracruz
Veracruz Italic
Veracruz Bold
Veracruz Boldltalic

Worchester
Worchester Italic
Worchester Bold
Worchester Boldltalic

Tire quick brown fox jumped over the lazy...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over...

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The cjuick biiwn fox junmiped over...
The qjuick browtru fox jumped over...

The quick brown fox jumped over the...
The quick brown fox jumped over the...
The cpafolk Bsimwa fox jwnaipsd...
The iqwick bzown fox jjwwip&d...

The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy...
The quick brown far jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped over...
The quick brown fox jumped over the...
The quick brown fox jumped over the...
The quick brown fox jumped! over...
The quick brown fox jumped over...
The quick brown fox jumped over the lazy...
The quick brown fox jumped over the lazy dog.
The quick brown fox jumped over the...
The quick brown fox jumped over the...
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Decorative Fonts

Amelia
j&d/cfduiei
EBwaxiDwaiy
Vjamme'icial bJk'ti/i/

Davida Sued

Ms® UBDaidk ODqdosdd

Msg®
Dom Casual
^rtiftnre yett
($©[$© (B©Q^
Japanese

L^&ifer
fcO CgjaVT' OlgEfTl
techno <:l w Edu

.kfyyctixj
RossGmrc

MWIL
S)t©F>
Studio
T<ab(as<S)C© TWiin

The quick brown fox jumped...
!dhc quick bioun/oxjumped ot’ci die iazy dog.
The quick brown fox...
,!%? f/uick fotown foxjuni/ied...
THE QUICK BROWN FOX JUMPED...

TTCDCIS 0[]irf(dk DDIJWD0 te JODDOOQDCdlooo
dpfeC3 brown Pox...

The quick brown fox jumped over the...
®(jie quiet brown for jnmjjcih*.
W fer©wn fox...
The quick Brown fox fumped over...

Tlw /wk brow, fonjiki^d ow tU...

M QU« 0R0^ FOX ^mPEO.

<_z/?c clutch v-iouytb/c-a,j,u/m/uxl c-vci...

ZJie quick dRocun Fo/ jumped...

rllW QUICK BROWN FOX...
tlFE @O5CC STOWn...
The quick brou/n fox...
Th© qukh bir©Wn fox.
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A
“About” command 14 - 2
Accessing special characters E - 1, E - 1
Adding a column of numbers 6-14
Aligning text 2-8, 7-9
ARexx

command definitions 13-8
command list 13-3
command syntax 13-3
errors 13-2
scripts 13-2

ASCII
data files for form letters 12-4
I/O preferences 3-8

Auto Suggest 3-11

B
Backup copies 1-3
Bibliography 10 - 14
"Bibliography" command 14-8
Body page 2-15, 4-6, 7 - 27
bold 14 - 13
boldltalic 14 - 13
"Box Settings" requester 8 - 5
“Bring to Front” command 14-7
“Bullet" command 14 - 5

c
Cache Size 3-10
"Case" command 14 - 6
Center text 2 - 9
"Clear" command 14 - 3
Click 1 - 3
Close box 1-10, 2-7
Closing a document 2-7, 5-7
Collate 11-4
Color

correct 11-7
document color preferences 3 - 14
graphic vs screen vs printed 8-19
IFF ‘On Screen’ 3-7
screen color preferences 3-18
\VB Document 3-7

“Color” command 14 - 6
Columns 4-6
“Copy” command 14-3
“Copy Ruler" command 14 - 3
Copying text 6 - 6
Correcting mistakes as you type 5-4
Correcting spelling errors 9 - 4
Creating

data file 12-3
lines, boxes, and ovals 8-2
new document 2-2, 5-2

Cropping graphics 8 -17
Cursor Key Functions A -1
“Cut” command 14 - 3

D
Data File

creating 12-3
saving 12 - 5
tips for setting up 12 - 4

Date
format and order 3 -13
inserting 6-12
updating 6-13

Decimal styles 3-13
“Define Text Styles” requester 7 - 20
“Delete” command 14 - 2, 14 - 7
Deleting

blank line (RETURN character) 5 - 6
block of text 2-5
character 5 - 6
files 14 - 2
objects 8-12
selected text 5 - 6

Density 11-6
Display Preferences

IFF ‘On Screen' colors 3-7
Measure in 3-7
Page guides 3 - 7
Rulers 3 - 7
Screen DPI 3 - 6
WB Document Color 3 - 7
Window size 3 - 7

D

Index -1

Index



Dithering
halftone 11-7
ordered 11-7

Document
closing 2-7, 5-7
creating 2-2, 5-2
formatting 2-8, 7-1
opening 2-8, 6-2
preferences 3-12, 3 - 14, 3 - 16
revising 2 - 4, 6 - 1
saving 2-7, 5-7
settings 14 - 14
statistics 9 - 8

Document Color preferences 3 - 14
Document Item preferences

Date Format and Order 3 - 13
Decimal 3-13
Tabs Every 3-12
Time Format 3 - 13

Document Save Preferences l-i - 14
Save With Each Document 3 - 16

"Document Scan" mode 9 - 3
Double-click 1 - 3
DPI 3 - 6
Draft mode printing 11-2
"Draft Preferences" requester

lines per page 11-0
margins 11-10
pitch 11-11
quality 11-11
spacing 11-11

Drag 1 - 3

E
Edit Area -I - 5
"Edit" menu 1-6. 14-3
Encapsulated PostScript® 8-8
Endnotes 10- 11
"Endnotes" command 1-1-8
EPS Clip .Art F. - I
Error Reporting 3-11

F
Final mode printing 11-2
"Find" command 14-8
Finding and replacing text 6-10
Finding text

next occurrence of specified text 6-9
specific text in a document 6-8

First line indent margin 7-5
“Font" command 14 - 6
Fonts

changing font size 2-11
opening 7-12
selecting 7-12
size 2-11,7-13

Footers 2 - 12, 4-6, 7 - 28
Form Letters

creating 12-6
merge field 12-8
merging data 12-9
producing 12-2
removing a merge field 12-9
saving 12-9

Format 4 - 6
Front to back gadget 1-10
FW.Prefs 14 - 14
FWMacros scripts I t - 12

G
Glossary D - 1
“Go To" Commands

go to selected text in a document 6-4
go to specific page in a document 6-4

"Go to Page” command 14-3
"Go to Section" command 14-3
"Go to Selection" command 14 - 3
“Graphic Final Print Preferences" re­

quester 11-5
Graphic Preferences

color correct 11-7
density 11-6
dithering 11-7
printer driver 11-6
shade 11-7

Index - 2



threshold 11-6
Graphics

Boxes
drawing new 8-5
perfect square 8-6
rounded-corners 8-6

Canceling graphic actions 8-18
Colors 8-19
Constrained moving 8-14
Creating 8-2
Deleting 8-12
Encapsulated PostScript® format 8 - 8
Exact size and location 8-16
Extra I lalfbrite format 8 - 8
11AM format 8-8
IFF II.BM format 8 - 8
IFF II.BM images

constrained sizing 8-13
cropping 8-17
grouping 8 - 18
importing 8-8
restoring 8-18

Lines
arrow-tipped 8-4
drawing new 8 - 3

Modifying settings 8 - 16
Moving 8 - 14
Ovals

drawing new 8-7
drawing perfect circles 8 - 8

"Quick” sizing 8 - 14
Restoring 8 - 18
Rotating objects 8-15
Save/Link Option 8 - 10
Selecting 8-11
“Settings" requesters 8 - 2
Sizing 8-13
“Snap To" moving 8-14
“Snap To" sizing 8-13

“Graphics” menu 1-7, 14-7
"Group" command 14 - 7
Grouping objects 8-18

IFFILBM 8-8
IFF 'On Screen' colors 3 - 7
“Import” command 14 - 7
“Imported Graphic Settings” requester 8-9
In List Show 4-4
“Indent Left" command 14 - 5
“Indent Right" command 14 - 5
“Index” command 14 - 8
“Insert Item” command 14 - 3
“Insert Page Break” command 14 - 4, 14 - 5
Inserting

blank lines 5-4
characters 5 - 3
date or time 6-12
text 2 - 4

Insertion Point
setting 5 - 3

Inside margin 4 - 5
Installing 1-4
Italic 14 -13

H
“Hanging Indent” command 14 - 5
Hardware required 1 - 2
Headers 2-12, 4-6, 7-28
Helpful Hints for Better Documents C -1
Highlight 1 - 3
Hyphenation

“Hot Zone" margin 7 - 7
“Off/On" 1-8,7-11
preferences 3 -10

J
Justification 1-7, 2-8, 7-9

K
Keyboard Shortcuts B -1

L
“Layout” menu 1-6, 14-5
Leading 7-14
“Leading” command 14 - 6

Index - 3
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Left margin 7-4
Left/Right Pages 4-3
“Line Settings” requester 8-3
“Lock” command 14-7

M
Margins 11-10

first line indent 1-8, 7-5
Hyphen “Hot Zone" 7 - 7
inside 4-5
left 1-8, 7-4
outside 4-5
right 1-8, 7-4
setting 2-10

Master pages
about 2 - 12, 7 - 27
define left and/or right 7 - 28
headers and footers 7-28
selectors 1-8

Measure in 3-7
Memory Usage 3-11
Menus 1 - 6
Merge field 12-6
Merging data with a form letter 12-9
Moving graphics 8 - 14
Moving text 2-6. 6-7
Moving through text 6 - 3

N
“New" command 14 - 2
“New Section" command 14 - 5
Number Pages and Page =s 4 - 3

o
"Oblique Percent" command 14 - 6
“Open” command 14-2
Opening a document 6-2
Opening fonts 7-12
Orientation 4-3
"Outline" command 14 - 8
Outline Fonts E - 1
Outlines 10-6
< lutside margin 4-5

“Oval Settings” requester 8-7

P
Page

breaks 7-29
guides 3 - 7
left/right 4-3
number 1-9, 14-15
prefix and first # 4-6
right only 4-3
size 4-2
view 7-2

“Page Number" icon
go to the first page of a document 6-5
go to the last page of a document 6-5
go to the next page 6 - 4
go to the previous page 6-5

"Page Setup" Requester
Number Pages and Page ~s 4 - 3
Orientation 4 - 3
Page Size 4 - 2
Pages 4 - 3
Print Area 4 - 3

“Page View" command 14-4, 14-5
Paragraph

alignment 7-9
settings 7-4
setup 7-3
sorting 6-13
spacing 7-10

“Paragraph" command 14-5
"Paragraph" requester 7-3
Paragraph Styles

applying 7-22
defining 7-25
deleting 7-25
modifying 7-25
"Styles Definition" requester 7-23
Using the “Tabs" requester 7-25

"Paste" command 6-6, 6 - 7, 14 - 3
“Paste Ruler" command 14-3
PenPal™ 14 - 14
Point 1-3

Index - 4



“Position” command 14-6
PostScript® Preferences

crop marks 11-9
download fonts 11-8
halftoning 11-8
orientation 11-9
page mode 11-8
page size 11-9
printer type 11-8
scaling 11-9
shade 11-8

PostScript® printing
advanced topics 11-13
communicating with Serial Port 11-11
handshaking 11-11
preferences 11-11

Preferences
ASCII file input/output 3 - 8
Display 3-6
Document Colors 3-14
Document Items 3-12
Document Save 3-16
Screen Colors 3-18
Speller and Hyphenation 3-10
Startup 3 - 9
User Button Strip 3-4
User Menu 3-2

"Preferences" command 14 - 2
Press 1 - 3
Print Area 4 - 3
"Print" command 14 - 2
"Print Document" requester

collate 11 - 4
number of copies 11-4
order 11-5
pages 11-4
paper feed 11-5
preferences 11-4
print to 11-5
section 11-4
set default 11-5

“Print Merge” command 14 - 2
Printer Driver 11-6

Printing a document
draft mode 11-2
final mode 11-2
how to stop 11-3

Program Command Strip 1 - 7
Program settings 14 -14
“Project" menu 1-6, 14-2
ProWrite™ 14 -14

Q
“Quit” command 14 - 2
Quitting 1-10, 2-16

R
RAM Dictionary 3-10
“Remove Page Break” command 14 -
“Remove Section" command 14 - 5
"Replace" command 14-3
Replacing text

Finding and replacing text 6 -10
Using the “Paste” command 6-6
With new text 6 - 5

Right margins 7 - 4
Right only pages 4 - 3
Right Page 4-5
“Rotate” command 14 - 7
“Rotate To” command 14 - 7
Rulers

mode selectors 1 - 8
options 3 - 7
settings 14 - 9
using 7 - 3

s
“Save" command 14-2
Save With Each Document 3-16
Saving

changes 2 - 16
document 2-7, 5-7

Screen Color preferences 3 - 18
Screen DPI 3-6
Scroll bars 1 - 9
Scrolling text 6-3



“Section Setup" command 14-5
Section Setup requester 4-4

Columns 4-6
Edit Area 4-5
Format 4-6
I leaders and Footers 4-6
In List Show 4-4
Page #s: Prefix and First * 4-6
Section List 4 - 4
Section Name 4-4

Section Types
bibliography 10 - 14
endnotes 10-11
main 10-5
outlines 10 - 6
preface 10 - 5
table of contents 10-8
table of illustrations 10- 10
title page 10 - 5

Sections
creating 10-3
deleting 10 - 4
going from one section to another 10 - 4
normal 10-3
printing 10 - i
reformatting special sections 10 - 18
special 10 - 2
updating special sections 10- 18

Select 1 - 3
“Select All" command I t - 3
Selecting

block of text 5 - i
fonts 7-12
objects S - 11
single word 5-5

“Send to Back" command 1-t - ~
Setting margins 2 - 10
"Settings" command I t - 7
Settings requesters 8-2
Shade 11-7, 11-8
"Size" command 14 -6
Size gadget 1-10
Skip Cache Size 3 - 10

“Sort Paragraphs” command 14-8
Sorting paragraphs 6-13
Spacing 1-7
Spacing, line

1-1/2 7 - 10
double 7-10
single 7-10
variable 7-10

Special characters E - 1
Speller

adding words 9 - 6
“Alternatives” list 9-5
correcting errors 9 - 4
deleting words 9 - 6
“Document Scan" mode 9 - 3
ignoring 9-5
suggestions 9-4
“Word Verify" mode 9-2

"Speller" command 1-t - 8
Speller/Hyphenation preferences 3 - 10

z\uto Suggest 3-11
Cache Size 3 - 10
Error Reporting 3-11
1 lyphenation 3 - 11
Memory Usage 3 - 11
RAM Dictionary 3-10
Skip Cache Size 3-10

Starting Final Writer 1 - 5
Starting Final Writer from CLI 14 - 10
Startup preferences 3 - 9
Startup Screen 1 - 5
Statistics 9-8
"Statistics" command 14 - 8
“Style" command 14-6
System software required 1-2

Tab stops
center tab 7-6
decimal tab 7 - 6
deleting 7-7
left tab 7-6
moving 7-7

Index - 6



right tab 7-6
selectors 1-8
setting 7-6

Table of Contents 10-8
“Table of Contents” command 14 - 8
Table of Illustrations 10 - 10
“Table of Illustrations” command 14 - 8
Tabs Every 3-12
“Tabs" requester 7 - 25
Technical Support

American English version 1-11
British English version 1 - 11
Limits on 1-11

Text
aligning 2-8
case 7-16,7-19
color 7-16, 7 - 19
copying 6 - 6
correcting 5-4
deleting 2-5, 5-6
finding 6-8
finding and replacing 6-10
flow 8-4, 8-7
font size 2-11.7-13,7-19
inserting 2-4, 5-3
leading 7 - 14, 7-19
moving 2-6, 6-7
oblique percentage 7 - 17, 7-19
position 7-15. 7-19
replacing 6-5
selecting 5-4
style 7 - 14, 7 - 19
width 7 - 15, 7 - 19

Text Blocks
changing the text or settings 8-11
creating 8 - 10

Text Clips 5 - 8
“Text" menu 1-6, 14 - 6
Text Styles

adding 7 - 21
applying 7-20
"Define Text Styles" requester 7-20
deleting 7-21

modifying 7 - 21
Thesaurus 9 - 7
“Thesaurus" command 14-8
Threshold 11-6
Time

format 3-13
inserting 6 - 12
updating 6 - 13

Title bar 1 - 7
Tool box 1 - 8
“Tools” menu 1-7, 14-8
ToolTypes 14 -10
“Type Specs" command 14 - 6
“Type Specs" requester 7 - 18

u
“Ungroup" command 14 - 7
“UnLock” command 14 - 7
“Update Item" command 14 - 3
Updating date and time 6 - 13
User Button Strip 1-7, 14-13
User Button Strip Preferences 3 - 4
User Command Strip

selectors 1 - 8
"User” menu 1 - 7, 14 - 8, 14 -13
User Menu Preferences 3 - 2

V
“View" menu 1-6, 14-4

w
WB Document Color 3 - 7
"Width" command 14 - 6
Window

new 5 - 2
size 3 - 7

Window Gadgets
close box 1-10
front to back gadget 1-10
size gadget 1 - 10

"Word Verify" mode 9 - 2
WordPerfect™ 14 -14

Index - 7
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